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What's New in 2008

Internationalization

Enhanced Response Device
Detection

vPad 2008
Web vPad Integration

User Friendly Settings and
options allow for a more
Personal Experience

This version of TurningPoint includes a healthy number
of improvements and additions that you may enjoy. The
new features provide simplified device set up, more
control over how results should be displayed, interesting
new ways to engage your audience, and a more
customizable experience.

TurningPoint now supports users who speak non-English
languages including Canadian French, Portuguese,
Spanish, Dutch, Japanese, Korean and Czech.
TurningPoint’s Enhanced Response Device Detection...

Provides Plug and Play capabilities for Response
Innovation’s USB Receivers

Eliminates the Device Location and need to run
Response Device Wizard

Allows you predetermine and set Channels
vPad 2008 supports self-paced testing

Web vPad eliminates the need to utilize an internal
network when users have access the internet
With the new settings interface, you can:

Use the Settings Hierarchy to choose from Response
Device, Presentation-level, Slide-level or Answer-
level settings

Use drop-down menus to change many of the
settings.

Choose from Common Settings or All Settings
See a more detailed description of each setting

Determine receiver channels



With more customizable settings and options, you can:
Use an mp3 as Countdown Sound
Customize where you save your sessions
Assign negative point values to questions
Move the Showbar anywhere on the screen
Set an answer as Correct/Incorrect
Set a point value for an answer
Clear the point value for an answer
TestingPoint 2008 Support TestingPoint is a Microsoft Word add-in that allows you
to:
Create self-paced paper tests
Collect responses via the Test Administer
Run reports in Microsoft Excel

Upload TestingPoint sessions into VantagePoint to
view performance of each child, class, building, or
district level compared to State Standards

Import your self-paced tests into TurningPoint to
create interactive presentation.
Built-in Testing Standards With Built-in Testing Standards, you can choose
standards by:
State
Subject
Grade
Smarter Conditional Creating a Conditional Branch has been simplified.
Branching TurningPoint 2008 guides you along the way.
New Participant List Features With the upgrades to the Participant List, you can:

Device ID field is automatically added when you
create a new list

Merge your sessions based on your Participant Lists
and show the aggregated results



Enhanced Reporting provides
more reports and makes
generating reports easier

Add/Remove Groups or Fields from the Participant
Information Screen

Allow users not in your Participant List to participate in
a presentation
With five new reports available, you can:

See the Ratio of correct to incorrect response by
Participant using the Graded Participant Results
(ratio)

See the scoring distribution for the presentation and
how each participant scored using the Comparative
Scoring Reports

See the how teams scored by percentage and points
using the Team Scoring Reports

See how participants responses compared to other
participants using the Percentile Reports

See the percentage of correct answers and total
points accumulated by each participant
With the new reports interface, you can:
Create reports more easily
Change numeric response to alphabetic responses
The following chapters in this guide demonstrate how to

implement these new features to make the most of your
presentation.
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About
TurningPoint

Welcome to TurningPoint, the easiest, most powerful, fully interactive group response system
available. Designed to be used with PowerPoint, TurningPoint enables two-way communication
between a speaker and a large group by allowing audience feedback. TurningPoint offers the ability to
collect, evaluate, and record responses from everyone in the audience, transforming a lecture,
workshop, or meeting into a more effective learning environment for everyone in the room. By
engaging each participant, TurningPoint creates a unique session every time, recording response
data that can be used immediately or later for grading, polling, attendance tracking, and demographic
research.

Whether you want to gauge an audience’s opinion or quickly assess your students’ understanding on
important points in a lecture, TurningPoint enables you to ask and receive a response at the very
moment you want to ask most. The audience uses response devices to submit answers to questions
you have created. Then, TurningPoint gathers responses from each participant and quickly translates
them into measurable results in the form of test scores, charts, and graphs.

After a presentation, TurningPoint helps you store the data for later access or for use in reporting or
grading.

This chapter provides an overview of the product and its capabilities and includes the system
requirements, the steps for installing TurningPoint on your computer, and some resources available to
you for customer support.



Product Introduction

TurningPoint smoothly integrates with PowerPoint to create a more interactive and memorable
presentation. TurningPoint was designed to run on Office 2003 and Office 2007 with Microsoft XP
support. (Find additional information in System Requirements on page 3.) All TurningPoint options
are accessed through the TurningPoint toolbar.

The TurningPoint toolbar can be found in PowerPoint beneath the standard PowerPoint toolbar
after TurningPoint is installed. This toolbar offers you all the options you need to create interactive
slides, set up and run a presentation, and generate reports. Easy-to-use features such as the
Participant List Wizard help you quickly get started.

Other TurningPoint features include participant monitoring and reporting tools. TurningPoint also
provides the ability to connect to an educational institution’s WebCT or Blackboard server or to use
Turning Technologies’ Enterprise Manager and TestingPoint to streamline the creating of Participant
Lists and reporting of classroom results and grades.

Additionally, TurningPoint is now available in a range of non-English languages. Customers may
choose a language when they install TurningPoint.



System Requirements

TurningPoint is designed for use on computers with typical abilities. You do not need the very latest
technology or a large amount of hard disk space to use TurningPoint. There are, however, a few
requirements that you should check for before installation. The requirements for hardware and
software are detailed in the following sections.

Requirements for Hardware

The following hardware specifications are required before installing TurningPoint:

Intel or AMD 600 Mhz class processor (1 GHz or higher recommended)
256 MB RAM (256MB or more of “available” RAM recommended)

60 MB hard disk space (an additional 32 MB is required if you do not have Microsoft .NET
Framework 2.0 installed).

800x600 resolution at 24-bit color (1024x768 resolution at 32-bit color or higher recommended)
Standard USB 1.1/2.0 port

Ethernet or 802.11 compatible wireless network card (for vPad and vPad Presenter use)

Requirements for Software

The following software applications are required to take full advantage of TurningPoint capabilities:

Microsoft Windows XP or higher
Microsoft Office XP, 2003, or 2007



Initial Setup

There are two easy steps that need to be completed before you begin using TurningPoint. This
section will guide you through those steps.

This section describes how to:

Install TurningPoint

Open TurningPoint with PowerPoint



Install TurningPoint

In a few simple steps, TurningPoint can be installed on your computer. The installation process takes
just a few minutes, and then you will be ready to create a TurningPoint presentation.

Before You Begin

Check the hardware and software specifications outlined in System Requirements on page 3. A
computer must meet these systems requirements before installation.

Step by Step Instructions To install TurningPoint software on a computer...

1 Install TurningPoint in one of

two ways:
* Download the latest The Turning Technologies web site is located at
edition of TurningPoint http://www.turningtechnologies.com. Use your web
from the Turning browser to download the file to your computer. When the
Technologies web site. download is complete, double-click the setup icon to
launch the InstallShield Wizard.
* Toinstall froma CD, insert After you insert the CD, the InstallShield Wizard launches

the CD on the computer. automatically.



If an older version of
TurningPoint is installed, the
InstallShield Wizard window
displays a message
requesting to uninstall the
previous version.

a. Select OK.

Select the Next button to
continue the installation with
the InstallShield Wizard.

If this is the first time you are installing TurningPoint or have
already uninstalled a previous version, continue with step 3.

The next page displays the license agreement. Use the
scrollbar to read the license agreement on the screen or
select the Print button to send the text to a printer.

License Agreement

& TurningPoint 2008 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully,

Legal Disciaimer: By particinating in the beta test, vou acknowledge that the -
TurningPoint 2008 beta sofware is indeed g beta product and may hot represent

the final shipping product. TurningTechnofogies cah not be responsibie for any

Issues that occuy as a resuit of running the TurningPoint 2008 beta.

IMPORTANT--READ THESE TERMS CAREFULLY BEFORE INSTALLING

THIS SOFTWWARE. BY INSTALLING OR USING THIS SOFTWARE, YOU
ACKNOWLEDGE THAT ¥ OU HAYE READ THIS LICEMSE AGREEMENT,
THAT ¥OU UNDERSTAMD IT, AND THAT ¥YOU AGREE TO BE BOUMD BY

ITS TERMS. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS

OF THIS ICFNSF AGRFFMENT PROMPTI Y FXIT THIS INSTALTATION v

(31 accept the terms in the license agresment
()1 do nok accepk the kerms in the license agreement
< Back “ Mext = ] Cancel

Select the button labeled I
accept the terms in the
license agreement” if you
accept these terms.

Accepting the terms of the license agreement permits you to
continue with the process of installing TurningPoint.



5 Select the Next button.

6 Type your name and
company in the fields.

7 Select the Next button.

The next page displays customer information entry fields.

Customer Information

) TurningPoint 2008 - InstallShield Wizard

Customer Information

Please enter wour information.

User Mame:

Organization:

Install this application For:

(%) Anvone who uses this computer (all users)
) only For me { Techiwrice

[ < Back ” Mexk = ] [ Cancel

The next page allows you to select a language.

Language Selection

) TurningPoint 2008 - InstallShield Wizard

Language Selection r
Please select your language. ’

(&) English () Japanese
) Czech ) Korean

() Dutch () Portuguese
() French () Spanish

[ < Back ” Mext = ] [ Cancel




8 Select a language to install. You may choose English, Czech, Dutch, French, Japanese,
Korean, Portuguese, or Spanish.

9 Select the Next button. The next page confirms that the computer is ready to install
TurningPoint.

Install the Program

& TurningPoint 2008 - InstallShield Wizard

Ready to Install the Program r
The wizard is ready to begin installation. ’

Click Install to begin the installation.

IF you want to review or change any of vour installation settings, click Back. Click Cancel to
exit the wizard,

< Back ] [ Install ] [ Cancel l




10 Select the Install button. The computer installs TurningPoint to the location you specified

and displays the Finish button on the page when it completes
the process.

Installation Wizard Completed
5 TurningPoint 2008 - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed TurningPoint
2003, Click Finish to exit the wizard,

Tu rningPOI'r‘lL' [1 Launch TurningPaint 2008

Informative On-line
Learning Community

Weekly Instructor Lad On-Line If Prerequisites have been installed, it is

. Treining Sessions. recommended that you restart your computer.
= Customer Based Case Studies,
= Proven Best Praciices.
11 Select the Finish button. The final page displays a message that the installation is

complete. Select the Launch TurningPoint checkbox if you
would like to immediately open the program.

The TurningPoint shortcut icon displays on your desktop and
points to the location where you installed TurningPoint on the
computer. Double-click the icon to open the program.

K |

TurningPoink
2008

TurningPoint Shortcut Icon



Open TurningPoint with PowerPoint

After you install TurningPoint onto your computer, you may want it to open automatically when you
open PowerPoint. Or, you may want the programs to always open separately. You can change this

option from the Settings window.

Step by Step Instructions

1 Double-click on the
TurningPoint icon.

2 From the TurningPoint
toolbar select Tools >
Settings (Hint: it's the one
that looks like a pair of
eyeglasses).

3 Select the Presentation from
the Settings Hierarchy.

To toggle the option to automatically load TurningPoint ...

The Settings window opens.

"= TurningPoint - Settings

Seuings | Poling Test

Settings Window

Fesponse Device ~|[ Answer settings ~
Fresentation

=1 Where & the capital of Ohic || Answer Bullet Farmat Decimal Period
1 Columbus
2 creirnat | Chart Settings
2 Youngstown Autn Scale Charts True
4 Cleveland Chart Colors Coler Scheme

=2 Where ks the capital af Penr || Coy e Alisees
1 Piftsburgh Chart value Format 0%
2 Harrisburg Standard Chart Type Vertical
3 Seranton
4 Philadelphia Competition Settings

=3 where & the capitalofthe U (|
1 Washington State Default Nurmber of Teams 5
2 washington, P& Include Non-Responders False
3 Washington D.C. Maximum Responders 5
4 Washington, NC Participants In Leaderboard 5

= 4 Where s the capital of New || Teams In Leaderboard 5
1 Albuguergue
2 SantaFe Misc
j ED;\SA;ZEDS AdeHIn ahways oaded Fake

€ 5 || correct Point value 1m0 2

(® Common Settings (O All Settings.

A specific list of settings options displays in the menu.




4  Scroll down the menu until
you see the Misc settings.

5 Select the Add-In always A drop-down menu appears.

loaded setting.
Settings Window: Add-In always loaded

*'w TurningPoint - Settings

Settings [ Poling Test
Response Device 211 Commetition Setti a
Presentation [ —ompetition Settings
1 Where is the capital of Ot || pefautt urmber of Tearms s
1 Columbus Include Nan-Responders False
2 Cincinnati Maximum Responders s
3 Youngstawn Farticipants In Leaderboard 5
# Cleveland Teams In Leaderboard 5
52 Where is the capital of Penr
1 Pittsburgh Misc
2 Harrisburg I
3 Scranton AddHIn atways loaded
4 Philadelphia Correct Paint Value
3 Where is the capital of the L || Incorrect Point Value:
1 Washington State ! )
2 Washington, PA | Response Reminders Settings
# Washington D.C. Answer Now None
4 Washington, HNC Answer Now Text Answer Now
-4 Whers is the capital of New || oy Fales
1 Albuguerque Courtdown none
2 SantaFe Counteown Ssconds 10
3 Los Alamas || Response Countar none
4 Carlsbad Response Counter Format Count
< > v
Add-In always loaded
Detarmings if TurningPoint is always lnaded when PowsrPoint is executad

6 Choose either True or False. Choosing True means that TurningPoint automatically loads
when PowerPoint is opened.

Choosing False means that TurningPoint does NOT
automatically load when PowerPoint is opened; you have to
open TurningPoint manually.

7 Select the Done button. The Settings window disappears and, depending on your
selection, TurningPoint either does or does not load the next

time you open PowerPoint.



Tour of the TurningPoint Toolbar

When you launch TurningPoint, PowerPoint opens and the TurningPoint toolbar is displayed
beneath the PowerPoint standard and formatting toolbars in the upper region of the window, as the
following image depicts.

TurningPoint Toolbar

o) - = Microsoft PowerPoint
—-j Home Insert Design Animations Slide Show Review View Add-Ins TurningPoint 2008
) Py \» )f 3 .9 Response Devices = ‘?
j 1 - 4 a | g
i Y L. = -1 ]

Information Reset Continue Save Insert Convertto Insert Tools Participants Select a Help
) Prior Session Session Slide = Picture Slide Object = > = Participant List

TurningPoint 2008

The following descriptions define the buttons that make up the tools in the TurningPoint toolbar.

Information Allows you to view information
about your TurningPoint
E License. It also provides a
mechanism to supply
Information Feedback to
TurningTechnologies.
Reset Resets the response tallies
= from the audience to zero for

‘# all slides in the session or only

the current slide. Find

Reset information about polling the
audience in Chapter 6: Tools.
Continue Prior Opens a previously saved
Session session. A session is a run-

through of a presentation
o where an audience has
._ submitted responses to some
I TINLE or all of the questions. Find
Prior Session . . Lo
information about continuing a
prior session in Chapter 9:
Sessions.

Save Session Stores the current session for
I I retrieval later. Find information

about saving sessions in

Chapter 9: Sessions.
Save

Session




Insert Slide

S

Insert
Slide =

Convert to
Picture Slide

W

»

Convert to
Picture Slide

Insert Object

e

Insert
Object -

Tools

x

Tools

-

Select Input
Source

Response Devices

Participants

=Yl

Participants

-

Select a

Participant List

)

Select a
Participant List

Displays a menu of
TurningPoint slides that you
select to create a presentation.
Find information about
TurningPoint slides in Chapter
3: Creating and Saving
Slides.

Use to assign and order
pictures as answers instead of
text. Find information about
picture slides in Chapter 3:
Creating and Saving Slides.

Displays a menu of items that
you select to enhance a slide.
Find information about slide
options in Chapter 3: Creating
and Saving Slides.

Provides advanced options to
set up, create a presentation,
and report data.

Selects the type of response
devices to be used with the
presentation. Find information
about response devices in
Chapter 4: TurningPoint
Device and Settings
Management.

Provides options to be used
with Participant Lists. Find
information about these
options in Chapter 5: Track
Participants and Teams.

Assigns a Participant List to a
session. Find information
about participant lists in
Chapter 5: Track Participants
and Teams.



Display Opens the online help file.
TurningPoint
Help
?
Help




Customer Support Resources

This guide defines and demonstrates many of the tools and functions that TurningPoint gives you. If
you have questions and concerns, additional resources are available to you online or by calling a
Turning Representative.

Online Assistance

Turning Technologies offers assistance to customers online through the Turning Technologies Web
Site. To access the web site, go to http://www.turningtechnologies.com.

Go to the Product Guides and Manuals section of the Turning Technologies Web Site to find valuable
information about using TurningPoint. The Downloads section provides a link to the Quick Start
TurningPoint Users Guide. Select the link to download the users guide for viewing or printing.

Go to the Learning Community section of the Turning Technologies Web Site find training information
including:

Tutorials

Online Training

Onsite Training

Case Studies

Best Practices

Presentations/Podcasts

Customer Support

To speak with a Turning Representative call our toll-free phone number: 1-866-746-3015. By E-mail,
send your inquiry to support@turningtechnologies.com.



Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)
Mailing Address:

Turning Technologies, LLC

241 Federal Plaza West

Youngstown, OH 44503

Turning Technologies, LLC offers complete TurningPoint training. Our trainers are ready to hit the
road to fulfill your training needs at your location. Or if you desire, send your team to our state-of-
the-art training facility in Ohio.

Typical training sessions last from two to six hours depending on your intended use of TurningPoint
and skill level with Microsoft Office products. For Training Services, call 1-866-746-3015 for details.



Where Do I Go From Here?

If you are new to TurningPoint, this manual will help you on your way. Read through Chapter 2:
Getting Started with TurningPoint to receive a general overview of working with this product.

Are you a returning user? Details of the new TurningPoint features can be found throughout this
document. What’s New in 2008 on page 5 outlines these new features, while the Table of Contents or

Index should help you find them quickly.
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Getting Started
with
TurningPoint

The process to create interactive presentations with TurningPoint is very simple. You can successfully
build, deliver, and save the results of an interactive presentation in five easy steps.

From there, with a little more effort, you can customize the slides and include animation, feedback
mechanisms, and excitement in your presentation. You can also create reports to view the results of
your presentation session.

This chapter provides the basics, a tutorial of sorts, for using TurningPoint. Following the five steps to
success allows you to create very simple interactive presentation slides, set up the devices, create a
Participant List, and use TurningPoint to present those slides.

The advanced features of TurningPoint are detailed in the chapters that follow. You can find
information about the contents of those chapters in Where Do I Go From Here? on page 45.



Five Steps to Presentation Success

Creating an interactive presentation with TurningPoint can be accomplished in five easy steps.

| .

Install TurningPoint

|

Five Steps to Success

— A
Enter question text... '. 1]
2 oo
S A
Step Two: Step Three:
Install Devices Create
Step One: and Manage Participant List
Create Slides Settings ﬂ

-

=
Where is the :ap’ulal of Chio /
= __. (Optionally)

—— Manage Tools
e =

]

Step Four:

(Optionally) Run Reports
Run Presentation

-~
S
\ \
{Optionally) Export Data
Step Five:

Save Session

As the previous diagram depicts, you start by creating the presentation slides. These slides can be
as simple or complex as you desire. You can use PowerPoint’s features to apply a background,

insert graphics, etc. to meet your needs. You will repeat this step many times as you create
additional TurningPoint interactive slide presentations.

Next, plug the devices into your computer to be used to during the presentation and you are ready

to gather responses from the audience. You can go to the Polling Test found in Settings to test
communication or skip the test and go to the next step.



Then, identify your audience. Create a Participant List using the Participant List Wizard. You can
choose from using standard list templates or creating one of your own to store as much information
about your audience as is required. (You can also run a presentation without a Participant List if you
wish.) Create a Participant List for each audience.

When that’s done, you are ready to run the presentation. You'll use PowerPoint’s Slide Show
functionality for this purpose. Behind the scenes, TurningPoint is gathering, tallying, and storing the
responses provided by your audience.

Finally, save the results of your session in a file to be used with TurningPoint’s reports to evaluate the
audience’s responses. Perform this step for each presentation session.

Instructions to perform these five steps to success are detailed in the following sections. Instructions
to use the advanced features of TurningPoint are found in the chapters that follow.

This section describes how to:

Step One: Create Presentation Slides
Step Two: Set Up the Response Devices
Step Three: Create a Participant List
Step Four: Run a Presentation Session

Step Five: Save Session Results



Step One: Create Presentation Slides

Using TurningPoint to create an interactive presentation requires some basic PowerPoint
knowledge and your imagination. Your slides can simply contain question and answer text, or you
can add TurningPoint objects to each slide to allow your participants to interact effectively with your
presentation. TurningPoint’s objects include answer reminders, timers, and response indicators, to
name a few.

Before You Begin

Install TurningPoint on the machine to be used to run the presentation. Find installation instructions
in Install TurningPoint on page 5.

You should be familiar with the basics of creating slides using PowerPoint. This manual discusses
how to use TurningPoint to create interactive presentation slides.

Step by Step Instructions To create a simple slide...
1 From the TurningPoint This displays a variet of pre-defined slides. Each slide can be
toolbar, selectthe Insert Slide used as-is or customized to behave as you desire.

menu.



As you move your cursor over the entries in the Insert Slide
menu, the slide name is highlighted. Find more information on
slides in Types of Slides on page 56

£ E g

Insert | Convertto Insert Tools
Slide = | Picture Slide Cbject -~ ~

Vertical Slide

Insert Slide

A7

Horizontal Slide

3D Pie Slide

Distributed Pie Slide
Off5et Slide

Doughnut Slide

Team Assignment Slide
Participant Leader Board
Team Leader Board
Fastest Responders
Yes/Mo

True/False
Yes/Mo/Abstain

Likert Slides b

KNG - S - A L =

Generic Slides 4
Ice Breaker Slides 4
ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priority Ranking

e K A A T L

Demographic Comparison

0

Moment to Moment -2 to +2




2 Highlight and select the
Vertical Slide option.

3 Select the Question region
and type in a question.

4  Select the answer region and
type in the answers.

TurningPoint inserts a Vertical Slide. The slide contains a
question region, an answer region, and a vertical bar chart.

Insert Vertical Slide

Enter question text...

1. Enter answer ,
text 100%
&
&

R

Question region - “Enter question text...”
Answer region - “Enter answer text...”
Chart region - This example is a vertical bar

chart. Charts can be positioned anywhere on the
slide.

When you select the region, the text is highlighted. The
highlighted text is replaced with the question text that you

enter.

This region has the same behavior as the Question region.
You can enter a maximum of ten answers per slide.



5 Repeat step 1-step 4 to
insert additional slides.

6 Save your file before exiting
TurningPoint.

Next Steps
Slides can be customized by adding a variety of animated feedback mechanisms. Find information
about these different presentation objects and a variety of other slide features in Chapter 3: Creating

and Saving Slides.



Step Two: Set Up the Response Devices

Each audience participant uses a device to respond to the questions asked during the presentation.

TurningPoint supports a variety of response devices including infrared and radio frequency keypads
as well as vPad, Web vPad, laptops, desktops, and Smart Devices.

TurningPoint needs to know what types of response devices will be used before you run the
presentation.

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and must
have the hardware device receivers and devices available for testing.

Step by Step Instructions To set up the response devices...
1 Connect the device receiver Connect the USB cable to your computer. The device is now
to the presentation computer. ready for use.

If you are using a response device licensed for TurningPoint
2003 or 2006, contact your Account Executive to receive a
new license code.



2

If required, Upgrade your
Response Device otherwise,
go step 3.

a. From the TurningPoint
toolbar, select Tools >
Upgrade TurningPoint and
follow the on screen
instructions.

Tools » || Response Devices

= | Participa

% | Turning Reports

Session Management

Standards

Comparative Links

Conditional Branching

Impart From TestingPaink
TurningPaink Parser

Ipdate Parser Template

H b 5 [ R e

Fanking ‘Wizard

WebCT Wizards
Elackboard Wizard
VantageFoink
QuestionPoink

Enterprise Manager

Settings

3
=

& Me B E

pgrade TurningPoink Receiver

Upgrade Response Device



3 From the TurningPoint The TurningPoint Settings window opens, displaying two

toolbar, select Tools > tabs: Settings and Polling Test.
. L
Settings. (Hint: it's the one
that looks like a pair of Settings Window
eyeg Iasses_) ¥ TurningPoint - Settings EEs
Settings | Poling Test
Response Device Al Answer settings e
Pre o
=1 where is the capital of Ohic Answer Bullet Format Decimal Period
1 Columbus )
2 Cincirnati | Chart Settings
3 Youngstown Auto Seale Charts e
4 Cleveland Chart Colors Coler Scherme
=2 where Is the capial of Per | oo 0 P
1 Pittsburgh Chart Value Format 0%
2 Harrishurg Standard Chart Type vertical
3 Scranton
4 Philadelphia Competition Settings =
=3 Where s the capital of the L ||
1 Washington State Default Number of Teams 3
2 Washington, P4 Include Non-Responders False
3 Washington D.C. Maximum Respanders 5
4 Washington, NC || Participants In Leaderboard 5
54 Where & the capital of hew || Teams In Leaderbaard H
1 Albuguergue )
2 SantaFe Misc
3 Los Alamos
AdeHIn always loaded Fake
& 3. carsbad 1 5| || correct Paint value 100 -
(@ Common Settings () Al Settings

4 Select the Settings Tab. The Settings tab displays a Settings Hierarchy in the left pane
and the available settings in the right pane.



5 Select Response Device
from the Settings Hierarchy.

6 Enterthe number of expected
devices.

7 Select the Done button.

Settings for the Response Devices are listed in the right pane of
the Settings window. Select All Settings to access more

settings.

Settings Window: Response Devices

¥ u TurningPoint - Settings FEX

Settings | paling Test

Response Device
Presentation
2 Where is the capital of Ohic
1 Columbus
2 Cincinnati
3 Youngstown
4 Cleveland
3 Where is the capital of Perr
1 Pittsburgh
2 Harrisburg
3 Scranton
4 Philadelshia
4 Where is the capital of the U
1 Washington State
2 Washington, PA
3 Washington D.C
4 Washington, HC
5 Where is the capital of New
1 Albuguercue
2 SantaFe
3 Los Alamos
4 Carlsbad

~

ResponseCard Channels
Empty 21
ResponseCard Misc
Expected Devices o
Enforce Participant List Falke
Cwerwrite User Information False
vPad

Enable vPad / vLinks False
Port hurmber 1001

Web vPad

Enable Web vPad False
URL

Session Name

Access Code

® Common Settings O All Ssttings

Dane

You are only required to enter the number of expected devices
when using Simulated Data or a Response Counter or
Response Table.

TurningPoint limits the number of response devices that will be
displayed in a Response Counter or on a Response Table
based upon the number of expected devices entered.

Find more information on Response Counters in Add a
Response Counter on page 138 and Response Tables in Add
a Response Table on page 141.

Note Access the Response Device settings again

when you need to make changes to the
number or type of devices being used with your
presentations.

The response device testing is now complete.




Next Steps

Find more information about Response Devices and the Settings available in Chapter 4:
TurningPoint Device and Settings Management.

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication...

1 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen
to verify that TurningPoint can receive responses from the
devices.

Settings Window: Polling Test

User Information: Magnify Valuss []

Start Test

Done

For vPad and USB response devices, go to step 4. For Web
vPad response devices, skip to step 5.

2 Select the Start Test button. TurningPoint is now ready to accept responses from the
response devices. You can magnify the responses by placing
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

Device ID Channel Response
AO003BF 21 2




3 Press a key on each TurningPoint displays the Device ID, Channel (if applicable), an
response device to be used. entry for each response device, in the order in which they were
tested, and the key number pressed on each response device.

Polling Test: Response Device Test

" u TurningPoint - Settings

Settings | Poling Test |
Device: ] Channel Response
User Information: Magnify Values [7]
4 Select the End Test button. This action ends the Polling test. If you are using the Web vPad,

go to step 6. Otherwise, go to step 5.



5 Select the Test Web vPad If the connection was successful, TurningPoint displays Web
button. vPad connected Successfully. Go to step 7

Polling Test: Web vPad Test

“aTurningPoint-Semings LD
Settings | Poling Test |

Device ID Channel Response

Web vPad Test 3]
eb vPad cannested Suszessfuly
User Information: WisoriFy Yelues [
Test Web vPad Start Test
r T |

If connection was not successful, TurningPoint displays an
error message. You should check your settings. For more
help on settings see Obtain the Web vPad Response Device
Settings on page 170

6 Select the Done button. The response device testing is now complete.



Step Three: Create a Participant List

Participant Lists identify the members of your audience—your students, your trainees, your survey
respondents—who will use a response device during your presentation. The participant name and
required information is stored along with information about their assigned device, which is identified
by number (for example, 1, 2, 3, and so on) and by Device ID.

You may create multiple Participant Lists to be used with one interactive presentation. Doing so
allows you to use the presentation with multiple audiences and track the session results per audience.

Before You Begin

Your Participant List must not exceed the number of devices licensed for use. If you are not sure of
the number, perform the following steps on the computer to be used for presentations after you setup
your response devices.

Step by Step Instructions To create a Participant List...

1 From the TurningPoint The TurningPoint Participant List Wizard window opens.
toolbar, select Participants >
Participant List Wizard. Turning Point toolbar: Participants

- a)
i @ ?
Participants Select a Help

G Participant List
E Display Participant Monitor

Participant List Wizard
Import a Participant List
Edit a Participant List

o B E

Delete a Participant List




2 Select a template to be used Participant List Wizard

to create your own "' a TurningPoint - Participant List Wizard
Participant List.

Please select a Participant List Template

Iy Custorn Templates

() Education Template

(O Corporate Template

() Awailable Fields Template

() Custom Template

Participant List template choices include:

Education—contains standard student information
used for K-12 and higher education presentations,
such as name and student ID.

Corporate—contains entries for the information most
often used in corporate feedback meetings including
name, company name, telephone numbers, etc.

Available Fields—contains all information entries
defined for use with TurningPoint.

Custom—allows you to create a personalized
Participant List and to name the template or it allows
you to select a previously created template from the list.

3 Selectthe Next button to TurningPoint displays the Participant List information entries
continue. (called fields). Use this screen to customize a pre-defined



4  Optionally, select the right(>)
and left (<) arrow buttons to
to add or delete selected
fields from the template.
Optionally, drag and drop a
field from the Available Fields
to the Selected Fields.

5 Select the Next button to
continue.

template or to select the fields to be included in your Custom
template.

Participant List: Add or Remove Fields

" a TurningPoint - Participant List Wizard

Please select your participant list fields

Available Fields Selected Fields

Address 1 rS Last Marne

Address 2 3 First Mame

ity Student ID

Company 6
Country

Department 0 0
Email < ] ()
Fax

Initial Points B 9
Mobile:

Phone:

StatefProvince b

Add a custom figld

| [ add |

o) L]

Note Find instructions to customize Participant List
templates in Chapter 5: Track Participants
and Teams.

TurningPoint displays the Groups entry box. Use this screen to
add Groups to your Participant List. Groups provide



categorization allowing for team competitions and for greater
reporting opportunities.

Participant List Wizard: Add Groups

" TurningPoint - Participant List Wizard

Add Groups to your Participant List

You may optionally include Groups within your  Incuded Groups
Participant List., Participants may be assigned
to these groups for purposes of tracking
demographics andfor team competition,

Creake a new group

[ fdd

Check the groups that you wish to be
included in tearn competition,

o) o]
6 Optionally, type in a Group TurningPoint displays all Groups in the Included Groups list.

name and select the Add Repeat this step to add additional groups.
button.



Select the Next button.

Optionally, edit the

Participant File composition.

Select the Finish button to
create the Participant List
and save it to afile.

TurningPoint displays the Participant List summary screen.

Participant List Wizard: Summary

" a TurningPoint - Participant List Wizard

Add Participant Information

Participant List Summary

Marne: Mev Lisk 7.6,2007 4.09,29 PM

Humber of Fields:

Murmber of Groups:

Click "Finish" to generate your Participant List and launch the Participant
Information Dialog. From this dislog you can add, edit, import, or export
participant information and assign participants to groups.

Back ] [ Finish

The settings you can change include the Participant List file
name, number of participants, number of fields, and number of
groups. For file name select the old file name and type a new
one in the box provided. For number of fields or number of
groups select the link next to the setting to be returned to the
screen and make your edits.

TurningPoint opens the Participant Information window where
you can type, Edit, paste, or import data.



Chapter 2: Getting Started with TurningPoint

10 Optionally, Add names and Participant Information
other participant information « Participant Information - New List 1.6. 2007 4.09.29 PH.tpl
tO the neW PaI‘tICIpant Llst. i Fle  Edit  Import Murnber of Participants: 1

| Device ID Last Name First Name Student 10 Team1 | Team2

[ check to rearrange column order (editing functionality will be Imited)

Flease select a Participant List you would like to edit by clicking the File menu and click Open,

Cancel Done

11 Select Done to close the
Participant Information
window.

Next Steps

Find more information about Participant Lists in Chapter 5: Track Participants and Teams.

38 Turning Technologies



Step Four: Run a Presentation Session

TurningPoint uses PowerPoint’s Slide Show capabilities to present the interactive slides you have
created. You test your slides during development and run the presentation for your audience by

executing the following steps.

Before You Begin

You must either have use an installed Response Device, Keyboard Keys 0-9, or select to use
Simulated Data before attempting to run the presentation. It is recommended that you use a
participant list, but you can still run a presentation session by selecting Anonymous or Auto for the

participant list.

Step by Step Instructions

1 From the PowerPoint menu,
select File > Open and select
the TurningPoint
presentation to be used.

2 From the TurningPoint
toolbar, select the Response
Device menu and select the
device to be used.

To run a presentation session...

TurningPoint allows you to select how responses will be
provided during the presentation. Your choices are:

Select Response Devices

Response Devices &

Response Devices
Keyboard Keys 09

Simulated Data

Response Devices—a response device will be used
during the presentation. The response devices must have
been set up in Settings. Find more information on
response devices in Install Devices on page 157.

Keyboard Keys 0—9—you will provide input to the
presentation using the keyboard keypad or number keys.



Simulated Data—TurningPoint provides random
responses to the presentation. TurningPoint
determines the number of responses to provide based
on the number of expected devices designated in
settings. i.e. If you enter expected devices as 100,
TurningPoint will provide up to 100 responses to each
question in your presentation. Find more information on
expected devices in Manage Response Device
Settings on page 171.

3 From the TurningPoint This command clears any active sessions from memory and
toolbar, select Reset > allows polling to take place.
Session.

Reset Session

= ‘
2 & l
Reset Continue ]

hd Prior Session Se

f]  Session

=] Current Slide

Ty Al Slides
4 From the TurningPoint A task pane appears to the right listing the available
toolbar, select the Participant Participant Lists. The default Participant List is shown as
List Button and select the (Anonymous). TurningPoint shows all Participant Lists

Participant List to be used.



available in the Participants folder. Participant lists located on
the desktop or in other folders are not displayed.

Participant List Selection

TurningPoint 2008 - Participant Lists ¥ X

Zurrent Participant List:
[fAnomymaus) |

Historic Men
Partic 1
Partic 2
Presidents
Tearns

Import a List ] [ Use Selected List

5 From the PowerPoint ribbon,

This displays a menu of slide show options.
select the Slide Show tab.

6 In the Start Slide Show

section, select From the
Beginning.

The first slide of the presentation is shown.



7 Use the left mouse button to Optionally, you can press the Spacebar, Enter, or Right-Click
control the progress of the and select next on the shortcut menu to control progress.
slide show. For each slide:

a Advance the presentation Polling opens automatically when a TurningPoint slide
to a TurningPoint slide to appears in the slide show. TurningPoint receives
open polling. responses when polling is open.

Polling is the mechanism by which TurningPoint
accepts and tallies responses.

b Click the slide once to No responses are accepted when polling is closed.
close polling and display
the results.

c Click again to advance to
the next slide.

8 Click at the end of the slides
to exit from the Slide Show.

Next Steps

Your presentation may have additional features, such as animation, that cause it to behave
differently at runtime from the default behavior. Find more information in Chapter 7: Run
Presentations.



Step Five: Save Session Results

TurningPoint stores the results from your session. These results can be reviewed at a later date and
used with TurningPoint’s reporting feature in a variety of ways.

When you save a session, a default TurningPoint setting automatically includes the PowerPoint
presentation with your TurningPoint file. You have the option to exclude the PowerPoint presentation
from the TurningPoint session file. This function allows you to save only the TurningPoint results data
without the presentation slides. If you do NOT wish to include the PowerPoint presentation in your
TurningPoint session file, navigate to the Settings menu and, under the Misc heading, change
‘Include Presentation’ from True to False. Find more information in Settings on page 189.

The session results are stored temporarily during a session. You can save the session results to a file
to access them later. This section provides instructions to do just that.

Step by Step Instructions To save the session results...
1 From the TurningPoint TurningPoint opens the Save Session dialog box.
toolbar, select the Save
Session button. (Hint: it looks Save Sessions
like a disk.) . - I_I
Save
Session
2 Type a file name to be used TurningPoint names session files using the current system date
to store the session results. and time. Providing your own name for the file allows you to

retrieve the file more easily.



Select the Save button.

This command clears TurningPoint of the existing session

From the TurningPoint
results and allows you to run the presentation again to capture

toolbar, select the Reset >
Session command. new results.

Reset Sessions

Continue ]
- Prior Session Se

fl  Session
.| Current Slide

Ty Al Slides

Note TurningPoint prompts you to save existing
session results when you reset the session and
when you exit from TurningPoint without
previously saving the session.

Next Steps
You are able to run reports to review the responses provided by each participant for your
presentation. The TurningPoint reports use the saved session file. Find more information on Turning

Reports in Chapter 8: Reports.



Where Do I Go From Here?

The answer to that question depends upon what you want to do. Following is a listing of the remaining
chapters in this book along with information about what to find in each chapter.

Chapter Name

Description

Creating and Saving Slides

TurningPoint Device and Settings
Management

Track Participants and Teams

Tools

This comprehensive, instructional chapter provides
details of not only how to create a slide, but also how to
add TurningPoint’s custom features to the slide to meet
your needs.

Read this chapter to understand how to add objects such
as response timers and indicators, how to set slide
defaults, how to convert existing slides into interactive
TurningPoint slides, and more.

Device setup is easy. However, if you need more help
than what is included in this Getting Started chapter,
you'll find it here.

Read this chapter for a comprehensive guide of the
available settings and how they can help you create a
presentation to meet your needs.

Participant Lists can use the default templates or can be
customized to include information according to your
needs or requirements.

Read this chapter to understand how to create custom
Participant Lists, how to create Groups, how to modify or
delete a Participant List, and how to download participant
information from other sources.

The tools discussed in this chapter include how to work
with the Ranking Wizard, how to set up standards for
your slides, and how to set up advanced features such as
Comparative Links and Conditional Branching.



Chapter Name

Description

Run Presentations

Reports

Sessions

Export

Appendices

Would you like to establish presentation session default
behaviors? Have you included animation in your slides?
Would you like to add slides during your presentation?

This chapter focuses on the behavior of your slides
during a Slide Show presentation and identifies how you,
the presenter, interact with TurningPoint during a “live”
session.

This chapter focuses on the various reports produced
from a Slide Show presentation. These reports allow you
to get a better understanding of the audience and
presentation results.

You can stop and save a session, and pick up where you
left off at a later time. This chapter will teach you how to
save, resume, and delete a session to give you flexibility
during your presentation.

You may wish to export session data. This chapter will
teach you how to export data in various ways.

The appendices include a guide to Frequently Asked
Questions.



Creating and
Saving Slides

In Chapter 2: Getting Started with TurningPoint, you learned the basic steps for creating
TurningPoint presentations. This chapter and the remaining chapters of this user guide demonstrate
the steps in greater detail, allowing you to use all the powerful features TurningPoint offers.



Recall the five steps to presentation success:

Five Steps to Success
Install TurningPoint

Enlesr quastion taxt ..

4

Step Three:
Install Devices Create
Step One: and Manage Participant List
Create Slides Settings
—i
o -!-

Where is the Eﬂp’l|ﬂ| of Ohio =
1 -;r-wn.s -
§ St = . (Optionally)

e Manage Tools
S LS
Step Four: (Optionally) Run Reparts

Run Presentation

[ ~
(Optionally) Export Data
Step Five:
Save Session

As the previous diagram depicts, the first step is to create the presentation slides. This chapter
demonstrates how to use TurningPoint to create the slides you will use later in a presentation.

TurningPoint slides are slides in a PowerPoint presentation with the ability to dynamically display
information based on the responses of an audience. Most TurningPoint slides ask the audience to



answer a question, and then tabulate and display the responses. These slides have a question
region, an answer region, and a chart.

Composition of a slide

Enter question text...
1. Enter answer )
text... 100%
©
(2
o
&"‘g

Question region - “Enter question text...”
Answer region - “Enter answer text...”
Chart region - This example is a vertical bar

chart. Charts can be positioned anywhere on the
slide.

L

The question region contains the text of the question you are asking the audience. The answer region
contains an enumerated list of answers that the audience can choose from. (You can even use
pictures as the answers. Find more information in Create Picture Slides on page 115.)
The chart shows the results of the audience’s choices, with a bar, slice, or other indicator for each
answer (depending on the type of chart). There are six types of charts available. Find more
information in Chart Slides on page 57.
You start by creating some TurningPoint slides. You have several options:

Insert a TurningPoint template slide using the Insert Slide menu in the TurningPoint toolbar.

Find instructions for inserting a slide in Insert a Slide on page 51.

Convert an existing PowerPoint slide into a TurningPoint slide by inserting a TurningPoint chart
using the Insert Object menu in the TurningPoint toolbar.



Find instructions for converting a PowerPoint slide in Make a PowerPoint Slide Interactive by
Inserting a Chart on page 123.

Once you create the slides, you can modify them in a number of ways. You can add pictures,
change colors, change the chart, mark correct answers, and perform other operations specific to
TurningPoint. Find more information in Modify Slides on page 85.

Additionally, TurningPoint allows you to add a number of TurningPoint objects to your slides. These
include response indicators, countdowns, and even statistics like the average and variance of the
responses. Find information on adding objects in Add Objects on page 128.

Your TurningPoint slides are saved as part of your PowerPoint presentation in your .ppt file. Find
information on saving your presentation in Save the Presentation Slides on page 54.



Creating Slides

TurningPoint allows you to create and save an interactive presentation.
This section describes how to:

Insert a Slide

Save the Presentation Slides

Insert a Slide

You can insert a TurningPoint slide using the Insert Slide menu.



Step by Step Instructions

1

In TurningPoint, open a
presentation or create a new
presentation.

Select Insert Slide from the
TurningPoint toolbar.

\7

To insert a slide into a presentation...

The Insert Slide menu opens.

£ E g

Insert | Convertto Insert Tools
Slide = | Picture Slide Object = ~

Wertical Slide

Horizontal Slide

3D Pie Slide

Distributed Pie Slide
Off5et Slide

Doughnut Slide

Team Assignment Slide
Participant Leader Board
Team Leader Board
Fastest Responders
Yes/Mo

True/False
Yes/Mo/Abstain

Likert Slides b

KNG - S - A L =

Generic Slides 4
Ice Breaker Slides 4
ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priority Ranking

e K A A T L

Demographic Comparison

0

Moment to Moment -2 to +2

Insert Slide menu



3 Select the type of slide you
would like to insert from the
Insert Slide menu.

TurningPoint inserts the new slide into your presentation.

Depending on what type of slide you selected, the new slide
may contain question and answer regions and a chart.

Find information about the different slide types in Types of
Slides on page 56.

Composition of a Slide

Enter question text...
1. Enter answer .
text... 100%
©
(2]
-
@e‘*g

Question region - “Enter question text...”
Answer region - “Enter answer text...”
Chart region - This example is a vertical bar

chart. Charts can be positioned anywhere on the
slide.

L

Additionally, depending on your TurningPoint settings, the slide
may contain answer, response, and countdown indicators or
other objects. Find more information on adding or changing
these objects in Add Objects on page 128.



4 Edit the text in the question
region to reflect the question
you would like to ask the
audience.

5 Edit the text in the answer You may enter up to ten answers in the answer region.
region to reflect the choices

the audience will have when
responding to the question. Repeat this procedure as many times as needed to create

your interactive presentation.

Save the Presentation Slides

Your TurningPoint slides are saved as part of your regular PowerPoint (.ppt) presentation file. You
can share this file with other TurningPoint users.

Note You can safely open the presentation on
computers without TurningPoint installed,
but you cannot use the TurningPoint
features. You should not edit the
TurningPoint slides on a computer without
TurningPoint installed.

Step by Step Instructions To save your presentation...

6 Select the Office Button > The Save As window opens.
Save As from the PowerPoint
menu.



7 Select a location to save the You should keep the .ppt extension in the filename to ensure
file and type a filename for that PowerPoint opens the presentation file.
the file in the space provided.

8 Select the Save button to TurningPoint saves all of the presentation level settings that you
save your file. defined in the Settings menu to the presentation itself. When

you open the presentation on a different computer, the saved
presentation settings are used instead of the computer’s default
settings. This function preserves your custom settings so that
you do not have to reapply them every time you open a
presentation on a new computer. Find more information on
settings in Chapter 4: TurningPoint Device and Settings
Management

Note You can restore the computer’s settings
when using any presentation. In the Settings
menu, select the Presentation from the
Settings Hierarchy. A Restore default
Presentation Settings box displays in the bar
below the settings options. Select this
button and a dialog box appears with this
statement: ‘This will restore the presentation
settings back to the default installation
state.” Select OK to restore the default
settings.




Types of Slides

The Insert Slide menu on the TurningPoint toolbar lists all of the slides you can insert into a
presentation.

Insert Slide menu

¥

¥ g

Insert | Convertto Insert Tools
Slide = |Picture 5lide Object~ -

=

Vertical Slide

Harizontal Slide

30 Pie Slide

Distributed Pie Slide
OffSet Slide

Doughnut Slide

Team Assignment Slide
Participant Leader Board
Team Leader Board
Fastest Responders
Yes/Mo

True/False
Yes/Mo/Abstain

Likert Slides 4

THnEEES 0N g

Generic Slides 4

Ice Breaker Slides 4

ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priority Ranking

LR

Demographic Comparison

|{|

Moment to Moment -2 to <2

This section describes

Chart Slides
Competition Slides
Template Slides
Special Slides



Chart Slides

The first set of six slides (above the first divider in the menu) insert a template slide with a chart of the
specified type: vertical, horizontal, 3D pie, distributed pie, offset, or doughnut. The chart shows the
results of the audience’s choices for each answers.

3] * &g

Insert | Convertto Insert Tools
Slide = |Picture Slide Object ~ -

Vertical Slide

Chart Slides Menu

Horizontal Slide

3D Pie Slide
Distributed Pie Slide
OffSet Slide

omeL €M

Doughnut Slide

The six chart slides in the Insert Slide menu each contain the following:

A question area with the text “Enter question text...”
An answer area with the text “Enter answer text...”
A chart of the specified type: vertical, horizontal, 3D pie, distributed pie, offset, or doughnut.

Charts are objects on the TurningPoint slide that can be moved and resized just like ordinary objects.
You can change the type of chart on a TurningPoint slide by following the instructions in Change
Chart Types on page 86.



Vertical Slide The vertical slide contains a bar chart with vertical bars for
each answer.

Vertical Slide
Enter question text...
1. Enter answer text... 25% 25% 25% 25%
2. Enter answer text...
3. Enter answer text...
4. Enter answer text...
Horizontal Slide The horizontal slide contains a bar chart with horizontal bars

for each answer. Each bar displays behind the corresponding
answer in the answer region.

Horizontal Slide

Enter question text...




3D Pie Slide

Distributed Pie Slide

The 3D pie slide contains a three-dimensional pie chart with a
slice for each answer and a key indicating the color representing
each answer.

3D Pie Slide

Enter question text...

1. Enter answer text...

2. Enter answer text...

3. Enter answer text...

4. Enter answer text... 25% 25%
25% 25%

B Enter answer text... B Enter answer text...
W Enter answer text... M Enter answer text...

The distributed pie slide is similar to the 3D pie slide except the
slices are shown separated from each other.

Distributed Pie Slide

Enter question text...

Enter answer text...
Enter answer text...
Enter answer text...

El A

Enter answer text...

25%

25%

25%

25%

B Enter ans
W Enter

wer text... B Enter answer text...
answer text... B Enter answer text...




Offset Slide The offset slide contains a bar chart with horizontal bars for
each answer. Each bar is shown directly below the
corresponding answer in the answer region.

Offset Slide

Enter question text...

. Enter answer text...
25%
. Enter answer text...
25%
. Enteranswer text...
25%
. Enter answer text...
25%

Doughnut Slide The doughnut slide contains a pie chart with a hollow center
with a slice for each answer and a key indicating the color
representing each answer.

Doughnut Slide

Enter question text...

Enter answer text...
Enter answer text...
Enter answer text...

El A

Enter answer text...

B Enter answ... B Enter answ... B Enter answ... B Enter answ...




Competition Slides

The second set of four slides are the setup and summary slides for competitions these slides allow
you to assign teams and keep track of the participants or teams with the most points and fastest
responses.

Competition Slides Menu

Team Assignment Slide
Participant Leader Board

Team Leader Board

B o B

Fastest Responders

The competition slides include: Team Assignment Slide, Participant Leader Board, Team Leader
Board, Fastest Responders.

Since the Leader Boards and Fastest Responders slides are updated after each question, you only
need to include one of each in your presentation. Simply place it at the end of the presentation and
jump to that slide when you want to know which participants or teams are in the lead.

Team Assignment Slide The Team Assignment slide allows teams to be assigned by
asking the audience members to choose a team. Simply include
names for the teams in the answer list and the participants will
automatically be placed on the teams according to their
answers. Display this slide early in your presentation so that
participants can join a team at the beginning.

Team Assignment Slide

Please select a Team.

Team 1 20%  20% 20% 20% 20%

Team 2 M
Team 3
Team 4

v e wN e

Team 5




Participant Leader Board
Slide

Team Leader Board Slide

Using the Team Assignment slide is an alternative to
assigning participants to groups in a Participant List. The
Team Assignment slide allows teams to be assigned
dynamically, while assigning groups in the Participant List
ensures that the same participants are always on the same
teams. Find more information on setting up a competition in
Set Up Team Competitions on page 255.

The Participant Leader Board displays the top individual
participants ranked by their point totals.The Participant
Leader Board slide updates dynamically after each question.

Participant Leader Board Slide

Participant Scores

450 Benjamin Franklin
400 George Washington
250 Abraham Lincoln
100 Alexander Hamilton

You can specify the number of participants to show on the
slide using the TurningPoint settings. You can also specify
whether the point totals should be cumulative, or for the most
recent question only. Find more information on modifying
settings in TurningPoint Device and Settings Management
on page 153.

The Team Leader Board displays the top teams ranked by
their point totals. (The team’s points are the average of the



team’s participant’s points.) The Team Leader Board slide
updates dynamically after each question.

Team Leader Board Slide

Team Scores

400 Team 1
333.33 Team?2
250 Team 3
200 Team 4
150 Team 5

You can specify the number of teams to show on the slide using
the TurningPoint settings.You can also specify whether the
point totals should be cumulative, or for the most recent
question only. Find more information on modifying settings in
TurningPoint Device and Settings Management on page 153.

Fastest Responders The Fastest Responders displays the individual participants
who responded correctly and the fastest to the most recent
question. This feature requires a correct response or point



value. The Fastest Responders slide is updated dynamically
after each question.

Fastest Responders Slide

Fastest Responders (in seconds)

1.89 Andrew Jackson
1.90 John Q. Adams

1.91 John Adams
1.95 Gerald Ford
2.00 Alexander Hamilton

You can specify the number of participants or teams to show
on the slides using the TurningPoint settings. Find more
information on modifying settings in TurningPoint Device
and Settings Management on page 153.



Template Slides

The third set of slides are templates for commonly used kinds of questions, such as Yes/No,
True/False, Yes/No/Abstain, Likert Scale, Generic and Ice Breaker slides.

Template Slides Menu

=] Yes/Mo

=] True/False

]| Yes/No/Aabstain
Likert Slides »
Generic Slides L4
Ice Breaker Slides L4

When you insert any of the template slides, a chart of the
default type (specified in the Settings) is inserted onto the slide.
You can change the chart type on the inserted slide. Find
information for changing chart types in Chart Slides on

page 57.

Note You can change the default chart type to any
of the six chart types using the Standard
Chart Type setting, a presentation-level
setting. Find more information on modifying
settings in TurningPoint Device and
Settings Management on page 153.

Yes/No Slide A Yes/No slide is used for a question with yes or no
response.The template slide includes a generically worded



question and answers. You may wish to edit the question to
be more specific.

Yes/No Slide
Do you agree?
1. Yes
2. No 71%
29%
True/False Slides A True/False slide is used for a question with a true or false

response. The template slide includes generically worded
question and answers. You may wish to edit the question to
be more specific.

True/False Slide

Do you agree?
1. Yes
2. No 71%
29%
Yes/No/Abstain Slide A Yes/No/Abstain slide is used with a yes or no response with

option to abstain. The template slide includes generically



Likert Scale Slide

Generic Slide

worded question and answers. You may wish to edit the
question to be more specific.

Yes/No/Abstain Slide

Do you agree?

1. Yes
2. No
3. Abstain

41%
33%
25%

o .
< * o

A Likert scale slide is used for a statement with a response of
varying levels of agreement or disagreement. There are 4-, 5-,
and 7-level Likert scale slides. The template slide includes a
generically worded question and answers. You may wish to edit
the question to be more specific.

Likert Scale Slide

What is your opinion?

Strongly Agree
Agree

Somewhat Agree
Neutral

Somewhat Disagree
Disagree

N o u ks wnN e

Strongly Disagree C S e S e e e
R A )
& & B &
& & 3 &
s o° Hass &

A Generic 2- to 10-answer slide allows you to insert a a slide
with up to 10 answers. The template slide includes generically



Icebreaker Slides

worded question and answers. You may wish to edit the
question and answers to be more specific.

Generic Slide

Please make your selection...

Choice One
Choice Two
Choice Three
Choice Four
Choice Five
Choice Six
Choice Seven
Choice Eight
. Choice Nine
0. Choice Ten

BWLoONOUVEWNRE

An Icebreaker slide is a slide with analogy or word scramble
questions to get your audience involved in your TurningPoint
presentation. Analogies are automatically generated, but you
must supply a word for the word scramble.

The Analogy icebreaker slide creates a slide with an analogy
question with one missing word. (For example, parking
brake:car::anchor:?) It includes four choices, one of which is
marked as the correct choice. (If you include a Correct
Answer indicator, the correct choice will be revealed after



polling. Find more information on adding a Correct Answer
indicator in Add a Correct Answer Indicator on page 143.)

Analogy Slide

parking brake : car :: anchor :

plane

65%

train
ship

El A

bus

The Word Scramble icebreaker slide asks you to input a word.
Every other letter from the word is removed. (For example,
COMPUTER becomes C_M_U_E_.) The removed letters are
scrambled and appear as one of four choices. The correct
choice is automatically marked. (If you include a Correct Answer
indicator, the correct choice will be revealed after polling. Find
more information on adding a Correct Answer indicator in Add
a Correct Answer Indicator on page 143.)

Word Scramble Slide

C_M_U_E_

PTRO
CPHO
FIOT
IKDB

79%

El A

7% 7% 7%



Special Slides

The final set of slides in the Insert Slides menu are special-purpose slides. There are several
special-purpose slides: ResponseCard RF Channel Slide, vPad/Web vPad Log-In, Fill in the Blank,
Essay Slide, Priority Ranking, Demographic Comparison, and Moment to Moment -2 to +2.

ResponseCard RF Channel
Slide

Special Slides Menu

o S Y i

ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priarity Ranking

Demographic Comparison

i)

Moment to Moment -2 to +2

The ResponseCard RF Channel Slide, which displays
channel setting instructions for the ResponseCard Radio
Frequency devices used by participants.

The ResponseCard RF Channel Slide displays instructions
that show participants how to set the channel code on their
response devices. If simultaneous presentations are
occurring in adjacent rooms, channel setting prevents
frequency disruption between response devices and
receivers.

Before you change the channel settings on the
ResponseCard devices, you will need to change the channel
on the receiver. There are 82 possible channels for the
ResponseCard RF and 74 possible channels for
ResponseCard XR, and the default channel is 41.

Once the channel is set correctly on the receiver, display the
ResponseCard RF Channel Slide early in your presentation



so that participants can update the channel code on their
devices.

ResponseCard RF Channel Slide

Channel Setting Instructions for ResponseCard RF

1. Press and release the "GO" button.

2. While the light is flashing red and green, enter the 2 digit
channel code (i.e. channel 1 = 01, channel 21 = 21).

3. After the second digit is entered, Press and release the
"GO" button.

4. Press and release the "1/A" button. The light should
flash yellow to confirm.

vPad/Web vPad Log-In Slide The vPad/Web vPad Log-In slide displays setup information for
participants using vPad or Web vPad to send their responses.

The vPad/Web vPad Log-In slide displays the computer’s

friendly name, IP address, and port number, which are required
for participants submitting responses using vPad and the

Session Name and Access Code for Web vPad. If some of the
participants in your audience will be using vPad or Web vPad,
you should include this slide early in your presentation so that
they can successfully connect. Find more information on using



Fill in the Blank Slide

vPad or Web vPad in Chapter 4: TurningPoint Device and
Settings Management.

vPad/Web vPad Log-In Slide

Please enter the following Friendly Name or IP Address
and Port Number to connect...

vPad

presenterlaptop or 191.157.1.112
1001

Web vPad

http://hq1l.turningtechnologies.com:94/
Session Name: Web001
Access Code: 12345

Fill in the Blank slides contain a question region for you to
pose a question. It does not contain an answer region or a
chart, since the responses are in the form of text.
ResponseCard users are limited to numerical responses, but
vPad and Web vPad users may type in alphanumeric
responses of varying lengths.

You can specify one or more keywords in the TurningPoint
settings that the answer should contain to be considered
correct (for reporting and grading purposes). Find more



Essay Slide

Priority Ranking Slide

information in Chapter 4: TurningPoint Device and Settings
Management

Fill in the Blank Slide

Enter question text...

Essay slides (for vPad and Web vPad participants only) contain
a question region for you to pose a question. They do not
contain an answer region or a chart, but vPad and Web vPad
users may type in alphanumeric responses of varying lengths.

Essay Slide

Enter question text...

A Priority Ranking slide weighs participants’ choices and then
ranks them accordingly.



Demographic Comparison
Slide

Priority Ranking slides allow participants to respond to a
question or poll multiple times. You select the number of
responses (maximum of 10) allowed per participant. The
participants’ responses are then weighted, with points
assigned to each response. First choices are weighted with
more points than second choices, second more than third,
etc.

By allowing participants to choose more than one option, you
can see a more diverse range of their preferences. The
Priority Ranking slide displays the weighted scores assigned
to the answers based on participant responses. Find more
information in Insert a Priority Ranking Slide on page 76.

Priority Ranking Slide

What is important to you?

1. Learningthe State
Capitals

Playing Sports o
Playing Video Games

Self-image 1o%
Self-improvement o

Sleeping

No v sewN

Eating

A Demographic Comparison slide shows results based on
certain demographic information.

The Demographic Comparison slide visually displays the
results of a question based on certain demographic
information obtained from the audience. For instance, you can
insert a comparison slide that calculates how participants’
ages relate to the amount of television that they watch. To use
a Demographic Comparison Slide you must first designate a



Moment to Moment Scoring

slide as ‘Demographic.” Find more information on Designate a
Demographic Slide on page 80.

Demographic Comparison Slide

How many hours of television do you watch a day?

The Moment to Moment scoring slide can be used to have
participants rate something on a scale of -2 to +2 at regular
intervals over a period of time. The Moment to Moment slide
contains a question region for the question and a chart that
shows the average response at each polling interval and a
curve connecting the values. Polling continues until you stop it
by clicking on the slide.

You can set the polling interval in seconds for a Moment to
Moment slide in the TurningPoint settings using the Polling
Cycle setting, a slide-level setting. Find more information about
modifying settings in TurningPoint Device and Settings
Management on page 153.

Moment to Moment Scoring Slide

On a scale of -2 to +2 rate:
How you feel at this moment.

A YN
SAVAY B W4
VAR
_2 \/

Duration: 25 Seconds




Insert Special Slides

Inserting some Special Slides differs from inserting Chart, Competition, Template, and Special
slides as outlined in Insert a Slide on page 51. These slides require additional information or setting

changes to function properly.
This section describes how to:

Insert a Priority Ranking Slide
Designate a Demographic Slide

Insert a Demographic Comparison Slide

Insert a Priority Ranking Slide

You can insert a Priority Ranking slide to allow participants to respond multiple times to a question.

The responses are then weighted and ranked accordingly.

You could use a Priority Ranking slide to find out a what is most important to participants. You insert
a Priority Ranking slide, select the number of responses you want to allow per participant, and then
ask participants what is most important. You ask participants to enter their first choice as their first
response, their second choice second, etc. Choices entered first are weighted more heavily.

For example: You create a slide with five possible answers. You allow three responses (choices) per
participant where first the choice is worth ten points, the second nine, and the third eight. You have
six participants providing responses. The first three participants select 5, 4, 3 as answers in that

order. The second three participants select 1,2,3 as answers in that order. TurningPoint calculates

the results as depicted in the table below.

Priority Ranking Calculation Sample

Arnswer Number | Participant Answer
Selection Order

Answer Point Value

Total Points Receive
by Answer

3 & ld choice

3 responses @ 10 points each

30

3 & 2nd choice

3 responses @ 9 points each

27

& & 3rdchoice

6 resonses (@ B points sach

48

3 & 2nd cholce

[N FS T PR I

3 responses @ 9 points each

27

3 & ld choice

3 responses @ 10 points each

30




The table shows that despite participants selecting answers 1 and 5 as their first choice 3 times each,
all six participants selected answer 3. This gives answer 3 a higher priorty for the group as a whole.



Step by Step Instructions

1

Navigate to the slide you
would like the Priority
Ranking slide to be inserted
after.

Select Insert Slide from the
TurningPoint toolbar.

\7

To insert a Priority Ranking slide...

The Insert Slide menu opens.

£ g

Insert | Convertto Insert Tools
Slide = | Picture Slide Object = ~

Wertical Slide

Horizontal Slide

3D Pie Slide

Distributed Pie Slide
Off5et Slide

Doughnut Slide

Team Assignment Slide
Participant Leader Board
Team Leader Board
Fastest Responders
Yes/Mo

True/False
Yes/Mo/Abstain

Likert Slides b

KNG - S - A L =

Generic Slides 4
Ice Breaker Slides 4
ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priority Ranking

e K A A T L

Demographic Comparison

0

Moment to Moment -2 to +2

Insert Slide Menu



3 Select Priority Ranking. A dialog box appears asking how many responses you want to
allow per participant.

Priority Ranking Dialog Box

TurningPoint

How many responzes do you want to allow per
participant(1-10]7

E |
4 Type the number of The default number of responses is set at 3. The maximum
responses you wish to allow number of responses cannot be higher than 10.
per participant.
5 Select OK. A new slide appears prompting you to enter question and

answer text.

Priority Ranking Slide

What is important to you?

1. Learningthe State »
Capitals N

Playing Sports o
Playing Video Games

13%

Self-image 1o%

4%

Self-improvement

Sleeplng y oo & L& & é@%ab@a

No v sewN

o o &
ST A
EAIRA S S

i < &
Eating A

6 Enter the desired question You can now poll participants and ask them to respond the
and responses. selected number of times. Their responses are weighted and



ranked: first responses weighted more than second, second
more than third, etc.

Designate a Demographic Slide

You can designate a slide as demographic to see how a certain group in your audience responds to
certain questions. Slides designated as Demographic can be used in conjunction with Demographic
Comparison Slides or Demographic Reports. Find more information on Insert a Demographic
Comparison Slide on page 81 and on Demographic Reports on page 352.

Step by Step Instructions

1 From the TurningPoint
toolbar, select Tools >
Settings (Hint: It’s the one
that looks like a pair of
glasses.)

2 Select the slide you want to
designate as Demographic
from the Settings Hierarchy.

To designate a slide as ‘Demographic’...

The Settings window opens.

This displays the available settings for the slide in the right
pane of the window.



3 Under the Misc heading, A Drop-down menu appears.
select Demographic.

Settings for Demographic Slide
" a TurningPoint - Settings 3=

Settings | Paling Test

& Sleeping Al chart settings —
7 Eating
26 Onasale of 2t +2 rate || Chart Colors Coler Scherme
= 27 What is your age group? Chart Labels Aliases
1 1825 Chart Value Format 0%
2 2630 Review Only False
3 3140 )
4 4150 | Mise
S5 si-60 Allow Duplicates
& 8170 Anonymous
7 7180 Correct Pont value
B8 80+

Dernagraphic

=28 How many hours of wlevis || o e

1 Multple Response Divisor
2t Question Alias Wihat is your age group?
3z Response Data False
43 Responses 1
54 Speed Scaring False
65 Zero Based Polling False
76
g6+ Response Reminders Settings
o|-Re
< 5 || Au-sevance False v

@ Commen Settings O Al Settings

Demographic

Determines if this question wil be treated a5 a demographic question.

4 Select True

5 Select Done Your slide is now a Demographic Slide.

Insert a Demographic Comparison Slide

The Demographic Comparison slide can be used to visually display the results of a question slide in
terms of certain demographic information gathered from the audience.

For example, you could use this slide to show how participants’ age groups influence the number of
hours of television they watch per day. To do this, you first create a question slide asking participants
what age group they fall under and then designate that slide as ‘Demographic.’ Next, poll participants
by asking ‘How many hours or television they watch a day?’ Finally, you insert a Demographic



Comparison slide that provides percentages for how many hours of television each participant’s age
group watches a day.

Demographic Comparison Slide

How many hours of television do you watch a day?

0% 20% 0% 60% 80% 100% 120% 1a0%

[B1e% B33 03130 09150 WELe Bel70 BT ]

It's important to remember that you must designate a slide as ‘Demographic’ in the Settings menu
to be able to insert a Demographic Comparison slide.



Step by Step Instructions

1

Navigate to the slide you

would like the Demographic

Comparison slide to be
inserted after.

Select Insert Slide from the
TurningPoint toolbar.

\7

To insert a Demographic Comparison slide...

The Insert Slide menu opens.

£ g

Insert | Convertto Insert Tools
Slide = | Picture Slide Cbject -~ ~

Insert Slide Menu

Wertical Slide

Horizontal Slide

3D Pie Slide

Distributed Pie Slide
Off5et Slide

Doughnut Slide

Team Assignment Slide
Participant Leader Board
Team Leader Board
Fastest Responders
Yes/Mo

True/False
Yes/Mo/Abstain

Likert Slides b

KNG - S - A L =

Generic Slides 4
Ice Breaker Slides 4
ResponseCard RF Channel Slide
vPad / Web vPad Log-In

Fill in the Blank Slide

Essay Slide

Priority Ranking

e K A A T L

Demographic Comparison

0

Moment to Moment -2 to +2




3 Scrolldown the list and select The Demographic Comparison dialog box opens.
Demographic Comparison.
Demographic Comparison Dialog Box

Demographic Comparison

Choose a demographic slide

| ¥

Choose a question slide to link with demographic slide

| "]

[ o4 l [ Cancel ]
4 Select a demographic slide Any slides you have designated as ‘Demographic’ are
from the first drop-down included in the menu.
menu.
5 Select a question slide to link You must choose both a demographic slide and a question
with the demographic slide slide.
from the second drop-down
menu.
6 Select OK. The Demographic Comparison slide is inserted displaying the

demographic results in a chart. This slide creates its title
based on the question slide.



Modify Slides

TurningPoint slides are simply ordinary PowerPoint slides with extra features, so you can use and
customize them as you would an ordinary PowerPoint slide. You can reorder slides, move objects,
add text and pictures, apply fonts and color schemes, and use animation. Find more information in
your PowerPoint documentation.

You can also modify the features TurningPoint adds to your slides. You can change chart types and
colors (find more information in Chart Slides on page 57). You can use pictures for answers (find
more information in Create Picture Slides on page 115). And you can add a correct answer indicator
(find more information in Add a Correct Answer Indicator on page 143).

Note Chart settings will retain any modifications
you make, even after you add or remove
answers on the modified chart slides.

This section describes how to:

Change Chart Types

Enable Zero-based Polling

Identify a Correct Answer from the Settings Window
Identify a Correct Answer on a TurningPoint Slide
Use Keywords for Fill in the Blank Slides

Set Point Values from the Settings Window

Set Point Values on a TurningPoint Slide

Clear Answer Values from the Settings Window
Clear Answer Values on a TurningPoint Slide

Use Speed Scoring

Create Picture Slides

Change Chart Colors

Make a PowerPoint Slide Interactive by Inserting a Chart
Disable Auto Scale in Charts



Change Chart Types

You can change the type of chart on a TurningPoint slide using the Insert Object menu.

Step by Step Instructions

1

Navigate to the TurningPoint
slide in your presentation on
which you would like to
change the chart.

Select Insert Object from the
TurningPoint toolbar.

To change a chart’s type...

The Insert Object menu opens.

E x Response Devices
*

Insert | Tools

Insert Object Menu

Object =] =~
Charts L4
Answer Now L4
Countdown k
Response Counter 4
Response Table 4

Correct Answer Indicator »

Stats +

=) | Teut Message




3 Select Charts to display the Insert Object: Chart Selection

Charts submenu. E
!
Insert
Object =
Charts » | il vertical
Answer Now ¢ | = Horizontal
Countdown » | @@ 3D Pie
Response Counter 4 ﬁ'} Distributed Pie
Response Table r | B Offset
Correct Answer Indicator *» | @ Doughnut
Stats L4
= | Text Message
4 Select the type of chart you When you select the chart type, TurningPoint changes the chart
would like to appear on the on your slide to match the type.

slide.

Enable Zero-based Polling

By default, answers are numbered 1-10, but you can change the settings to enable answers to be
numbered 0-9 for zero-based polling.



Step by Step Instructions To enable Zero-Based Polling...

1 In the TurningPoint toolbar,
select Tools > Settings (Hint:
It looks like a pair of
eyeglasses).

Settings Window

¥ o TurningPoint - Settings ==

2 Select Presentation or a
specific Slide from the

Settings Hierarch e
g y. A Answer settings ~
or I
51 Where & the capital of Obic || Answer Bullst Format Decimal Period
1 Columbus )
2 Cincinati | Chart Settings
2 Youngstown Autn Scale Charts True
4 Cleveland Chart Calors Color Stheme
=2 Where ks the capital af Ferr || ot 0 el
1 Pitsturgh Chart value Format 0%
2 Harrishurg Standard Chart Type vertical
3 Scranton
4 Philacelphia Competition Settings J
53 Where is the capital of the L ||
1 Washingtan State Default Humber of Teams 5
2 Washington, P4 Include Non-Responders Falsa
3 Washingtan D.C. Maximum Responders s
4 Washington, NC — || Participants In Leaderboard 5
= 4 Where ks the capital of New || Teams In Leaderboard s
1 Albuguergue
2 SantaFe Misc
j ED;\SA;ZEDS AdcHn ahways Ioaded False
. 1 5 || correct Paint value 100 @
© Common seths Al setngs

Selecting Presentation affects all of the slides in the
presentation. You will need to select the All Settings to reveal
the Zero-Based Polling Option for the Presentation. Selecting
a Slide affects the currently selected slide.



3 Under the Misc heading, A drop-down menu appears to the right.
select Zero-Based Polling.
Settings Window: Enable Zero-Based Polling

*'w TurningPoint - Settings

Settings | poling Test

Respanse Device A Misc
Presentation [
=2 Where is the capital of Ohic
1 Columbus
2 Cincinnati

Add-In always Iaded False
allow Duplicates False
Allowr User Feedback True

3 Youngstown Aut-Update Aliases Tre
4 Cleveland Correct Point Value 150

53 Whers fs the capital of Penr || DBt Participant Setting Anonymous
1 Pitsburgh Default Save Location €:\Dacuments and Setting
2 Harrisburg Include Presentation True
3 Scranton Incorrect Point Value =0
4 Philadelphia Input Source Response Devices

Language English

4 Where is the capital of the L
1 Washington State
2 Washington, PA
3 Washington D.C.
4 \Washington, NC
=5 Where Is the capital of New

Multiple Response Divisor Devices
Responses
Zero Based Polling

Moment to Moment Settings

1 Albugueroue Palling Cycle 2
2 SantaFe
3 Los Alamos Esenter vPad Settings
4 Carlsbad s
< > Default Port Murnber 1001 ~
© Common Settings () All Ssttings
Zero Based Polling
Enables answers to be numbered 1-10 o 0-9, Zero Based Polling will averride current answer bullet Format.
4  Use the drop-down menu to Your answers are now numbered 0 to 9. To enable Zero-Based
select True. Polling for the entire presentation, you will need to select “Apply
All.”

Identify a Correct Answer from the Settings Window

You can specify whether answers in your TurningPoint slides should be considered correct or
incorrect from the Settings window. By setting answer values, you can show the correct answer after
polling with a Correct Answer indicator (find more information in Add a Correct Answer Indicator on
page 143) or by coloring the chart to indicate correct and incorrect answers (find more information in
Change Chart Colors on page 118).

You can set keywords for fill in the blank questions. If a response contains the keyword, it will be
considered correct. Find more information in Use Keywords for Fill in the Blank Slides on page 95.

You can identify a correct answer to a question from the Settings window. By default, answers marked
Correct have a value of 100 points, and answers marked Incorrect have a value of 0 points for the
purposes of scoring and competition. (Find information about assigning specific point values to



answers in Set Point Values from the Settings Window on page 97 or Set Point Values on a
TurningPoint Slide on page 103.)

Step by Step Instructions To mark an answer correct from the Settings window...

1 In the TurningPoint Toolbar, This displays the Settings window
select Tools > Settings (Hint:

’ H - -
It's the one that looks like a Settings Window
pair of glasses). & TurningPoint - Setings EEx

Settings [ Poling Test
Response Device ~|| Answer Settings ]
" I
=1 Where & the capital of Ohic || Answer Bullet Format Decimal Period
1 Columbus )
2 Cincinati | Chart Settings
3 V“]“”g‘smdw” Autn Scale Charts True
4;“:’1 o Chart Calars Color Scheme
=2 el TEP'@ ofPen || chartLabels Bliases
1 P i Chart Value Farmat 0%
2 Harrisburg Standard Chart Type Vertical
3 Scranton
4 Philacielphia Competition Settings L)
=3 Where is the capital of the U ||
1 Washington State DefaLlt Murnber of Tearms 5
2 Washington, P4 Include Non-Responders Falsa
3 Washingtan D.C. Maximum Resporders s
4 \Washington, NC — || Participants In Leaderboard 5
=4 Where s the capital of New || Teams In Leaderboard s
1 Albuguergue
2 SantaFe Misc
j ED;\SA;ZEDS AdcHn ahways Ioaded False
& 1 5| || Correct Point value 100 2
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2 From the Settings Hierarchy,
find the slide on which you
would like to identify a correct
answer.

3 Select the Answer you want
to identify as correct.

4 Select Correct from the
Answer Value drop down
menu.

This displays the settings for that answer.

Settings Window: Answer Settings

Settings | Poling Test |

Response Device
Presentation
&2 where & the capital of ohic

2 Cincinnati
3 Youngstown
4 Cleveland
=3 Where is the capital of Penr
1 Pittsburgh
2 Harrisburg
3 Scranton
4 Philadelphia
4 Where is the capital of the L
1 Washington State
2 washington, P4
3 Washington D.C.
4 washington, HC
=5 Where Is the capital of New
1 Albuguergue
2 SantaFe
3 Los Alamos
4 Carlsbad

E3

Answer Settings

Answer Alias
Answer Yalug

Colurnbus
Mo Vale

(@ Comman Settings

© Al Settings

gPoint - Settings:

Settings | Poling Test |

Settings Window: Select Correct

EEX

Response Device
Presentation
2 Where is the capital of Ohic
1 Columbus
2 Cincinnati
3 Youngstown
4 Cleveland
3 Where is the capital of Perr
1 Pittsburgh
2 Harrisburg
3 Scranton
4 Philadelshia
4 Where is the capital of the L
1 Washington State
2 washington, PA
3 Washington D.C.
4 washington, NC
©-5 Where is the capital of New
1 Albuguergue
2 SantaFe
3 Los Alamos
4 Carlsbad

Answer Settings

Answer Alias
Answer Valle

Columbus

alu

(%) Commen Settings

) Al settings

Answer Value

The value for the answer, Valid answer values are: Correct Incorrect +- L0000 No Yalue




TurningPoint sets the selected answer as Correct and
automatically sets other answers as Incorrect.

Note You can also set the Correct or Incorrect
from the slide. Find more information in
Identify a Correct Answer on a
TurningPoint Slide on page 92.

You can have more than one correct answer on a slide by
repeating these steps on another answer.

You can change an answer you marked as Correct to
Incorrect by repeating these steps and selecting Incorrect
from drop down menu.

Identify a Correct Answer on a TurningPoint Slide

You can specify whether answers in your TurningPoint slides should be considered correct or
incorrect. By setting answer values, you can show the correct answer after polling with a Correct
Answer indicator (find more information in Add a Correct Answer Indicator on page 143) or by
coloring the chart to indicate correct and incorrect answers (find more information in Change Chart
Colors on page 118).

You can set keywords for fill in the blank questions. If a response contains the keyword, it will be
considered correct. Find more information in Use Keywords for Fill in the Blank Slides on
page 95.

You can identify a correct answer to a question on a TurningPoint slide. By default, answers marked
Correct have a value of 100 points, and answers marked Incorrect have a value of 0 points for the
purposes of scoring and competition. (Find information about assigning specific point values to
answers in Set Point Values from the Settings Window on page 97 or Set Point Values on a
TurningPoint Slide.)



Step by Step Instructions To mark an answer correct...

1 Navigate to the slide on
which you want to mark a
Correct Answer.

2 Place your cursor in the An Answer Values Task Pane appears listing all of the answers
Answer region of the slide. and current answer values.

Answer Values Task Pane

TurningPoint 2008 - Answer Yalues ¥ X

Clear Al Answer Values

Answer 1: Columbus
Answer Yalue:

Answer 2: Cincinnati
Answer Yalue:!

Incomect hd

Answer 3 Younadstawn
Answer Yalue:!

Incorect v

Answer 4! Cleveland
Answer Yalue:!

Incorect v




3 Select Correct from the
Answer Value drop-down
menu.

TurningPoint sets the selected answer as Correct and
automatically sets other answers as Incorrect.

Answer Values Task Pane: Select Correct

TurningPoint 2008 - Answer Yalues ¥ X

Clzar All Answer Yalues

Answer 1: Columbus
Answer Yalue:

' alug |

Tect

Set Paints

ANswWer 31 Younastawn
Answer Value:

Inconect v

Answer 4 Cleveland
Answer Yalue:

Inconect v

Note You can also set the Correct or Incorrect
value in the Answer Value setting, a slide-
level setting for each answer. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

You can have more than one correct answer on a slide by
repeating these steps on another answer.

You can change an answer you marked as Correct to
Incorrect by repeating these steps and selecting Incorrect
from the contextual menu instead.



Use Keywords for Fill in the Blank Slides

Fill in the Blank slides, by their nature, do not have enumerated answers. You can, however, specify
that responses to a Fill in the Blank slide be counted as correct if it contains a certain word or words—
a “keyword.”

Step by Step Instructions To use keywords...

1 Open the Settings window The Settings window opens.
from the TurningPoint toolbar
by selecting Tools > Settings.

(Hint: It's the one that looks

Settings Window

*'w TurningPoint - Settings

like a pair of eyeglasses.) T T e
. “ll Answer Settings ~
is the capital of Ohic Answer Bullet Format Decimal Period
1 Columbus .
2 Cincinnati | Chart Settings
3 V‘D“”Q‘E'Eéw” Autn Scale Charts True
"hC - o Chart Calers Color Scheme
gz w ol Ehﬁp“a ofPenr || Chart Labels Aliases
1 Pt ng Chart Value Farmat 0%
2 Harrisburg Standard Chart Type wertical
3 Scranton
4 Philacelphia Competition Settings d
53 Whers ks the capital of the L ||
1 Washington State Default Nurmber of Teams S
2 washington, P& Include NerRespanders Falkse
3 Washington D.C Maximum Responders 5
4 Washington, NC —|| Participants In Leaderboard 5
54 Whers is the capital of New || Teams In Leaderboard 5
1 Albuquerque
2 SantaFe Misc
j E”:H:;‘:g‘“ || de-n abways maded False
< | s Correct Point Value 100 a
©Conmansetings O Al setngs




Chapter 3: Creating and Saving Slides

2

If it is not already selected,
select the slide on which you
would like to assign keywords
from the Settings Hierarchy.

Under Misc headings, select
Keywords.

4  Type the word(s) to include

as keywords in the space
provided.

Select the Done button in the
Settings window to save your
changes.

Settings Window: Keywords

Note The Keywords setting will only be displayed if
you select a Fill in the Blank or Essay slide.
Although you can assign keywords for Essay
slides, keywords are only considered for Fill
in the Blank slides for reporting and grading
purposes.

You can separate multiple keywords with commas.
Responses containing any of the keywords will be counted as
correct.
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Set Point Values from the Settings Window

The answer values are used to compute the scores in the summary slides for competitions.
Additionally, they are available in TurningPoint Reports. Find more information in Reports on
page 341.

You can set numerical point value for an answer in the range of negative 10,000 - 10,000. An answer
set as Correct has a default point value of 100. An incorrect answer has a default value of 0.

You can assign different point values to different answers (if one answer should be awarded more
than another, for example).

You can change the default point value settings for both correct and incorrect answers at the
Presentation or Slide level form the Settings window. For instance, you could enable participants to
receive positive points even if they answer incorrectly. To do this, you must first change the point
value at the Presentation or Slide level from the Settings window. Then set the appropriate answers
as Incorrect directly on the TurningPoint slides or at an Answer level from the Settings window.
Conversely, you can enable participants to receive negative points for correct answers in the same
way. Change the point value at the Presentation or Slide level from the Settings window. Then set the
appropriate answers as Correct directly on the TurningPoint slides or at an Answer level from the
Settings window.(Find more information about Settings in TurningPoint Device and Settings
Management on page 153.)

You can identify a correct or incorrect answer by following the instructions in Identify a Correct
Answer from the Settings Window on page 89 or Identify a Correct Answer on a TurningPoint
Slide on page 92.

If you assign negative points to a correct answer or positive points to an incorrect answer, use the
Point Value reports. The Percentage Reports will treat the correct answers with negative point values
as incorrect answers and incorrect answers with positive point values as correct answers.



Step by Step Instructions To set a point value for an answer...

1 In the TurningPoint toolbar, This displays the settings window.
select Tools > Settings.
Settings Window

Settings | Poling Test
Response Device ~|| answer settings A
the capital of Ohic| || Answer Bullet Farmat Decimal Period
1 columbus )
2 Cincinnati | Chart Settings
3 V‘U“”g‘smdw" Auto Seale Charts e
4hc . o Chart Cakors Coler Scheme
22 W E’EE itap't‘a OFPENT | chart Label Aliases
1 Pitis “h“g Chart Value Format 0%
2 Harrishurg Standard Chart Type Vertical
3 Seranton
4 Philadelphia Competition Settings -
=3 Where s the capitalofthe U ||
1 Washington State Default Nurmber of Teams 5
2 Washington, P& Include Non-Responders False
3 washington D.C. Masimum Respanders 5
4 Washington, NC || Participants In Leaderboard 5
= 4 where s the capital of New || Teams In Leaderboard 5
1 Albuguerque
2 SantaFe Misc
3 Los Al
. o || AdHIn always loaded Fake
4 | s || corrert Pot value 1m0 .

To assign the same point values to the whole presentation, go
to step 2. To assign point values to a specific slide, go to
step 3.



2 Assign the same point values
to the whole presentation.

a Select Presentation from
the Settings Hierarchy.

b Under the Misc heading,
select Correct Point Value.

Modify Slides

This displays the available presentation settings.

= TurningPoint - Settings

Settings | Paling Test

Settings Window:

Presentation Settings

- Respanse Device
P tion

[:3

w

-1 Where is the capital of Ohic

1 Columbus

2 Cincirnati

3 Youngstown

4 Cleveland

where is the capital of Penr
1 Pittsburgh

2 Harrishurg

3 Scranton

4 Philadelphia

Wihere is the capital of the L
1 Washington State

2 \Washington, PA

3 Washington D.C.

4 tWashington, NC “
wihere is the capital of New

1 Albuguerque

2 santaFe

3 Los Alamos

4 Carlshad L

n

IS

il | ]l

Answer Settings

Answer Bullet Format

Chart Settings

Auto Scale Charts
Chart Colors

Chart Labels

Chart Vale Format
Standard Chart Type

Competition Settings

Default Number of Teams
Include Non-Responders
Maximum Respanders
Participants In Leaderboard
Tearns In Leaderboard

Misc

Ade-In abways loaded

Carrect Point Value

Decimal Period

True

Color Scherme
Alizses

0%

‘ertical

I

Restore default presentation settings

(® Common Settings

© Al Settings

Dane

This displays a text box to enter the value you want
correct answers to receive.

Settings Window: Correct Point Value

Correct Point Value

TurningPoint User Guide
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Chapter 3: Creating and Saving Slides

c Enter the correct point
value.

d Hit the Enter key.

e Under Misc heading,
select Incorrect Point
Value.

f Enter the incorrect point
value.

g Hit the Enter key.

TurningPoint sets the point value for the presentation.

To set incorrect point values, go to step f. If you are
done setting point values go to step 4.

This displays a text box to enter the value you want
incorrect answers to receive.

Settings Window: Incorrect Point Value

Incorrect Paint Value

TurningPoint sets the point value for the presentation.

Repeat steps a through d for each slide on which you
want assign and individual point. Otherwise go to
step 4.
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3 Assignindividual point values
to a specific slide.

a Select the slide from the
Settings Hierarchy.

Modify Slides

This displays the available slide settings.

= TurningPoint - Settings

Settings | Paling Test

Settings Window: Slide Settings

- Resporse Device || chart settings L

Presentation

B R Chart Calers User Defined
1 Columbus Chart Labels Aliases
2 Cincinnati Chart Value Farmat o%
3 Youngsiown = || Review Only False
4 Clevelard )

3 wwhere is the capital ofPenr || ™S
1 Pittsburgh Allow Duplicates False
2 Harrisburg Sl anorymous Fake =
3 Seranton Correct Point Value 100
4 Philacelphia Bermographic Fake

4 Whers is the capital of the L | 1y orrect point vale a
T Washingtnn Stte Multiple Respanse Divisor Devices
2 Washington, PA Question Alias Wihere & the capital of Ohio
3 Washington D.C. Response Data The
4 Washington, NC Resporses .

5 Where & the capital ofew || g cecl The
T Albugierque 2ero Based Poling False N
2 samare
3 Los Alamos Response Reminders Settings
4 Carlsbad e

1€ i I > || Auto-advance False ~|

Defaults apply Al

(® Common Settings

© Al Settings

Dane

b Under the Misc heading,
select Correct Point Value.

This displays a text box to enter the value you want

correct answers to receive. The value can range from
negative 10,000 to 10,000

Settings Window: Correct Point Value

Carrect Point Value

TurningPoint User Guide
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Chapter 3: Creating and Saving Slides

c Enter the correct point

value.
d Hit the Enter key. The correct point value is set. To set incorrect point
values, go to step 3. If you are done setting point values
go to step 4.
e Under Misc heading, This displays a text box to enter the value you want
select Incorrect Point incorrect answers to receive. The value can range from
Value. negative 10,000 to 10,000.

Settings Window: Incorrect Point Value

Incorrect Paint Value

f Enter the incorrect point
value.

g Hit the Enter key. The incorrect point value is set.

Repeat step 3 for each slide on which you want to
assign individual point values. If have finished setting
point values go to step 4.

102 Turning Technologies



You can change the point value you set by repeating
these steps on the same slide and entering the new point
value instead.

Note If you have assigned negative points to a
correct answer or positive points to an
incorrect answer, use the Point Value
reports. The Percentage Reports will treat
the correct answers with negative points
values as incorrect answers and incorrect
answer with positive point values as correct
answers.

4 Select Done. You can award points for answers proportionally to how quickly
participants respond using speed scoring. Find more
information in Use Speed Scoring on page 113.

You can use speed scoring in competitions to award more
points to faster responders. Find more information in Use
Speed Scoring on page 113.

You can clear the point value for a particular answer or for all
answers on the slide by following the instructions in Clear
Answer Values from the Settings Window on page 108 or
Clear Answer Values on a TurningPoint Slide.

Set Point Values on a TurningPoint Slide

The answer values are used to compute the scores in the summary slides for competitions.
Additionally, they are available in TurningPoint Reports. Find more information in Reports on
page 341.

You can set numerical point value for an answer in the range of negative 10,000 - 10,000. An answer
set as Correct has a default point value of 100. An incorrect answer has a default value of 0.

You can assign different point values to different answers (if one answer should be awarded more
than another, for example).



You can change the default point value for both correct and incorrect answers. Additionally, you
could enable participants to receive positive points even if they answer incorrectly. Conversely, you
could enable participants to receive negative points if they answer correctly. Find more information
in Set Point Values from the Settings Window on page 97.

You can identify a correct or incorrect answer by following the instructions in Identify a Correct
Answer from the Settings Window on page 89 or Identify a Correct Answer on a TurningPoint
Slide.



Step by Step Instructions

1

Navigate to the slide on
which you want to set point
values.

Right-click on the picture (for
a picture slide) or the number
of the answer (for all other
slides).

Modify Slides

To set a point value for an answer...

The answer is highlighted and a contextual menu opens. At the
bottom of this menu, note the group of items including Set Point
Value.

Contextual Menu

Set as Correct
Set as Incorrect
Set Point Yalue

Clear Answer Yalue

Clear all Answer Values

TurningPoint User Guide
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3 Place your cursor in the
Answer region of the slide.

An Answer Values Task Pane appears listing all of the
answers and current answer values.

TurningPoint 2008 - Answer Yalues ¥ X

Clzar All Answer Yalues

Answer 1: Columbus
Answer Yalue:

Correct A

Answer 2 Cincinnati
Answer Valle:

Incamect v

ANswWer 31 Younastawn
Answer Value:

Inconect v

Answer 4 Cleveland
Answer Yalue:

Inconect v

Answer Values Task Pane



4 Select Set Point Value from Answer Values Task Pane: Select Set Points
the Answer Value drop_down TurningPoint 2008 - Answer ¥alues ¥ X

box.
Answer 1 Calumbus

Answer Yalue:!

Correct v

NoValue
Corect

Answer 2:{Inca

t

S ts

Incorect v

Answer 3 Youngstown
Answer Yalue:

Incorect v

Answer 4: Cleveland
Answer Yalue:

Incorect v

A dialogue box asking you to enter a point value opens.

Point Value Dialog Box

TurningPoint

Pleaze enter a paint walue +4 10000,




5 Enter a point value in the TurningPoint sets the point value for the selected answer.
space provided and click the
OK button .

Note You can also set the point value in the
Settings menu after selecting a specific slide.
Under Misc, enter the desired point values
beside Correct Point Value and Incorrect
Point Value. Find more information about
modifying settings in Settings on page 189.

You can set the point value for another answer by repeating
these steps on another answer.

You can change the point value you set by repeating these
steps on the same answer and entering the new point value
instead.

You can award points for answers proportionally to how
quickly participants respond using speed scoring. Find more
information in Use Speed Scoring on page 113.

You can use speed scoring in competitions to award more
points to faster responders. Find more information in Use
Speed Scoring on page 113.

You can clear the point value for all answers in a presentation
by following the instructsions in Clear Answer Values from
the Settings Window on page 108. You can clear the point
value for a particular answer or for all answers on the slide by
following the instructions in Clear Answer Values on a
TurningPoint Slide on page 111.

Clear Answer Values from the Settings Window

If you wish to reset answer values from the Settings Window, you will reset all presentation settings
to the default settings. Find more information on resetting individual answers in Clear Answer
Values on a TurningPoint Slide on page 111.



Step by Step Instructions

1 From the TurningPoint
toolbar select, Tools >
Settings.

2 Select Presentation from the
Settings Hierarchy.

To clear the values for a presentation...

This displays the Settings Window.

Modify Slides

Settings Window

= TurningPoint - Settings (=]
Settings | Polling Test
- Response Device Al answer settings B
F ion r
‘1 Where & the capital of Ohic || Answer Bullet Farmat Decimal Period
1 Columbus .
2 Cincinnati Chart Settings
3 V‘”“"g‘s“jdw” Auto Scale Charts The i
“hc o o Chart Calers Color Scheme 7
2 g i(ap"‘a OPeNT | Chart Labels aliases
1 Pt “h'9 = || chart value Format 0%
2 Harrisburg Standard Chart Type vertical
3 Scranton
4 Philadelphia Competition Settings L
3 Where is the capital of the U [
1 Washington State Default Number of Teams s
2 Washington, P4 Include Mon-Responders False
3 washington D.C. Maximum Responders s
4 Washington, NC || Participants In Leaderboard 5
4 Where is the capital of Mew || Teams In Leaderboard s
1 Albuguerque
2 SantaFe Misc
3 Los Al
o | Agetn aiware naded False
< " | 5 || ComeetPaint vale 100 gl
@ Common Settings () All Settings

Dane

This displays the available presentation settings and the

Restore default presentation settings button.

Settings Window: Restore default presentation settings

Restore default presentation settings

button

TurningPoint User Guide
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3 Select the Restore default

presentation settings button.

4 Select Yes to clear answer
values.

5 Select the Done

This displays a box warning that all settings will be restored
back to the default state.

Restore default presentation settings Warning

TurningPoint

This will restare the presentation settings back to the default installation state.
Do you want ko continue?

TurningPoint resets all of your answer values to the default
values.

Select No if you do not wish to reset all of the settings back to
the default state.

Note To clear an answer value, you can also set
No Value in the Answer Value setting, a
slide-level setting for each answer. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

Find information for setting Correct or Incorrect values in
Identify a Correct Answer from the Settings Window on
page 89 or Identify a Correct Answer on a TurningPoint
Slide on page 92.

Find information for setting point values in Set Point Values
from the Settings Window on page 97 or Set Point Values
on a TurningPoint Slide on page 103.



Clear Answer Values on a TurningPoint Slide

If you wish to reset answer values, you can clear the value from one or all answers.

Step by Step Instructions

1 Navigate to the slide on
which you want to clear
answer values.

2 Place your cursor in the
Answer region of the slide.

To clear the values for an answer...

An Answer Values Task Pane appears listing all of the answers
and current answer values.

Answer Values Task Pane

TurningPoint 2008 - Answer Yalues ¥ X

Clear all Answer Values

Answer 1: Columbus
Answer Yalue:

Correct v

Answer 2: Cincinnati
Answer Yalue:!

Incomect ~

Answer 31 Younastown
Answer Yalue:!

Incorect v

Answer 4 Cleveland
Answer Yalue:!

Incorect v




Chapter 3: Creating and Saving Slides

3 Select the Clear Answer
Values box.

Answer Values Task Pane: Clear Answer Values

Clear All Answer Yalues

The answer values for all answers on the slide are set to No
Value.

Note To clear an answer value, you can also set
No Value in the Answer Value setting, a
slide-level setting for each answer. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

Find information for setting Correct or Incorrect values in
Identify a Correct Answer from the Settings Window on

page 89 or Identify a Correct Answer on a TurningPoint
Slide on page 92.
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Find information for setting point values in Set Point Values
from the Settings Window on page 97 or Set Point Values on
a TurningPoint Slide on page 103.

Use Speed Scoring

Speed scoring awards points proportionally based on how quickly a participant responds. Any slide
with correct or point-value answers marked can be used for speed scoring.

If you use speed scoring, a participant receives all the points for a answer when responding correctly
before the countdown begins. When the countdown begins, the points a participant is awarded are
scaled proportionally by the amount of time remaining. In a 10-second countdown, a response with 5
seconds remaining is awarded half (5/10) the points. Below are two examples.

Example 1: Answer A is given a point value of 10 points. When polling opens, if the participant selects
answer A immediately they will receive 10 points. As the countdown timer counts down from 10, the
point value decreases. If the participant selects answer A with 5 seconds left, they receive 5 points. If
the participant does not select answer before the timer hits zero they receive no points.

Example 2: Answer B is given a point value of -10 points. When polling opens, if the participant
selects answer B immediately they will receive -10 points. As the countdown timer counts down from
10, the point value decreases. If the participant selects answer B with 5 seconds left, they receive -5
points. If the participant does not answer before the timer hits zero they receive no points.

Before You Begin

To use speed scoring, you should set points for one or more answers on the slide. Find information on
setting points in Set Point Values from the Settings Window on page 97 or Set Point Values on a
TurningPoint Slide on page 103.

You must use a Countdown indicator to use speed scoring. Find more information in Add a
Countdown Indicator on page 132.



Step by Step Instructions

1

Open the Settings window
from the TurningPoint toolbar
by selecting Tools > Settings.
(Hint: It's the one that looks
like a pair of eyeglasses.)

If it is not already selected,
select the slide on which you
would like to enable speed
scoring from the Settings
Hierarchy.

To use speed scoring...

The Settings window opens.

¥ a TurningPoint - Settings

Settings | Poling Test

Settings Window

Response Device ~
P on
=1 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Vaungstown
4 Cleveland
=2 Where is the capital of Perr
1 Pitisburgh
2 Harrishurg
3 Seranton
4 Philadelphia
=3 Where is the capital of the L
1 washington State
2 Washington, PA
3 Washington D.C.
4 Washingtan, NC =
=4 Where is the capital of New
1 Albuguergue
2 santaFe
3 Los Alamos
4 Carlsbad
< ) >

K3

Answer Settings
Answer Bullet Format
Chart Settings

Auto Scale Charts
Chart Colors

Chart Labeks

Chart Value Format
Standard Chart Type

Competition Settings

Default Nurmber of Teams
Include Non-Responders
Masimum Respanders
Participants In Leaderboard
Tearns In Leaderboard

Misc

AdeIn ahways loaded
Correct Paint Value

Decimal Period

True

Color Scherme
Aliases

0%

Vertical

Restore default pressrtation ssttings

(@ Common Settings

EEX
~
-
O Al Settings

Done




Modify Slides

3 Select Speed Scoring under A drop-down menu will appear next to the value for the Speed
the Misc header. Scoring setting,.

Settings Window: Speed Scoring

Speed Scoring
zero Based Polling

4 Select True from the menu to Select False to disable speed scoring.
enable speed scoring.

5 Select the Done button in the
Settings window to save your
changes.

Create Picture Slides

Instead of using textual answers in the answer region, you can use pictures. This is useful if you pose
a question with visual responses or where a visual aid will help the audience choose.
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Step by Step Instructions To create a picture slide...

1 Create a TurningPoint slide. It is recommended that you use descriptive words or phrases
for the answer text in the answer region because this text will
still be used for the chart labels, even though the text in the
answer region will be replaced by pictures.

Find more information on creating a slide in Insert a Slide on
page 51.

Nofte Since you'll be using pictures as answers,
the horizontal and offset charts will not align
correctly with the answers. Use a vertical, 3D
pie, distributed pie, or doughnut chart. Find
more information in Types of Slides on
page 56.

2 Insert pictures to use as Insert one picture for each answer.
answers using the options in

. i Find more information on inserting pictures in PowerPoint’s
PowerPoint’s Insert > Picture

online help.
menu.
3 Resize and arrange the Select and drag the picture to reposition it. Select one of the
pictures the way you want side or corner handles and drag to resize the picture. Find

them to appear on the slide. more information in PowerPoint’s online help.



4 To order the pictures
correctly with the answers,
follow these steps:

a First, ensure that no
objects on the slide are
selected by clicking
outside the slide.

b Select the picture that You can tell that the picture is selected when the resize
corresponds to the first handles are shown on its sides and corners.
answer by clicking on it.

c Select the picture that Now both the first and second picture are selected.
corresponds to the second
answer by holding the
Control key on your
keyboard and clicking on
the picture.

d Repeat step c for each

additional picture until you

have selected one for each Note You may include pictures on your slide that
are not associated with one of the answers

answer. (for decoration or illustration). Do not select
these pictures.
5 Select the Convert to Picture Convert Picture Slide Button
Slide button from the 'r
TurningPoint toolbar. (Hint: .7
It's the one that looks like an Convert to
artist’s palette.) Picture Slide




When you select the Convert to Picture Slide button, the
answer region is hidden and the pictures are enumerated with
a label, according to the answers you assigned them.

Picture Slide

i

i
=

i

JNE |

Flag?

Which one is the United States

27%

25%

25%

24%

01 m2 m3 04

After you convert the answers to pictures, you can still resize
and arrange the pictures if you need to adjust them.

Additionally, you can identify a correct answer or set point
values. Find more information in Identify a Correct Answer
from the Settings Window on page 89 or Identify a Correct
Answer on a TurningPoint Slide on page 92and Set Point
Values from the Settings Window on page 97 or Set Point
Values on a TurningPoint Slide on page 103.

Change Chart Colors

The colors used by charts are defined in the TurningPoint settings. By default, the charts take on
the colors defined in your PowerPoint presentation’s color scheme.

Note Chart settings will retain any modifications
you make, even after you add or remove
answers on the modified chart slides.




Step by Step Instructions

1 Open the Settings window
from the TurningPoint toolbar
by selecting Tools > Settings
(Hint: It's the one that looks
like a pair of eyeglasses.)

2 Select the All Settings radio
button.

To change chart colors...

The Settings window opens.

urningPoint - Settings

Settings | Poling Test

Settings Window

Response Device ~

=1 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Youngstown
4 Cleveland
12 Wihere is the capital of Penr
1 Pittsburgh
2 Harrishurg
3 Scranton
4 Philadelphia
=3 Where is the capital of the L
1 Washington State
2 \Washington, PA
3 Washington D.C.
4 tWashington, NC =
14 Wihere is the capital of New
1 Albuguerque
2 santaFe
3 Los Alamos
4 Carlshad

K3

< I >

Answer Settings

Answer Bullet Format

Chart Settings

Auto Scale Charts
Chart Colors

Chart Labels

Chart Vale Format
Standard Chart Type

Competition Settings

Default Number of Teams
Include Non-Responders
Maximum Respanders
Participants In Leaderboard
Tearns In Leaderboard

Misc

Ade-In abways loaded
Correct Point Value

Decimal Period

True

Color Scherme

Alizses
0%
‘ertical

False
100

[E3

Restore default presentation settings

(® Common Settings

© Al Settings

This displays all of the Chart Color settings.

urningPoint - Settings

Settings | Poling Test

Settings Window: All Settings

Response Device ~
Presentation
=2 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Youngstown
4 Cleveland
13 Wihere is the capital of Penr
1 Pittsburgh 3
2 Harrishurg
3 Scranton
4 Philadelphia
=4 Where is the capital of the L
1 Washington State
2 \Washington, PA
3 Washington D.C.
4 tWashington, NC

&5 where s the capital of New
1 Albuguerque
2 SantaFe
3 Los Alamos
4 Carlshad >
< | >

Chart Settings

Auto Scale Charts
Chart Calars

Chart Calor 1

Chart Calar 2

Chart Calor 3

Chart Calar 4

Chart Calor 5

Chart Calor &

Chart Calor 7

Chart Calor 8

Chart Calor 9

Chart Color 10
Chart Color Correct
Chart Calor Incarrect
Chart Labels

Chart Value Format
Reset Charts

Review Only
Standard Chart Type

Competition Settings

True
User Defined
]

Aliases
0%
True
False
wertical

[E3

Restore default presentation settings

© Common Settings

@\}MI Settings




3 Select Presentation ora Slide The level at which you change the settings controls which

from the Settings Hierarchy slides are affected:

to specify whether you'd like

to make changes to chart Making changes at the presentation level affects all
colors on the presentation slides you create in the future and modifies all slides in
level or slide level. the current presentation.

Making changes on the slide level affects only the slide
you select.

If you make changes on the slide level, you must select the
slide you wish to be affected from the Settings Hierarchy.

4 Locate the Chart Colors A downward arrow will appear next to the value for the Chart
setting in the Chart Settings Colors setting, indicating that you can select a value for the
group and select it. setting from a drop-down menu.

Chart Colors Setting

= TurningPoint - Settings

Settings | Palling Test

Response Device ] . ]
BiEsentEhoy, Chart Settings
2 where & the capital of Ohic
1 Columbus autn Scale Charts
2 cincirnati Chart Calors
-3 Youngstown Chart Color 1
4 Cleveland Chart Color 2
Lser Defined
3 where is the capital of Penr Chart Color 3
1 Pitisburh Chart Calr 4
-2 Harrisburg Chart Color 5
3 Scranton Chart Calor & oo
-4 Philadelphia Chart Color 7 251020
4 Where & the capital of the U || Chart Calor & 25,00
-1 Washington State Chart Color 9
2 washington, P4 Chart Color 10
-3 Washington D.C. Chart Color Correct
4 washingion, NG Chart Calor Incrrect BT I—
S Where s the capital of New || Chart Labels Aliases
1 Albuguergue Chart Value Farmat 0%
2 SantaFe Reset Charts True
3 Los Alaros Review Only False
4 Carlsbad %|| Standard Chart Type Vertical
[E2] —— 3 I
[ Restore defaul presentation settings | [ Defauks | [ apply Al | © Cornmon Settings (& All Settings
Chart Colors
Determines which chart colors wil be used,
5 Select a value for the Chart There are three options:

Colors setting.
Color Scheme, which uses the color scheme of your
PowerPoint presentation.



User Defined, which uses ten user-defined colors.

Correct Incorrect, which uses two user-defined colors,
one for correct answers and one for incorrect. (The
default colors for correct and incorrect are green and red
respectively.)

Note Wnhen Color Scheme is selected, PowerPoint
reverses the color order for Horizontal and
Offset Charts. Example: If your color scheme
has Light Blue, Blue, Aqua, and Green with
Light Blue as the first color to be displayed
and Green as the last, PowerPoint will
display the colors in reverse for Horizontal
and Offset Charts. Green is the first color
displayed and Light Blue is the last.




Chapter 3: Creating and Saving Slides

6 If you chose to use User
Defined or Correct Incorrect,
specify the colors to use by
completing the following

steps:

a Select Chart Color 1 The Select Chart colors pop-up window opens:
through Chart Color 10 or
Chart Color Correct/Chart Settings Window Chart Colors

Color Incorrect from the
Settings window.

Chart Color Correct
Chart Color Incarrect

b Select one of the colors A grid of 40 color swatches you can choose from is
labeled 1-10 or Correct displayed.
and Incorrect.
Color Swatches

EEEEEEEE

EEEEEEERDE
EEEEEEEDE
EE EEENEE
W NET

c Select a color from the The grid of swatches closes and the color is assigned.

swatches. To change all colors back to their defaults, select the
Defaults button.

122 Turning Technologies



d Repeat steps b—c for all
colors you would like to
change.

e Select the Done button to
save the changes to the
colors.

7 Select the Done button in the
Settings window to save your
changes.

If you made changes to the presentation-level setting, all slides
in your presentation will reflect the new colors, as will any new
slides you create.

If you made changes to the slide-level setting, the slide you
selected will reflect the new colors.

Make a PowerPoint Slide Interactive by Inserting a Chart

You can make an ordinary PowerPoint slide interactive by adding a chart to a slide that already has a

question and a list of answers.

Create one or more slides in PowerPoint with a title and a bulleted or numbered list.

When you convert the slide to a TurningPoint slide using the following instructions, the title will
become the question and the bulleted or numbered list will become the list of answers. You can

include up to ten answers.



Step by Step Instructions

1

Navigate to the PowerPoint
slide in your presentation that
you would like to convert to a
TurningPoint slide.

Select Insert Object from the
TurningPoint toolbar.

To convert a PowerPoint slide to an interactive slide...

The Insert Object menu opens.

E x Response Devices
+

Insert | Tools

Object =] =
Charts L
Answer Now L
Countdown L4
Response Counter g
Response Table k

Correct Answer Indicator »

Stats 4

=l | Tewmt Message

Insert Object Menu



3 Select Charts to display the A list of available charts is displayed.
Charts submenu.
Insert Object: Chart Selection

.

Insert

Object ~
Charts » | il vertical
Answer Now » | = Horizontal
Countdown b | @@ | 3D Pie
Response Counter 4 i?} Distributed Pie
Response Table v || Offset
Correct Answer Indicator *» | & Doughnut
Stats L4

= Text Message

4 Select a chart to add to the Find more information on chart types in Chart Slides on

slide. page 57.

When you select the chart to be added, TurningPoint converts
the title of your slide to the question, the bulleted or numbered
list to the answers, and adds the chart to the slide.

Note The bulleted or numbered answer list is re-
numbered according to your TurningPoint
settings.

You can modify the numbering scheme for
answers in the Answer Bullet Type setting, a
presentation-level setting. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

You now have a functioning TurningPoint slide.



Disable Auto Scale in Charts

When you insert a slide in TurningPoint, vertical charts are set to auto scale according to their
percentages. You can make vertical charts appear more realistic by disabling the Auto Scale Charts

setting.

Step by Step Instructions

1 In the TurningPoint toolbar,
select Tools > Settings (Hint:
it looks like a pair of
eyeglasses).

To disable Auto Scaling...

¥ TurningPoint - Settings

Settings | Poling Test

Settings Window

1 Columbus
2 Cincirnati
3 Voungstown
4 Cleveland
=2 \Where is the capital of Perr
1 Pittsburgh
2 Harrishurg
3 Scranton
4 Philadelphia
=3 Where is the capital of the L
1 Washington State
2 Washington, P&
3 Washington D.C
4 Washington, NC 2
=4 Where is the capital of New
1 Albuguergue
2 SantaFe
3 Los Alamos

4 Carlshad
< I >

Answer Settings

Answer Bullet Farmat

Chart Settings

Autn Seale Charts
Chart Calors

Chart Labels

Chart Value Farmat
Standard Chart Type

Competition Settings

Default Humber of Teams
Include Nor-Respanders
Maximum Responders
Farticipants In Leaderboard
Tears In Leaderboard

Misc.

AddHn ahways Ioaded

|| Correct Point Yalug

Decirmal Period

True
Color Scheme
Aliases

0%

vertical

Restors defaul presertation settings

(%) Commen Settings

(3 Al settings.




Modify Slides

2 Select the Presentation from
the Settings Hierarchy.

3 Under the Chart Settings A drop-down menu appears to the right.
heading, select Auto Scale

Charts. Auto Scale Setting

4 Select False from the drop- Auto Scale has been disabled.

down menu. Charts that you insert from this point will not Auto Scale.

Next Steps

To enable Auto Scale, repeat steps 1 through 3 and select True from the drop-down menu.
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Add Objects

TurningPoint offers several special objects you can add to your slides: Answer Now Indicator,
Countdown Indicator, Countdown Sound, Response Counter, Response Table, Correct Answer
Indicator, Text Messaging, Statistics Indicators.

G_i-' x Response Devices
e 3
=

Insert | Tools

Insert Object Menu

Obhject =] =
Charts L4
Answer Mow L4
Countdown L4
Response Counter L4
Response Table 4

Carrect Answer Indicator »

Stats 4

= Text Message

TurningPoint visually identifies when an animated indicator has been used. When PowerPoint is in
Normal view mode, a pane containing both Outline and Slides tabs is visible. If the Slides tab is
selected, a Play Animations button is displayed adjacent to the thumbnail of the slide containing the
indicator. Clicking on the Play Animations button causes the indicator to perform its animation on
the slide.

This section describes how to:

Add an Answer Now Indicator

Add a Countdown Indicator

Add Countdown Sound to a Countdown Indicator
Add a Response Counter

Add a Response Table

Add a Correct Answer Indicator

Add Text Messaging

Add Statistics Indicators



Add an Answer Now Indicator

An Answer Now indicator gives the audience a visual cue that the slide is a TurningPoint slide to
which they have the opportunity to respond. An Answer Now indicator appears during a presentation
when polling opens and disappears when polling is closed.

Note You can specify that an Answer Now
indicator should appear automatically on
each TurningPoint slide that you create using
the Answer Now setting, a presentation-level
setting. Find more information about
modifying settings in TurningPoint Device
and Settings Management on page 153.

Answer Now Indicators are available in 12 styles.

Answer Now Indicators

D Anstoer ot ‘]

vAg
*f:l] e ©

,D.NQ |

® > @ ®

“TAnswer Now Answer Now
o Bevel 9 Left Explosion
9 Right Explosion 6 Scroll
6 Bolt @ Prompt
e Moon @ Sun
@ Banner @ Marquis
m Smiley @ Twilight




The Answer Now indicator can be moved and resized like an ordinary PowerPoint object. You can
change the text “Answer Now” by selecting the text to edit it.

Step by Step Instructions

1

Navigate to the TurningPoint
slide in your presentation to
which you would like to add
an Answer Now indicator.

Select Insert Object from the
TurningPoint toolbar.

To add an Answer Now indicator...

The Insert Object menu opens.

E x Response Devices
F

Insert | Tools

Insert Object Menu

Object =] =~
Charts L
Answer Now L
Countdown k
Response Counter 4
Response Table +

Correct Answer Indicator »

Stats g

= Text Message




3 Select Answer Now to display
the submenu of Answer Now
indicators.

4 Select the type of Answer
Now indicator you would like
to appear on the slide.

5 Z

Answer Now Submenu

Insert
Object
Charts L4
Answer Mow F |E= Bevel
Countdown k| % Left Explosion
Response Counter k| ¥ Right Explosion
Response Table P seroll
Correct Answer Indicator » "%. EBolt
Stats b (E_} Prompt
= | Text Message @' Moon
& sun
%} Eanner
= Marquis
2 | Smiley
= Twilight

When you select the Answer Now indicator, TurningPoint
places it on your slide.

Note

You can change the default text of Answer
Now indicators when they are added to a
page from “Answer Now” to any text of your
choosing using the Answer Now Text setting,
a presentation-level setting. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

You can move,

resize, or change the text of the Answer Now

indicator to better fit your slide. You can also delete the Answer
Now indicator if you no longer want it to appear on the slide.

To replace an existing Answer Now indicator with a different
type, simply repeat these steps. The current Answer Now
indicator will be replaced with the new one you select.




Add a Countdown Indicator

A Countdown indicator gives the audience a visual cue that polling for a question is about to close.
The Countdown indicator shows the number of seconds remaining and counts down to zero. A
countdown can have a maximum length of 999 seconds. The indicator appears during a
presentation when you advance the slide during polling. When the countdown expires, the
Countdown indicator disappears and polling is automatically closed.

You can specify that a Countdown indicator should appear automatically on each TurningPoint slide
that you create using the Countdown setting, a presentation-level setting. Find more information

about modifying settings in TurningPoint Device and Settings Management on page 153.

Countdown indicators are available in 11 styles.

Countdown Indicators

10
Seconds .
Remaining )

N A

o Ball Drop 9 Letter

9 Clock e Hourglass
6 Timer @ Candle

6 Sunset @ No Vote

@ Logo @ Second Hand

m Gemstone



Step by Step Instructions To add a Countdown indicator...

1

Navigate to the TurningPoint
slide in your presentation to
which you would like to add
an Countdown indicator.

Select Insert Object from the The Insert Object menu opens.

TurningPoint toolbar.

E x Response Devices
F

Insert | Tools

Object =| =~
Charts L4
Answer Now L4
Countdown L4
Response Counter 4
Response Table bk

Correct Answer Indicator »

Stats g

= Text Message

Insert Object Menu



3 Select Countdown to display Countdown Indicator Submenu

the submenu of Countdown '
indicators. g"’-’
Insert
Cihject =
Charts L4
Answer Now L4
Countdown L4 @ Ball Drop
Response Counter ¥ | [l | Letter
Response Table F | B Clock
Correct Answer Indicator ¥ ! Hourglass
Stats » | B Timer
= | Text Message L Candle
= | Sunset
@ | Mo Vote
m Logo
¥ | Second Hand
©  Gemstone
4  Select the type of Countdown When you select the Countdown indicator, TurningPoint

indicator you would like to places it on your slide.
appear on the slide.

Note You can change the length of the countdown
in seconds for a particular slide or for all
slides using the Countdown Seconds setting,
a setting available on both the presentation
level and the slide level. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

You can also change the length of the
countdown by double-clicking the number on
the Countdown indicator on the slide. A
dialog box appears prompting you to ‘enter a
value 1-999 for the Countdown time limit.’

You can move or resize the Countdown indicator to better fit
your slide. You can also delete the Countdown indicator if you
no longer want it to appear on the slide.



To replace an existing Countdown indicator with a different type,
simply repeat these steps. The current Countdown indicator will
be replaced with the new one you select.

You can also use Countdown indicators in competition to award
points based on how quickly a participant responds. Find more
information in Add a Countdown Indicator on page 132.

Add Countdown Sound to a Countdown Indicator

A Countdown Sound is a TurningPoint setting that allows you to add sound file to your slide. The
acceptable file extensions include: .aiff, .au, .mid, .midi., .mp3, .wav, and .wma. A Countdown Sound
gives the audience an audible cue that polling for a question is about to close. The sound begins to
play when you activate the Countdown Indicator.

Your slide must have a Countdown Indicator to use a Countdown Sound. To add a Countdown
Indicator see to Add a Countdown Indicator on page 132

Step by Step Instructions To add a Countdown Sound...

1 From the TurningPoint TuringPoint displays the Settings window.
Toolbar, select Tools >
Settings (Hint: It's the one
that looks like a pair of
eyeglasses).



Chapter 3: Creating and Saving Slides

2 Select the Settings Tab.

3 From the Settings Hierarchy, Settings Window
select the slide you want to  TurningPoint - Settngs EEE

d d C t d S d t Settings | poling Test
a a Lountaown soun O. Response Device Al Answer settings L
pre: n ——
o the capital of Ohic || Answer Bullet Format Decimal Period
1 Colmbus
> Creinnat Chart Settings
3 Veungstawn AUt Scale Charts True L
4 Cleveland Chart Colors Color Scheme b
2 where is the capital of e || o e i
1 Pitsburgh ~ || chart vale Format 0%
2 Harrishurg Standard Chart Type vertical
3 Swranton
4 Philadeiphia Competition Settings L
3 Where k the capitalof the L |
1 Washington State Default Nurmber of Teams 5
2 Washingtan, P& Include Non-Responders Fake
3 washington D.C MaKImurm Resporders 5
4 Washingtan, NC || Participants In Leaderboard 5
4 Where is the capital of New || Teams In Leaderboard 5
1 Abugueraue )
2 SantaFe Mise
3 gi‘jb‘jg“ o in iy oac Fake
< T | iJI Correct Point Value 100 a
@ Common Settings () All Settings

All the settings available for that slide are displayed in the right
pane of the settings window. Find the Response Reminders
Settings header.

4 Under Countdown Sound, This opens a folder window.
click on the word None.

Settings Window: Countdown Sound
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5 Navigate to the folder where Countdown Sound: Windows Dialog Box
the sound file you want to use
is located

TurningPoint - Countdown Sound E]
Laok in: ‘_} Sessians v| ¢ ? s (M-

) |)Backup

23 IZ)Real-Time
Iy Fecent
Drocuments

@

Desktap

My Documents

9

hy Computer

‘_;‘] File name: ‘ A | { Open 1

-
My Metwark Files of tupe: ‘ Sound File [ aiff; *.au; *.mid; * midi; . mp3; “wa » | [ Cancel ]

6 Select the file name.

7 Select Open. The file path where the wav or mp3 file is located on your
computer is now listed.

8 Select Done. If your presentation will be used on a computer different from
the one you created it on, ensure that the Countdown Sound
(sound file) can be found on the presentation computer and that
it has the same file path. For example, if the file path for the
Countdown Sound is c:\Documents and Settings\My
Documents\Explosion.wav. You must ensure that the
Countdown Sound is located at the same file path on the
presenting computer or you must go into settings and change
the location by strating this procedure at step 1.



Add a Response Counter

A Response Counter keeps track of how many participants have submitted a response out of the
total number of participants. A Response Counter appears during a presentation when polling
opens and disappears when polling is closed.

Response Counters are available in six styles:

Response Counters

0 of 20

© n ©() o

0
0 0
of of
20 20

o Flag Pole 9 Meter
9 Bubble e Gauge
@ Liquid @ Tube



The Response Counter can be moved and resized like an ordinary PowerPoint object.

Note You can change whether the Response
Counter displays the number or percentage
of participants who have responded (or both)
using the Response Counter Format setting,
a presentation-level setting. Find more
information about modifying settings in
TurningPoint Device and Settings
Management on page 153.

Step by Step Instructions To add a Response Counter...

1 Navigate to the TurningPoint
slide in your presentation to
which you would like to add a
Response Counter.

2 Select Insert Object from the The Insert Object menu opens.

TurningPoint toolbar.
F x Response Devices
=

Insert | Tools

Insert Object Menu

Object =| =~
Charts L4
Answer Now L4
Countdown L4
Response Counter g
Response Table L4

Correct Answer Indicator »

Stats 4

=l | Teut Message




3 Select Response Counter to
display the submenu of
Response Counters.

4 Select the type of Response
Counter you would like to
appear on the slide.

Response Counter Submenu

(2

Insert
Object *
Charts L
Answer Now L
Countdown L4
Response Courter 3 I Flag Pole
Response Table P (= Meter

Correct Answer Indicator » | i Bubble

Stats L I Gauge
= Teut Message D Liquid
B Tube

When you select the Response Counter, TurningPoint places
it on your slide.

Note You can specify that a Response Counter
should appear automatically on each
TurningPoint slide that you create using the
Response Counter setting, a presentation-
level setting. Find more information about
modifying settings in TurningPoint Device
and Settings Management on page 153.

You can move or resize the Response Counter to better fit
your slide. You can also delete the Response Counter if you
no longer want it to appear on the slide.

To replace an existing Response Counter with a different
type, simply repeat these steps. The current Response
Counter will be replaced with the new one you select.



Add a Response Table

A Response Table keeps track of which participants have submitted a response. A Response Table
appears during a presentation when polling opens and disappears when polling is closed. The
Response Table shows each participant’'s number, and a background color that changes when a
response from the participant has been successfully received.

The Response Table is available in two types, fixed and rotating. A fixed table shows all the
participants. A rotating table displays up to 40 participants at a time, and rotates through the list every
few seconds. It shows participants 1-40, then 41-80, and so on. When it reaches the last participant,
the next rotation starts again with 1. A rotating table takes up less space on your slide if you have
more than 40 participants.

Response Table

Where is the capital of Ohio?

Columbus
Cincinnati

Youngstown
50%

A

Cleveland

20% 20%
10%

o
& & &
o

S &

& o 5 &

> & & o
S o <

« < o &

‘1‘2‘3‘4‘5‘6|7J3‘9‘10‘11‘11‘13‘14‘15‘16‘17'13J19‘ZD‘

Note You can specify the rotation interval in
seconds for a rotating Response Table using
the Rotation Interval setting, a presentation-
level setting. Find more information about
modifying settings in TurningPoint Device
and Settings Management on page 153.

The Response Table can be moved and the font can be changed like an ordinary PowerPoint object.



Step by Step Instructions To add a Response Table...

1 Navigate to the TurningPoint Insert Object Menu

slide in your presentation to E x Response Devices
£ .

which you would like to add a

Response Table. Insert | Tools
Object~| -
Charts L4
Answer Now L4
Countdown k
Response Counter 4
Response Table 4

Correct Answer Indicator »

Stats +

=) | Teut Message

2 Select Insert Object from the The Insert Object menu opens.
TurningPoint toolbar.

3 Select Response Table to Response Table Submenu
display the submenu of
Response Tables.

Insert

Cihject ~
Charts L
Answer Now L
Countdown L4
Response Counter 4
Response Table F B Fixed Table

Correct Answer Indicator » | Bl Rotating Table

Stats g

= | Text Message




4 Select the type of Response See above for information on the differences between fixed and
Table you would like to rotating Response Tables.
appear on the slide (fixed or

i When you select the Response Table, TurningPoint places it on
rotating).

your slide.

You can move the Response Table and change the font it uses
to better fit your slide. You can also delete the Response Table
if you no longer want it to appear on the slide.

To replace an existing Response Table with a different type,
simply repeat these steps. The current Response Table will be
replaced with the new one you select.

Note You can specify that a Response Table
should appear automatically on each
TurningPoint slide that you create using the
Response Table setting, a presentation-level
setting. Find more information about
modifying settings in TurningPoint Device
and Settings Management on page 153.

As an alternative to a Response Table, TurningPoint also offers
the Response Grid, which is overlaid on your slide during a

presentation and can be shown and hidden at your command.
The Response Grid shows more information than a Response
Table and does not take up space on your slide, but you must
manually choose to display and hide it during your presentation.
Find more information in View Polling Status on page 328.

Add a Correct Answer Indicator

A Correct Answer indicator gives a visual cue to the audience to indicate the correct answer(s) after
polling for a question is finished. A Correct Answer indicator appears during a presentation when you
advance the slide after displaying the chart.

A Correct Answer indicator appears for each answer marked as Correct or for which a point value is
specified. Find more information in Identify a Correct Answer from the Settings Window on page 89
or Identify a Correct Answer on a TurningPoint Slide on page 92.



Correct Answer indicators are available in seven styles.

Correct Answer indicators

L1

2]
2. Correct v 2. Correct
© 4]
© 2. Correct ¢ 2. Correct
e G
#) 2. Correct | 2. Correct
7]

d 2. Correct

o Rectangle 9 Checkmark
9 Smiley Face e Star
9 Arrow @ Blinking Rectangle

9 Custom Indicator



Step by Step Instructions

1

Navigate to the TurningPoint
slide in your presentation to
which you would like to add a
Correct Answer indicator.

Select Insert Object from the
TurningPoint toolbar.

To add a Correct Answer indicator...

The Insert Object menu opens.

E x Response Devices
+

Insert | Tools

Object =| =~
Charts L4
Answer Now L4
Countdown L4
Response Counter 3
Response Table b

Correct Answer Indicator »

Stats »

=l | Text Message

Insert Object Menu



3 Select Correct Answer Correct Answer Submenu
Indicator to display the
submenu of Correct Answer

(2

Indicators. Insert
Object =
Charts L
Answer Now L
Countdown L
Response Counter 4
Response Table g
Correct Answer Indicator * | £ | Rectangle
Stats ¥ | of  Checkmark
= | Tewt Message 1) | Smiley Face
W | Star
mp | Arrow
iwi | Blinking Rectangle
. Custom Indicator
4 Select the type of Correct When you select the Correct Answer indicator, TurningPoint

Answer indicator you would places it on your slide.

like to appear on the slide. You can delete the Correct Answer indicator if you no longer

want it to appear on the slide.

To replace an existing Correct Answer indicator with a
different type, simply repeat these steps. The current Correct
Answer indicator will be replaced with the new one you select.

Add Text Messaging

Text Messaging, which allows you to send messages to vPad users to reinforce the content and
their participation.

A Text Message appears as a small object on your slide, but when it is shown, it automatically
sends a message that can be viewed on vPad.



You can add more than one text message to a slide. For example, you might add a “Respond Now”
message to send when polling opens and a “Time Is Up” message to send when polling closes.

Tip  Since Text Messages are objects on your slide,
you can use PowerPoint’'s animation features
to time when they should be displayed. Find
more information in PowerPoint’s online help.

Step by Step Instructions To add a Text Message...

1 Navigate to the TurningPoint
slide in your presentation to
which you would like to add a
Text Message.

2 Select Insert Object from the The Insert Object menu opens.

TurningPoint toolbar.
E x Response Devices
3

Insert | Tools

Insert Object Menu

Object=| =~
Charts L4
Answer Now L4
Countdown L4
Response Counter L4
Response Table 4

Correct Answer Indicator »

Stats bk

= | Text Message




3 Select Text Message.

4 Type your message in the
dialog box and select the OK
button.

A dialog box appears asking you to enter the text of the
message.

Text Message Dialog Box

TurningPoint

Pleaze enter a meszsage.
Cancel

A speech balloon displays in the upper left corner of the slide.
When TurningPoint is running the presentation session, this
symbol notifies the participants in the audience to check their
vPads for a text message.

Slide with Text Message

Where is the capital of Ohio?

Columbus
Cincinnati
Youngstown

e

50%
Cleveland

20% 20%

10%

You may now alter the timing of the message using
PowerPoint’s animation features. By default, the message is
sent as soon as the slide is shown.

You can delete the Text Message object from the slide if you
no longer want it to be sent. To add an additional Text
Message, simply repeat these steps.



Add Statistics Indicators

Statistics indicators, which allow you to reveal statistics about the responses after polling is closed.

Statistics indicators show a calculation after polling is closed based on the responses received. You
can show the mean (average), median, standard deviation, and variance of the responses. The value
of the statistic is revealed when the chart is displayed.

Statistics Indicators

Where is the capital of Pennsylvania?

1. Pittsburgh
14%
2. Harrisburg

61%
3. Scranton
13%

4. Philadelphia
13%

Statistics are calculated based on the numerical value of the response (the number of the answer on
the slide). Since the statistics are based on the number of the answer, they are most useful for
questions with an ordered scale of answers (such as a Likert scale).



Step by Step Instructions

1

Navigate to the TurningPoint
slide in your presentation to
which you would like to add a
Statistic indicator.

Select Insert Object from the
TurningPoint toolbar.

To add a Statistic indicator...

The Insert Object menu opens.

E x Response Devices
-+

Insert | Tools

Object =] =
Charts L
Answer Now L
Countdown L4
Response Counter k
Response Table 4

Caorrect Answer Indicator »

Stats 4

=l | Teut Message

Insert Object Menu



3 Select Stats to display the
submenu of Statistic
indicators.

4 Select the type of Statistic
indicator you would like to
appear on the slide.

E |

Insert
Object =

Charts

Answer Now
Countdown

Response Counter
Response Table

Correct Answer Indicator
Stats

= Text Message

Statistics Submenu
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MMean [Average)
Median
Variance

Standard Deviation

When you select the Statistic indicator, TurningPoint places it

on your slide.

You can move or resize the Statistic indicator to make it better
fit your slide. You can delete the Statistic indicator if you no
longer want it to appear on the slide.

You can add additional Statistic indicators to the same slide (up
to all four types). Simply repeat these steps and select the
additional Statistic indicator you would like to place on the slide.



Where Do I Go From Here?

This chapter has demonstrated how to create and customize TurningPoint slides for your
presentation.

The next step in successfully using TurningPoint for an interactive presentation is to set up the
hardware devices for participants to respond. Chapter 4: TurningPoint Device and Settings
Management demonstrates this process. You only need to install hardware devices once on the
computer you will use them with, unless you add or change the hardware devices.

If you have already install hardware devices, the next step is to create a Participant List to keep
track of the participants for your presentation. Chapter 5: Track Participants and Teams
demonstrates this process.

If you already have a Participant List for the audience you will be presenting to, you are ready to
conduct your presentation! Chapter 7: Run Presentations demonstrates this process.



TurningPoint
Device and
Settings
Management

This chapter discusses the installation and management of the Response Devices available for use
by your audience. Additionally, this chapter describes the various settings available for customizing
your presentation.

Your audience responds to your interactive presentation using a response device. You can license
response devices from Turning Technologies for use with TurningPoint. These response devices
include:

Response Device Description

Response Innovations’
ResponseCard IR—a compact
response device that uses infrared

e .
‘;‘"@ @ technology to send audience
® 0@“‘@ responses.
o
0®®



Response Device Description

Responsive Innovations’
ResponseCard XL—a compact
response device that uses infrared
technology to send audience
responses and allows for self-paced
testing by letting students enter
responses to many different
questions on the card’s LCD then
transmitting all the answers at once.

Responsive Innovations’

gw ResponseCard RF—a compact
e ® response device that uses radio
.' ° % ® frequency technology to send
a\\\' \ % 9 audience responses.
X

Response Innovations’

ResponseCard XR —a compact

response device that uses radio

frequency technology to send

— audience responses and allows for

a,;;g;,e self-paced testing by letting

S sew students enter responses to many
tiia different questions on the card’s

multi-line LCD then transmitting all

the answers at once.

Turning Technologies’ vPad group
response software application—a
virtual keypad, installed on a
personal computer, and Smart
Devices, that takes advantage of a
classroom network to send
responses or control presentations.
vPad also allows for self-paced
testing by letting students enter
responses to many different
questions and then transmitting all
the answers at once.




Response Device Description

vLinks is a software program that
allows remote and/or multi-site
polling using an IP address.
Participants using Response Device

[=[=]-]

. Receivers can use vLinks to
connect to a host computer and
transmit their responses to the
: presentation over the internet. Find
more information about vLinks at
www.turningtechnologies.com.
Turning Technologies’ Web vPad —
B | a virtual keypad, installed on a

personal computer or Smart Device,
allows a user to log into a web site,

FII_FI select a session and send their
I_D_I responses over the internet.

TurningPoint also offers many settings you can use to customize the way your slides look and
behave. You may notice that sections throughout this user guide mention settings that can have an
effect on the tasks you perform with TurningPoint.



Recall the five steps to presentation success:

Five Steps to Success
Install TurningPoint

Enter question text.

5}

13

Step Three:
Install Devices Create
Step One: and Manage Participant List

Create Slides Settings

rr———
Where is the capital of Ohio
1. Coumbus -
2 Cincienati

— (Optionally)

e Manage Tools
s
Step Four: (Optionally) Run Reports

Run Presentation

: ~~
NV
{Optionally) Export Data
Step Five:
Save Session

This chapter covers the second step, connecting response devices with TurningPoint’s Plug and
Play capabilities and managing your settings.



Install Devices

Users interact with your TurningPoint presentation using response devices that communicate through
a response device receiver, or over a network or the internet.

Response device receivers are connected directly to the computer that will be used to run the
TurningPoint interactive presenation.This section includes instructions to install the device receivers.

The vPad response device software application allows users to participate with your presentation
through an internal network. The vPad response software application has two versions: the client
vPad and Presenter vPad. The client vPad allows participants to respond to your presentation. The
Presenter vPad enables the presenter to control the presentation from a computer on the same
network. This section includes instructions to install the vPad software.

The Web vPad virtual keypad utilizes the internet to allow audience participants to respond to the
interactive presentation. This section informs presenters what information they need and where to
obtain it to use Web vPad.

This section describes how to:

Install RF Response Device Receiver
Install IR Response Device Receiver
Install the vPad Response Software

Obtain the Web vPad Response Device Settings



Install IR Response Device Receiver

The ResponseCards IR and XL communicate with TurningPoint using infrared technology. The
receiver accepts the signal produced by the individual response cards and passes the response

along to TurningPoint.

Before You Begin

IR Response Card and Receiver

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions

1 Connect the receiver to the
USB port of the presentation
computer.

2 Place the receiver in an
unobstructed area at the front
of the room.

To install the IR response card receiver...

Windows detects the receiver and installs the proper drivers.

The receiver operates on a “line of sight” and needs to be
positioned so that it can receive the signal from the response



devices. You may want to elevate the receiver so that it can be
seen by everyone in the room.

Note The effective range of an infrared device
receiver is about 90 feet (27meters). You will
need to install one receiver for every 80
participants.

Use more than one receiver during your
presentation if your room size or participant
size exceeds these maximum specifications.
Contact Turning Technologies for suggested
receiver layout plans.

Next Steps

Go to Response Device Management on page 171 to manage the settings for the response devices.

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication...

1 From the TurningPoint TurningPoint displays the Settings window.
toolbar, select Tools >
Settings. (Hint: it's the one
that looks like a pair of
eyeglasses.)



2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen
to verify that TurningPoint can receive responses from the
devices.

Settings Window: Polling Test

¥ TurningPoint - Settings

Settings | Poling Test |
Device pue Channel Response
User Information: Magnify Yalues ]
3 Select the Start Test button. TurningPoint is now ready to accept responses from the

response devices. You can magnify the responses by placing
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

Device ID Channel Response
AO03BF 21 2




4 Press a key on each TurningPoint displays the Device ID, Channel, an entry for each
response device to be used. response device, in the order in which they were tested, and the
key number pressed on each response device.

Polling Test: Response Device Test

" u TurningPoint - Settings

Settings | Poling Test |

Device ID Channel Response

User Information: Magnify Values [7]
5 Select the End Test button. This action ends the Polling test.

6 Select the Done button. The device communication check is now complete.



Install RF Response Device Receiver

The ResponseCards RF and XR communicate with TurningPoint using a radio frequency. The
receiver accepts the signal produced by the individual response cards and passes the response
along to TurningPoint.

RF Response Card and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions To install the RF response card receiver...

1 Connect the receiver to the Windows detects the receiver and installs the proper drivers.
USB port of the presentation Your response devices are now ready to be used.
computer.

Note the effective range of a ResponseCard RF is
about 200 feet (60 meters) and the
ResponseCard XR is about 400 feet (120
meters). A single receiver is sufficient for up to
1000 keypads, and a direct line of sight
between the receiver and the keypad is not
necessary.

Use more than one receiver during your
presentation if your room size or participant
size exceeds these maximum specifications.
Contact Turning Technologies for suggested
receiver layout plans.




Next Steps
Go to Response Device Management on page 171 to manage the settings for the response devices.

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication...

1 From the TurningPoint TurningPoint displays the Settings window.
toolbar, select Tools >
Settings. (Hint: it's the one
that looks like a pair of
eyeglasses.)

2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen
to verify that TurningPoint can receive responses from the

devices.

Settings Window: Polling Test
EEX

User Information: Magnify values []

Stark Test




3 Select the Start Test button. TurningPoint is now ready to accept responses from the
response devices. You can magnify the responses by placing
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

Device ID Channel Response
AO03BF 21 2
4 Press a key on each TurningPoint displays the Device ID, Channel, an entry for
response device to be used. each response device, in the order in which they were tested,

and the key number pressed on each response device.

Polling Test: Response Device Test

User Information: Magnify Valuss []

End Test

5 Select the End Test button. This action ends the Polling test.

6 Select the Done button. The device communication check is now complete.



Install the vPad Response Software

The vPad group response software acts as a virtual response device. Audience members use the
software from desktop or laptop computers or PDAs that are connected to the presentation computer
using a direct or wireless network.

vPads exhibit the same response behavior as ResponseCards. If you are running a vPad and connect
during a presentation, you can close and reopen the vPad and still have the same response device
number.

vPad Response Device

[ Turning vPad EHE|E|

Device #: MA

Status! Idie

Before You Begin

TurningPoint must be installed on computers that use the same

network.
Step by Step Instructions To install and set up the vPad software on a PC...
1 Insert the vPad installation
CD into your computer’s CD-
ROM drive.
2 Run the vPad setup program. Follow the instructions in the vPad setup wizard to install vPad

on your desktop or laptop computer. The installation creates a
vPad desktop icon and an entry in your computer’s Start >
Programs menu.



3 Double click on the vPad The Turning vPad window opens.

desktop icon to start the vPad You need to configure vPad to enable it to communicate on

software. the network.
4 Onthe Turning vPad window, The Select a Host Computer window opens.
select File > Select Host
Computer. vPad: Select A Host Computer
Hast Marme Part Mumber
Current:
5 Select the Add button. The Turning vPad dialog box opens and displays the friendly

name setup prompt.

vPad: Enter Friendly Computer Name

Turning vPad r5__<|
Fleaze enter the host computer's friendly name
or [P address.
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In the Turning vPad window,
enter the computer’s friendly
name or IP address and
select OK.

In the Turning vPad window,
enter the port number to be
used for communication
between the vPad and
TurningPoint and select OK.

In the Select a Host
Computer window, select
OK.

In the TurningPoint
connection dialog box, select
OK.

Repeat steps 1-9 for each
computer to be used as a
response device.

Next Steps

The Turning vPad dialog box displays the port number setup
prompt.

vPad: Enter Port Number

Turning vPad §|

Pleaze enter the port number aszigned by the

host computer. Must be a whole number 1 to
ER535.

Turning wPad's default port fumber iz 1007,

1001

Turning vPad uses port 1001 by default. Enter a different
number, if defined otherwise on the host computer.

The newly added host computer appears in the Select a Host
Computer window.

Turning vPad displays a dialog box asking to connect to the
selected host.

The Turning vPad window displays a message: Connected to
mylaptop at 2:30:21 PM.

Your computer’s friendly name (entered in step 6) and the time
when you connected (as a result of completing this step) are
displayed in place of the words above.

Go to Response Device Management on page 171 to manage the settings for the response devices.



If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions

1

3 Select the Start Test button.

From the TurningPoint
toolbar, select Tools >
Settings. (Hint: it’s the one
that looks like a pair of
eyeglasses.)

Select the Polling Test Tab.

To Check Device Communication...

TurningPoint displays the Settings window.

TurningPoint displays the Polling Test screen. Use this screen
to verify that TurningPoint can receive responses from the
devices.

Settings Window: Polling Test

¥ TurningPoint - Settings

Settings | Poling Test |

Device ID Channel Respanse

User Information: Magnify Values [

Start Test

TurningPoint is now ready to accept responses from the
response devices. You can magnify the responses by placing
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

Device ID Channel Response
AO003BF 21 2




4 Press a key on each TurningPoint displays the Device ID, Channel, an entry for each
response device to be used. response device, in the order in which they were tested, and the
key number pressed on each response device.

Polling Test: Response Device Test

" u TurningPoint - Settings

Settings | Poling Test |

Device ID Channel Response

User Information: Magnify Values [7]
5 Select the End Test button. This action ends the Polling test.

6 Select the Done button. The device communication check is now complete.



Obtain the Web vPad Response Device Settings

The Web vPad response device acts as a virtual response device. Audience members use Web
vPad from desktop or laptop computers or PDAs that access your Web vPad Server URL.

Web vPads exhibit the same response behavior as ResponseCards and vPad. If you are using Web
vPad and connect during a presentation, you can close and reopen the Web vPad and still have the
same response device number.

In order to use the Web vPad during for your presentation, you must obtain the following information
from TurningTechnologies Customer Support:

Web vPad Server URL
Web vPad Server Username
Web vPad Session Name

Web vPad Access Code

Go to Response Device Management on page 171 to manage the Web vPad settings.



Response Device Management

Each audience participant uses a device to respond to the questions asked during the presentation.
TurningPoint supports a variety of response devices including infrared and radio frequency keypads
as well as networked PDAs, laptops, and desktops and laptops and desktops with internet access.

TurningPoint needs to know what types of response devices will be used before you run the
presentation. Access the Response Device settings to confirm TurningPoint is configured to your
needs.

You may need to confirm your settings when you add new response devices and change the number
of response devices to be used during a presentation session.

Additionally, you are able to test communication between TurningPoint and the response devices
using the Polling Test found in settings.

This section describes how to:

Manage Response Device Settings
Update the Number of Devices Used
Add New Device Types

Check Device Communication

Manage Response Device Settings

Use the Response Device settings to confirm TurningPoint is configured according to your needs.

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations, the device
receivers connected, vPad installed (if using the virtual response device software), Web vPad
settings, and the response devices available for testing.



Step by Step Instructions

1 Access the settings window
from the TurningPoint
Toolbar, select Tools >
Settings. (Hint: it's the one
that looks like a pair of
eyeglasses.)

2 Select the Settings Tab.

3 Select Response Device
from the Settings Hierarchy.

To manage the response devices...

This displays the Settings window.

¥ a TurningPoint - Settings

Settings | Poling Test

Settings Window

Response Device ~
P on
=1 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Vaungstown
4 Cleveland
=2 Where is the capital of Perr
1 Pitisburgh
2 Harrishurg
3 Seranton
4 Philadelphia
=3 Where is the capital of the L
1 washington State
2 Washington, PA
3 Washington D.C.
4 Washingtan, NC =
=4 Where is the capital of New
1 Albuguergue
2 santaFe
3 Los Alamos
4 Carlsbad
< ) >

K3

Answer Settings
Answer Bullet Format
Chart Settings

Auto Scale Charts
Chart Colors

Chart Labeks

Chart Value Format
Standard Chart Type

Competition Settings

Default Nurmber of Teams
Include Non-Responders
Masimum Respanders
Participants In Leaderboard
Tearns In Leaderboard

Misc

AdeIn ahways loaded
Correct Paint Value

Decimal Period

True

Color Scherme
Aliases

0%

Vertical

Restore default pressrtation ssttings

(@ Common Settings

EEX
~
-
O Al Settings

Done

All response device settings are listed in the right pane of the

Settings window.



4 Enterthe number of expected
response devices.

a Click on the number of
devices currently entered.

b Enter the number of
expected devices.

c Select done.

Response Device Management

Settings Window: Expected Devices

You are only required to enter the number of expected devices
when using Simulated Data or a Response Counter or
Response Table.

This opens a text box allowing you to enter a numeric
value.

Note You cannot exceed the number of licensed
devices. For example, if you enter the number
of expected devices as 60 in this region, but
TurningPoint is licensed for 50 devices, only 50
devices can be used during the presentation.

Note TurningPoint limits the number of response
devices that will be displayed in a Response
Counter or on a Response Table based upon
the number of expected devices entered.

Find more information on Response Counters
in Add a Response Counter on page 138 and
Response Tables in Add a Response Table on
page 141.

If you are using only USB devices, skip to step 12. If you
are using only vPad devices, go to step 5. If you are using
only Web vPad devices, skip to step 6.

TurningPoint User Guide

173




Chapter 4: TurningPoint Device and Settings Management

d HIt the Enter key. If you are using only USB devices, skip to step 12. If
you are using only vPad devices, go to step 5.

5 |If you are using the vPad
software, enable the vPad.

a Select Enable This displays a drop down menu.
vPad/vLinks.

b Change the Enable vPad Settings Window: vPad Settings
setting from False to True.

Note TurningPoint uses False as the default
setting for Enable vPad.

c Select done. If you are using only vPad devices, skip to step 12. If
you are using only Web vPad devices, go to step 6.

174 Turning Technologies



Response Device Management

6 If you are using the Web Settings Window: Web vPad Settings
vPad, enable the Web vPad.

a. Change the Enable Web
vPad setting from False to

True. Note TurningPoint uses false as the default setting
for Enable Web vPad.

TurningPoint User Guide 175



Chapter 4: TurningPoint Device and Settings Management

7 Enter the URL of the Web
vPad Sever.

a Double click in the blank This opens a text box in which you can type in the URL
space to the right of URL for the Web vPad Server.

and directly below the
True/False drop-down Web vPad Settings: URL

menu.

176 Turning Technologies



Response Device Management

b Type in the URL.

8 Enter the Username.

a Double click in the blank This opens a text box in which you can type in the
space to the right of Username for the Web vPad Server.
Username and directly
below where you entered Web vPad Settings: Username
the URL.

TurningPoint User Guide 177



Chapter 4: TurningPoint Device and Settings Management

b Type in the Username.

9 Enter the Password

a Double click in the blank This opens a text box in which you can type in the
space to the right Password for the Web vPad Server.
Password and directly
below where you entered Web vPad Settings: Password

the Username.

Password

178 Turning Technologies



Response Device Management

b Type in the Password

10 Enter the Session Name

a Double click in the blank This opens a text box in which you can type in the
space to the right of Session Name for the Web vPad Server.
Session Name and directly
below where you entered Web vPad Settings: Session Name

the Password.

Session Name

TurningPoint User Guide 179



Chapter 4: TurningPoint Device and Settings Management

b Type in the Session Name.

11 Enter the Access Code

a Double click in the blank This opens a text box in which you can type in the
space to the right of Access Code for the Web vPad Server.
Access Code and directly
below where you entered Web vPad Settings: Access Code

the Session Name.

b Type in the Access Code.

12 Select done. Your devices are ready for use with your interactive
presentation.

Next Steps

If an audience member’s device is not being accepted, go to Polling Test in Check Device
Communication on page 185. Additionally go to Update the Number of Devices Used on

page 181 when you need to make changes to the number or Add New Device Types on page 183
type of devices being used with your presentations.

180 Turning Technologies



Update the Number of Devices Used

Access the Response Device settings whenever you need to change the number of devices being

used.
Step by Step Instructions To increase or decrease the accepted responses...
1 From the TurningPoint TurningPoint displays the Settings window.
toolbar, select Tools >
Settings (Hint: it's the one Settings Window
that looks like a pair of "'a TurningPoint - Settings A=
Settings | Poling Test
eyeg l asses. ) Response Device || ResponseCard Channels
= ;rﬁ/svi'g:‘inms capital of Ohic || Empty 21
1 Gobmts Responsesard wisc
3 oungstown Experted Devices o
4 Cleveland Enforce Participant List False
-3 Where Is the capital ofPenr || oo e User Information Falsa
1 Pittsburgh
2 Harrishurg || vpad
2 Scranton I~
4 Philadelphia Enable vPad / vLirks False
=4 Where is the capital of the L Port Number 1001
1 Washington State
2 Washington, PA | Web vPad
j x:z:::x:&g i;aLbls Wb vPad False
=5 vrhzs u\sun;re :mea\ oftew (| L hame
3 Samg FE“ Acress Code
3 Los Alamos
4 Carlshad v
< >

2 Select Response Device

® Common Settings O All Ssttings

Dane

TurningPoint displays all of the Response Device settings in the
from the Settings Hierarchy. right pane of the settings window.



Chapter 4: TurningPoint Device and Settings Management

3 Enterthe number of expected This setting is found under ResponseCard Misc heading.
response devices.

Settings Window: Expected Devices

a Click on the number of This opens a text box allowing you to enter a numeric
devices currently entered. value.

Note You cannot exceed the number of licensed
devices. For example, if you enter the number
of expected devices as 60 in this region, but
TurningPoint is licensed for 50 devices, only 50
devices can be used during the presentation.

b Enter the number of

expected devices.

Note TurningPoint limits the number of response
devices that will be displayed in a Response
Counter or on a Response Table based upon
the number of expected devices entered.

Find more information on Response Counters
in Add a Response Counter on page 138 and
Response Tables in Add a Response Table on
page 141.

182 Turning Technologies




4 Optionally, test your TurningPoint displays the Polling Test screen. If desired, you

response device can use this screen to test the communication between
communication by selecting TurningPoint and the response devices. Find more information
the Polling Test tab from the in Check Device Communication on page 185

Settings window.

Note TurningPoint does not require a polling test be
performed when changing the device ranges.
Find polling instructions in the Check Device
Communication section.

5 Select the Done button. The response device setup is now complete.

Add New Device Types

Access the Response Device settings whenever you need to change the number of devices being
used. Plug the additional device into the computer.

Before You Begin

Ensure the device receiver is properly connected.




Step by Step Instructions

1 From the TurningPoint TurningPoint displays the Settings window.
toolbar, select Tools >
Settings. (Hint: it's the one

that looks like a pair of

Settings Window
EEX

¥ a TurningPoint - Settings

eyeg |aSS€S ) Settings | Poling Test
) Response Device #][ Responsecard channels
Presentation

=2 WWhere is the capital of Ohic || Emply 21
1 Columbus
2 Cincinnati | ResponseCard Misc
2 Youngstown Expected Devices o
4 Cleveland Erforce Participant List Falke

53 where s the capital o Penr | oer ity User Information False
1 Pitisburgh
2 Harrishurg || vpad
3 Seranton —
4 Philadelphia Enable vPad / vLinks Fake

=4 Where s the capital of the L || Port Nurmber 1001
1 washington State
2 Washington, P4 Web vPad
3 washingon D.C, Enabile Wb vPad False

2 Select the Settings Tab.

3 Select Response Device
from the Settings Hierarchy.

4 Washingtan, NC

55 Where is the capital of New

1 Abuguergue
2 SantaFe
3 Los Alamos
4 Carlsbad

< | >

URL
Sessian Name
Access Code

(@ Common Settings

O Al Settings

Done

Settings window.

All response device settings are listed in the right pane of the



4 Follow the instructions in
step 4 of Manage Response
Device Settings on page 171
to set up your devices.

Check Device Communication

You should test the communication between a device and TurningPoint if an audience member’s
response is not being accepted during a live presentation.

Before You Begin

Ensure the device receiver is properly installed and the device to be tested is available.

Step by Step Instructions To test for device communication...

1 From the TurningPoint TurningPoint displays the Settings window.
toolbar, select Tools >
Settings. (Hint: it's the one
that looks like a pair of
eyeglasses.)



2 Select the Polling Test Tab.

3 Select the Start Test button.

TurningPoint displays the Polling Test screen. Use this screen
to verify that TurningPoint can receive responses from the

devices.

¥ TurningPoint - Settings

Settings | Poling Test |

Settings Window: Polling Test

Device ID Channel

User Information:

Magnify Values [

Start Test

Done:

For USB and vPad response devices, go to step 3. For Web
vPad response devices, skip to step 6.

TurningPoint is now ready to accept responses from the
response devices. You can magnify the responses by placing
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

Device ID
AO03BF

Channel
21

Response
2




4 Press a key on each TurningPoint displays the Device ID, Channel, an entry for each
response device to be used. response device, in the order in which they were tested, and the
key number pressed on each response device.

Polling Test: Response Device Test

" u TurningPoint - Settings

Settings | Poling Test |
Device: ] Channel Response
User Information: Magnify Values [7]
5 Select the End Test button. This action ends the Polling test. If you are using the Web vPad,

go to step 6. Otherwise, go to step 7.



6 Select the Test Web vPad
button.

7 Select the Done button.

Next Steps

If the connection was successful, TurningPoint displays Web
vPad connected Successfully. Go to step 7

Polling Test: Web vPad Test

[ Settings | Poling Test |

Device ID Channel

Respanse

User Information:

Magnify valuss []

Test Web vPad Stark Test

Done

If connection was not successful, TurningPoint displays an
error message. You should check your settings. For more
help on settings see Obtain the Web vPad Response Device
Settings on page 170

The device communication check is now complete.

Return to Check Device Communication on page 185 if an audience member’s response is not
being accepted during a live presentation or Add New Device Types on page 183 if a new

response device is being used.



Settings

TurningPoint Allows you to view and modify various settings from the Settings window. To access the
Settings window select Tools from the TurningPoint toolbar and settings. (Hint: It's the one that looks
like a pair of eyeglasses.)

Tools > Settings

x Response Devices
A

Tools

-

[

Turning Reports

Session Management b

Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template

BE & B & 5 R

Ranking Wizard

WebCT Wizards 4
Blackboard Wizard

YantagePoint

CQuestionPoint

Enterprise Manager

t RSB

Settings

s
=1

Upgrade TurningPoint Receiver




You can adjust the settings in the Settings window:

Settings Window
¥ o TurningPoint - Settings =1

Settings | paling Test
Response Device || Answer Settings 2~
Presentation
=1 Where is the capital of Ohic Answer Bullet Format Decirmal Period
1 Columbus
2 cincinnati Chart Settings
3 V“]“”g‘smdw” Autn Scale Charts True
4hc e o Chart Calars Color Scheme
=2 ol Ehtap'ta ofPen || chartLabels alizses
1 P i Chart Value Farmat 0%
2 Harrisburg Standard Chart Type Vertical
3 Scranton
4 Philaelphia Competition Settings
=3 where & the capital of the L ||
1 Washington State Default Number of Teams 5
2 Washington, P4 Include Non-Responders False
3 Washington D.C. Maximum Responders 5
4 \Washington, NC Participants In Leaderboard 5
= 4 Where ks the capital of New || Teams In Leaderboard 5
1 Albuguergue
2 SantaFe Misc
j ED;\SA;ZEDS | d-In shways lnaded Fake
< S Carrect Point Value 100 al
© conmon setngs O Al setngs

The Settings window contains two tabs: Settings and Polling Test. See Check Device
Communication on page 185 for more information on Polling Test.

The Settings tab displays a Settings Hierarchy in the left pane of the Settings window which allows
you to change the settings for a Response Device, Presentation, Slide or an Answer. In the right
pane of Settings window are the settings themselves. The settings are grouped by type and listed
alphabetically. The name of each setting is in the left portion of the right pane and its value is on the
right. Some settings may allow you to type a value, while others will offer a drop-down menu to
select from several choices.



= TurningPoint - Settings

At the bottom of the Settings window is a region that displays a detailed description of a setting when
you select it. You can use these descriptions or the following pages to learn about the settings.

Settings Window: Bottom Region
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Chart Colors
Determines which chart colors wil be used.

The Common Settings and All Settings Buttons allow you to select your level of customization. The
Common Button displays the most commonly modified settings. The All Settings Button reveals more
settings allowing for a more personalized presentation.

The Restore default presentation settings button allows you to return the settings back to the default
installation state.

The Defaults button is active for chart colors on a presentation level only. The button allows you to
return your chart colors back to the default installation state.

The Apply All button is active for some chart settings on a presentation level. The button applies and
saves the setting changes that you made to the all existing applicable slides.

The section describes:

Response Device Settings
Presentation Settings
Slide Settings

Answer Settings

The following sections contain information about the settings available by selecting the Settings Tab
and then selecting one of the following items from the Settings Hierarchy: Response Device,
Presentation, an individual Slide or an answer. Settings listed in italics can be found by selecting the
All Settings radio button.



Response Device Settings

Response Device contains settings for the response devices compatible with TurningPoint. The list
below contains more detailed information for each setting.

Response Device Settings
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(@ Common Settings () All Settings
ResponseCard Channels Allows you to view the Response Receiver settings.

Setting

Description

Receiver

Displays Receiver ID and receiver
Channels of the receivers connected
to computer



Allows you to view and change various response card settings.

Setting

Description

Force Channel
Change

Expected Devices

Enforce Participant
List

Overwrite User
Information

Determine whether to force the
Receiver Channel to change. The
default is set at False and will force
TurningPoint to accept the channel
from the receiver. True will set the
receiver to the first available slot in
TurningPoint.

Displays the number of Response
Devices that you expect to be used
during the presentation. This is only
required when using Simulated
Data or Reponse Counter or
Response Table.

Determine whether only members
of a participant list can respond
during a presentation or if anyone
with a response device can
respond. The default is set at True,
which only allows members of a
participant list to respond and
allows you to gather user
information. When set to false,
anyone can respond, but you will
not be able to gather user
information.

Determine whether participant data
received from a response device
will overwrite the matching fields in
the participant list. The default is set
to False, which will not overwrite the
participant list.



Enables you to view and change various vPad settings.

Setting

Description

Enable vPad/vLinks

Port Number

Determines whether vPads or
computers using vLinks can
participate in the presentation
remotely. The default is set to False
and will not allow vPads or
computers using vLinks to
participate remotely.

Manually change the Port number
that vPads use to participate in the
presentation.

Enables you to view and change various Web vPad settings.

Setting

Description

Enable Web vPad

URL

User Name

Password

Session Name

Access Code

Determines whether a Web vPad
can participate in the presentation.
The default is set to False and will
not allow Web vPads to participate.

Assign the URL of the Web vPad
Server

Assign a user name on the Web
vPad server.

Assign a password on the Web
vPad server.

Assign a session name for
Participants to connect to the Web
vPad Server.

Assign an Access code to be used
by Participants to connect to the
Web vPad Server.



Presentation Settings

Presentation contains settings for the creation of slides, the way they are displayed, and other
TurningPoint options. If you change a presentation-level setting, the change applies to all slides you
create in the future and in some cases in the currently opened presentation.

Presentation Settings
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Answer Settings

Setting

Enables you to view and change Answer settings.

Description

Answer Bullet

Format

Determines type of answer bullets
TurningPoint will display. The
available settings include: Alpha
Lowercase Parenth = a), Alpha
Lowercase Period = a., Alpha
Upercase Period = A., Decimal
Parenth = 1), Decimal Period = 1.,
Roman Lowercase Period = i.,
Roman Uppercase Period |.



Enables you to view and change the Backup Settings.

Setting

Description

Backup
Maintenance

Backup Sessions

Real-time Backup
Path

Sets the number of days a backup
session will be kept before being
automatically deleted. You can set a
range between one and ninety
days. The default set at seven days.

Automatically have TurningPoint
create a backup copy of all your
completed sessions. The default is
set at True, which will create a
backup copy.

Determines the location that your
real-time backup session will be
saved. When you determine a
location, TurningPoint saves an
XML version of your session while
you are conducting it. The default is
set at None. To change the
location:1.) Double click the current
setting to open a dialog box.
2.)Manually enter the location or
navigate to one by selecting the
ellipses. 3.) This activates an
explorer window. 4.) Choose your
location. 5.) Select OK. 6.) Select
Apply to set the location.

To restore to the default location,
double click the current setting and
select Turn Real-Time Backup Off.



This enables you to view and change the chart settings.

Setting

Description

Auto Scale Charts

Chart Colors

Chart Color 1

Chart Color 2

Determines whether the vertical
charts are scaled according to their
specific percentages or appear
more realistic. The default is set to
True, which scales charts according
to their percentages.

Determines what chart colors will be
used during your presentation. The
available settings are Color
Scheme, Correct/Incorrect and User
Defined. Color Scheme - uses the
selected PowerPoint color scheme.
To change the color of your charts,
you must change color setting in
PowerPoint. See PowerPoint help.
Correct/Incorrect - uses user
defined colors for slides that have
answers selected as correct and
incorrect. All other slides in the
presentation will uses the
PowerPoint color scheme. To
change the colors for correct and
incorrect answer see the
descriptions for Chart Color Correct
and Chart Color Incorrect settings
below. User Defined - uses user
defined colors. To change colors
see descriptions for Chart Color 1
through Chart Color 10 settings
below.

The default is set at Color Scheme.

Determines the first chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the second chart color
to be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.



Setting

Description

Chart Color 3

Chart Color 4

Chart Color 5

Chart Color 6

Chart Color 7

Chart Color 8

Chart Color 9

Determines the third chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the fourth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the fifth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the sixth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the seventh chart color
to be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the eighth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the ninth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.



Setting

Description

Chart Color 10

Chart Color Correct

Chart Color

Incorrect

Chart Labels

Chart Value Format

Reset Charts

Determines the tenth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the color to be used for
Correct answers for Correct
Incorrect color setting. To change
the color: 1.) Select the current
color to display the Color Select
window. 2.) Select the new color.

Determines the color to be used for
Incorrect answers for Correct
Incorrect color setting. To change
the color: 1.) Select the current
color to display the Color Select
window. 2.) Select the new color.

Determines if Answer Aliases
(Answer Bullet Format) or Bullet
Points will be displayed in the chart
labels and legends. The default is
set to Aliases.

Determines whether TurningPoint
displays the chart values a a whole
number (Number of people who
answered a question) or
Percentage (Percentage of people
who answer each question.) The
valid formats are: 0, 0%, 0.0%, and
0.00%. The default is set at 0%.

Determines whether the chart data
will be cleared whenever a slide is
reset. The default is set to True,
which resets the chart data.



Setting

Description

Review Only

Standard Chart Type

Determines whether to a chart
showing how participants
responded to a question is
displayed during a presentation or
only when a presenter reviews the
presentation. The default is set to
False which displays charts during
the presentation.

Determines default chart that is
used when a slide is inserted during
a presentation. The default is set to
Vertical. All chart options are
available to choose from.

Allows you to view and change the settings for competition

slides.

Setting

Description

Default Number of
Teams

Include Non-
Responders

Maximum
Responders

Participants in
Leader Board

Teams In Leader
Board

Determines how many teams are
displayed in the Team Assignment
slides. The acceptable range is 2-20
teams. The default is set at 5.

Determines whether non-
responders will be included in team
scoring. The default is set to False,
which does not include non-
responders.

Determines the maximum number
of responders that are included in
the fastest responders slide. The
acceptable range is 1-20
responders. The default is set at 5.

Determines the number of
participants to include in the
participant leader board. The
acceptable range is 1-20
participants. The default is set at 5.

Determines the number of teams
displayed in the leader board. The
acceptable range is 1-20 Teams.
The default is set at 5.



Enables you to view and change various uncategorized

settings.
Setting Description
Add-In always Determines if TurningPoint loads
loaded with PowerPoint. The default is set

Allow Duplicates

Allow User
Feedback

Auto Adjust
Participant Range

Auto-Update Aliases

Correct Point Value

Default Participant
Setting

to False, which does not
automatically load TurningPoint.

Determines whether more than one
response per response device is
permitted. The default is set to
False, which does not allow more
than one response.

Determines if user feedback will be
accept during the presentation. This
option is available for vPad and
Web vPad users only. The defaults
is set to True, which allows user
Feedback.

Determines whether TurningPoint
will auto adjust the device range to
match the loaded participant range.
The default is set to True, which
matches the matches the device
range with the participant range.

Determines if Question and Answer
Aliases will automatically reflect
changes in text made to the
Question and Answer placeholders.
The default is set to True, which
automatically updates aliases.

Set the default Point value of a
correct answer. The acceptable
range is from negative 10,000 to
10,000. The default is set to 100.

Determines whether the Participant
List Drop-down menu default is
Auto or Anonymous. The default is
set to Anonymous.



Setting

Description

Default Save
Location

Include Presentation

Incorrect Point
Value

Input Source

Language

Multiple Response
Divisor

Determines a custom location for to
save your sessions. The default
setting is My Documents. To change
the location:1.) Double click the
current setting to open a dialog box.
2.) Manually enter the location or
navigate to one by selecting the
ellipses. 3.) This activates an
explorer window. 4.) Choose your
location. 5.) Select OK. 6.) Select
Apply to set the location.

To restore to the default location,
double click the current setting and
select Restore to default path.

Determines whether to include the
PowerPoint presentation with your
saved session. The default is set to
True, which includes the
PowerPoint presentation.

Set a default point value for
incorrect answers. The acceptable
range is negative 10,000 to 10,000.
The default is set to zero.

Set the default input source that
TurningPoint uses when running a
presentation. The choices are
Keyboard Keys, Simulated Data
and Response Devices. The default
is set to Response Devices.

Change the language format. The
default is set to the language you
chose when installing TurningPoint
2008.

Determines whether the divisor
used to calculate the percentages
on multiple a response question will
be the total number of responses
received or the total number of
devices that participated. The
default is set to Devices.



Setting

Description

Responses

Use Enterprise
Manager

Zero Based Polling

Determines the number of
responses accepted from a
response device without overwriting
the previous response. The
acceptable range is 1-10
responses. The default is set to 1.

Determines whether TurningPoint
Enterprise Manager is used. If set to
True, the Enterprise Manager Log-
in Dialog will appear when
TurningPoint is launched. The
default is set to False.

Number answers from 1-10 or 0-9.
When set to True, answers will be
number from 0-9 and will override
the current answer bullet format.
The default is set to False.

Moment to Moment Settings Enables you to view and change settings for Moment to Moment
slides
Setting Description
Polling Cycle Determines the polling interval in

seconds on a moment to moment
slide. The default is set at two
seconds.



Presenter vPad Settings Enables you to view and change the settings for the

Presenter’s vPad.

Setting

Description

Default Port Number

Enable Presenter
vPad

Presenter vPad
Password

Require Password

Set the local port number used by
the Presenter vPad. Some ports
may not be usable due to system or
network configurations. The
acceptable port number ranges
from 1 - 65535. The default is set to
1001.

Determines whether a Presenter
vPad can be used to control a
SlideShow. The default is set to
False, which does not allow the
Presenter vPad to control a
slideshow.

Set a password for the Presenter
vPad. By default, there is not
password set.

Require that the vPad presenter
uses a password. The default is set
to False, which does not require a
password.

Ranking Settings Enables you to view and change the settings for Ranking
Chart Slides.
Setting Description

Bubble Grouping

Bubble Name
Visible

Determines the number of bubbles
shown while rotating using the TAB
key on a Ranking Chart slide. The
acceptable range is 1-10 bubbles.
The default is set at 3.

Determines whether the bubble
names are displayed. The default is
set to True, which displays bubble
names.



Setting

Description

Bubble Size Value
Format

Bubble Size Visible

Determines the displayed format for
bubble sizes. The acceptable
formats are 0, 0.0 and 0.00. The
default value is set to 0.

Determines if bubble size values
are visible. The default is set to
True, which shows the bubble size
value.

Enables you to view and set Response Reminders settings.

Setting

Description

Answer Now

Answer Now Text

Auto-Advance

Countdown

Countdown
Seconds

Select the default Answer Now
object that will be automatically
added to new slides. The default is
set to None, which does not
automatically add an Answer Now
indicator. All Answer Now objects
are available to choose from.

Change the Answer Now text that is
displayed in the Answer Now object.
The default text is Answer Now.

Determines whether the SlideShow
will automatically advance to the
next animation if polling is closed by
a Countdown Indicator or Response
Counter object. The default is set to
False, which does not automatically
advance the SlideShow.

Determines if a Countdown object
will be automatically added to new
slides. The default is set to None,
which does not automatically added
a Countdown object to new slides.
All Countdown objects are available
to choose from.

Set the number of seconds a
Countdown object will display. The
acceptable range is 1-999. The
default is set at 10 seconds.



Setting

Description

Response Counter

Response Counter
Format

Response Table

Rotation Interval

Determines whether a Response
Counter object is automatically
added to new slides. The default is
set at None, which does not
automatically added a Response
Counter. All Response Counter
objects are available to choose
from.

Determines the format for new
Response Counter objects. The
acceptable formats are Count
(number of responses), Percent, or
Both (Count and Percent). The
default is set to Count.

Determines whether a Response
Table object is automatically added
to new slides. The default is set to
None, which does not automatically
add a Response Table object. All
Response Table objects are
available to choose from.

Determines the number of seconds
that a Rotating Table will pause
between intervals. The acceptable
range is 1-10 seconds. The default
is set to two seconds.

Enables you to view and set the Response/Non-Response

Grid Settings

Setting

Description

Auto Size Grid

Custom Cell
Background Color 1

Determines whether the
Response/Non-Response Grid will
automatically resize to fit the
screen. The default is set to True,
which automatically resizes the
Response/Non-Response Grid.

Determines the color that will be
used for the Response/Non-
Response Grid’s cell 1st
background color. To change the
color: 1.) Select the current color to
display the Color Select window. 2.)
Select the new color. 3.) Select OK.



Setting

Description

Custom Cell
Background Color 2

Custom Cell
Background Color 3

Custom Cell
Background Color 4

Custom Cell
Foreground Color

Custom Grid
Background Color

Display Device IDs

Display Device
Numbers

Determines the color that will be
used for the Response/Non-
Response Grid’s cell 2nd
background color. To change the
color: 1.) Select the current color to
display the Color Select window. 2.)
Select the new color. 3.) Select OK.

Determines the color that will be
used for the Response/Non-
Response Grid’s cell 3rd
background color. To change the
color: 1.) Select the current color to
display the Color Select window. 2.)
Select the new color. 3.) Select OK.

Determines the color that will be
used for the Response/Non-
Response Grid’s cell 4th
background color. To change the
color: 1.) Select the current color to
display the Color Select window. 2.)
Select the new color. 3.) Select OK.

Determines the color that will be
used for the Response/Non-
Response Grid’s cell foreground
color. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color. 3.) Select OK.

Determines the color that will be
used for the Response/Non-
Response Grid background color.
To change the color: 1.) Select the
current color to display the Color
Select window. 2.) Select the new
color. 3.) Select OK.

Determines if Device IDs will be
displayed on the Response/Non-
Response Grid. The default is set to
True, which will display Device IDs.

Determines if Device Numbers will
be displayed on the Response/Non-
Response Grid. The default is set to
True, which will display Device
Numbers.



Setting

Description

Display Participant
Names

Gird Opacity

Grid Position

Grid Rotation
Interval

Grid Size

Use Scheme Colors

Determines if Participant names will
be displayed in the Response/Non-
Response Gird. The default is set to
True, which will display the
Participant Names

Determines how transparent or
opaque the Response/Non-
Response Grid is displayed. The
accpetable ranges is 1 (transparent)
to 100 (opaque). The default is set
at 90 (almost opaque.)

Determines the placement of the
Response/Non-Response Grid
when displayed. The acceptable
positions are: Bottom, Bottom Left,
Bottom Right, Center, Left, Right,
Top, Top Left, Top Right. The default
position is the Bottom of the screen.

Determines the number of seconds
a Response/Non-Response Grid
will pause between intervals. The
acceptable range is 1 to 10
seconds. The default is set at 2.

Determines the size, in pixels, of the
Response/Non-Response Grid
when the Auto Size Grid is set to
False. The default size is set to
800,600.

Determines whether the
Response/Non-Response Grid is
displayed using Scheme Colors or
Custom Colors. Scheme Colors are
set under Chart Colors. Custom
Colors are set in Custom Cell and
Grid settings for Response/Non-
Response Grid Settings. The
default is set to True, which uses
Scheme Colors.



Showbar Settings Enables you to view and change Showbar settings

Setting

Description

Display Showbar

Expand Showbar

Use Secondary
Monitor

Determines if the Showbar is visible
during a SlideShow. The default is
set to True, which displays the
Showbar.

Determines if the Showbar is
displayed in its expanded state. The
default is set to True, which displays
the Showbar in its expanded state.

Determines if the Showbar is
displayed on secondary monitor if
available. The default is set to True,
which displays the Showbar on the
secondary monitor.



Slide Settings

Slide settings affect specific slides and answers. The slide settings apply to the slide selected from
the Settings Hierarchy (and the particular answer, if applicable).

Slide Settings
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This enables you to view and change the chart settings.

Setting

Description

Chart Colors

Chart Color 1

Chart Color 2

Chart Color 3

Determines what chart colors will be
used during your presentation. The
available settings are Color
Scheme, Correct/Incorrect and User
Defined. Color Scheme - uses the
selected PowerPoint color scheme.
To change the color of your charts,
you must change color setting in
PowerPoint. See PowerPoint help.
Correct/Incorrect - uses user
defined colors for slides that have
answers selected as correct and
incorrect. All other slides in the
presentation will uses the
PowerPoint color scheme. To
change the colors for correct and
incorrect answer see the
descriptions for Chart Color Correct
and Chart Color Incorrect settings
below. User Defined - uses user
defined colors. To change colors
see descriptions for Chart Color 1
through Chart Color 10 settings
below.

The default is set at Color Scheme.

Determines the first chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the second chart color
to be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the third chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.



Setting

Description

Chart Color 4

Chart Color 5

Chart Color 6

Chart Color 7

Chart Color 8

Chart Color 9

Chart Color 10

Determines the fourth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the fifth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the sixth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the seventh chart color
to be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the eighth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the ninth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.

Determines the tenth chart color to
be used for User Defined color
setting. To change the color: 1.)
Select the current color to display
the Color Select window. 2.) Select
the new color.



Setting

Description

Chart Color Correct

Chart Color
Incorrect

Chart Labels

Chart Value Format

Review Only

Determines the color to be used for
Correct answers for Correct
Incorrect color setting. To change
the color: 1.) Select the current
color to display the Color Select
window. 2.) Select the new color.

Determines the color to be used for
Incorrect answers for Correct
Incorrect color setting. To change
the color: 1.) Select the current
color to display the Color Select
window. 2.) Select the new color.

Determines if Answer Aliases
(Answer Bullet Format) or Bullet
Points will be displayed in the chart
labels and legends. The default is
set to Aliases.

Determines whether TurningPoint
displays the chart values a a whole
number (Number of people who
answered a question) or
Percentage (Percentage of people
who answer each question.) The
valid formats are: 0, 0%, 0.0%, and
0.00%. The default is set at 0%

Determines whether to a chart
showing how participants
responded to a question is
displayed during a presentation or
only when a presenter reviews the
presentation. The default is set to
False which displays charts during
the presentation.



Enables you to view and change various uncategorized

settings.

Setting

Description

Allow Duplicates

Anonymous

Correct Point Value

Demographic

Incorrect Point
Value

Multiple Response
Divisor

Question Alias

Response Data

Determines whether more than one
response per response device is
permitted. The default is set to
False, which does not allow more
than one response.

Designate slide as anonymous
when polled. The default is set to
False, which does not make the
selected slide Anonymous.

Set the default Point value of a
correct answer. The acceptable
range is from negative 10,000 to
10,000. The default is set to 100.

Determines if the question on the
selected slide is treated as
demographic question. The default
is set to False, which does not treat
the question as demographic.

Set a default point value for
incorrect answers. The acceptable
range is negative 10,000 to 10,000.
The default is set to zero.

Determines whether the divisor
used to calculate the percentages
on multiple a response question will
be the total number of responses
received or the total number of
devices that participated. The
default is set to Devices.

Determines how the question is
labeled. This applies only to some
reports. The default is set to how
the question appears on the slide

Determines whether a slide
contains response data. When set
to True, the slide has polled data
and will not be polled again. When
set to False, the slide can be polled
again. The default is set to True and
the slide will contain response data
and cannot be polled again.



Setting

Description

Responses

Speed Scoring

Zero Based Polling

Determines the number of
responses accepted from a
response device without overwriting
the previous response. The
acceptable range is 1-10
responses. The default is set to 1.

Determines whether point values
will decrease relative to the time
polling is kept open. The default is
set to False, which will not decrease
point values relative to the time
polling is kept open.

Number answers from 1-10 or 0-9.
When set to True, answers will be
number from 0-9 and will override
the current answer bullet format.
The default is set to False.

Enables you to view and set Response Reminders settings.

Setting

Description

Auto-Advance

Determines whether the SlideShow
will automatically advance to the
next animation if polling is closed by
a Countdown Indicator or Response
Counter object. The default is set to
False, which does not automatically
advance the SlideShow.



Setting

Description

Countdown
Seconds

Countdown Sound

Set the number of seconds a
Countdown object will display. The
acceptable range is 1-999. The
default is set at 10 seconds.

Use a sound file for a Countdown
sound.To add a Countdown sound:
1.) double click the current setting to
open the folder window. 2.)
Navigate to the folder containing the
wav or mp3 file is located. 3.) Select
the file name. 4.) Select open. 5.)
Select done.

The default is set to (None). The
acceptable file extensions include:
.aiff, .au, .mid, .midi., .mp3, .wav,
and .wma.



Answer Settings

Answer-level settings affect specific answers. The answer settings apply to the answer selected from

the Settings Hierarchy.

Chart Settings

Answer Settings

¥ o TurningPaint - Settings (=]

Settings | Poling Test

Response Device
Presentation
=2 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Youngstown
4 Cleveland
13 Wihere is the capital of Penr
1 Pittsburgh
2 Harrishurg
3 Scranton
4 Philadelphia
=4 Where is the capital of the L
1 Washington State
2 \Washington, PA
3 Washington D.C.
4 tWashington, NC
£1'5 Wihere is the capital of New
1 Albuguerque
2 santaFe
3 Los Alamos
4 Carlshad

~

Answer Settings

Answer Alias
Answer Valle

Colurmbus
No Valle

@ Common Settings () All Settings

Dane

This enables you to view and change the chart settings.

Setting

Description

Answer Alias

Answer Value

Determines the Alias (Name) that is
used for the chart labels and in
some reports. The default is set to
the answers entered during slide
creation.

Determines whether the Answer is

Correct, Incorrect or has no answer,
or give the answer a point value of

negative 10,000 to 10,000.



Where Do I Go From Here?

If you are setting up your devices for the first time, the next step is to create your Participant List. A
Participant List allows you to track the responses provided by your audience for each slide you
present. Find instructions to create a Participant List in Chapter 5: Track Participants and Teams.

If you have installed new response device hardware, and you have already set up your Participant
List, you can create a new interactive presentation or run an existing presentation using the new
device. Find instructions to create slides in Chapter 3: Creating and Saving Slides. Find
instructions to run a presentation in Chapter 7: Run Presentations.



Track
Participants and
Teams

Participant Lists identify the members of your audience—your students, your trainees, your survey
respondents—who will use a response device to respond to questions during your presentation. The
participant name and other required information are stored along with information about their
assigned device, which is identified by number (for example, 1, 2, 3, and so on) and by Device ID, a
unique identifier for a response device. The Device ID is printed on the device tag, which is located on
the back of the device (unless you are using vPad and Web vPad response software).



Recall the five steps to presentation success.

Five Steps to Success

-—
g

Install TurningPoint

Enter question text.

Tl e

Step Two: Step Three:
Install Devices Create
Step One: and Manage Participant List

Create Slides Settings

P
Where is the capital of Ohio
1. Coumbus -

; :«":_'-E»« |:{> _L (Optionally)

Manage Tools

Py

Step Four: (Optionally) Run Reports
Run Presentation

~

{Optionally) Export Data
Step Five:
Save Session

This chapter discusses creating and managing a Participant List.



Create Participant Lists

Create a Participant List using the Participant List Wizard, Enterprise Manager from Turning
Technologies or Course Management Systems by Web CT and Blackboard.

You may create multiple Participant Lists to be used with the same interactive presentation. One
Participant List contains information about one audience group. This allows you to capture responses
from multiple audiences to your slides.

Create a Participant List using Participant List Wizard
Create Participant List from Enterprise Manager

Create a Participant List from a Course Management System

Create a Participant List using Participant List Wizard

The Participant List Wizard guides you through the creation of a Participant List to be used with your
interactive presentation. You control the number of responses TurningPoint will accept, which equates
to the number of audience members. A Participant List captures the audience names, their device
numbers and serial numbers, and other relevant information.

Create a Participant List using the Participant List Wizard. You can choose from using standard list
templates or create one of your own to store as much information about your audience as is desired.

Before You Begin

If you are using a Response Table, the number of names entered in the Participant List must not
exceed the number of expected devices that you identified for use in the Settings. The Response
Table will only display the number of Participants equal to the number of expected devices.



Step by Step Instructions To create a Participant List...

1 From the TurningPoint Participants Menu

toolbar, select Participants > -~ a}
A @ °

Participant List Wizard.
Participants Select a Help

£ Participant List

Display Participant Maonitor
Participant List Wizard
Import a Participant List
Edit a Participant List

Gk & E Bl

Delete a Participant List

The TurningPoint Participant List window opens presenting
the option to use a pre-defined Participant List template or to
create a custom template. Custom templates created in the
past will appear in the My Custom Templates region when the
Custom Template button is selected.

2 Select a template for the new Participant List Wizard

Participant List. - ﬂ?
ik @ r

Participants Select a Help
= Participant List

Display Participant Maonitor
Participant List Wizard
Import a Participant List
Edit a Participant List
Delete a Participant List

G B E B

Participant List template choices include:

Education—contains standard student information
used for K-12 and higher education presentations,
such as name and student ID.

Corporate—contains entries for the information most
often used in corporate feedback meetings including
name, company name, telephone numbers, etc.



3 Select the Next button to
continue.

Available Fields—contains all information entries defined
for use with TurningPoint.

Custom—allows you to create a personalized Participant
List and to name the template or it allows you to select a

previously created template from the list.

If you opted to create a new template, TurningPoint asks you to
name the template. Enter a name and select the OK button.

TurningPoint

Pleaze enter a name for your custom template.

Custom Template Name

| MHew Template

79,2007 2.34 P

TurningPoint displays the Participant List information entries
(called fields). All entries that make up the template appear in
the Selected Fields region on the right. Use this page to add,

delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields

" a TurningPoint - Participant List Wizard

Please select your participant list fields

Available Fields

Address 1
Address 2
Ciby
Company
Counkry
Department
Ernail

Fax

Initial Points
Mobile
Phone
SkakefProvince

Q0

Selected Fields

Last Mame
First Marme
Student 1D

0000

Add a custom figld

NI

Cancel

l

Back

] [ MNext ]




4 Optionally, customize the list Right (>) and left (<) arrow buttons appear.
of Selected Fields.

* To remove an entry from When selecting entries from the fields lists, hold Shift +
the template, select it click to select multiple contiguous entries, or Control +
under the Selected Fields click to select multiple entries.

region and click the left
arrow button.

* To add an entry to the
template, select the
desired entry from the
Available Fields region,
and click the left arrow
button.

e To change to order of the
selected Fields click the up
and down buttons.

5 Select the Next button to TurningPoint displays the Groups entry box. Use this screen
continue. to add Groups to your Participant List. Groups provide
categorization for greater reporting opportunities, such as
demographic reports or team competitions.



Participant List Wizard: Add Groups

‘m TurningPoint - Participant List Wizard

Add Groups to your Participant List

You may optionally include Groups within your  Included Groups
Participant List, Participants may be assigned
to these groups for purposes of tracking
dermographics and/or tearn cormpetition,

Zreate a new group

| Add
s ] (e ]
6 Optionally, type in a group TurningPoint displays all groups in the Included Groups list.
name and select the Add Repeat this step to add additional groups.
button.
7 Optionally, edit the The settings you can change include the Participant List file
Participant File composition. name, number of participants, number of fields, and number of

groups. For file name select the old file name and type a new
one in the box provided. For Number of Fields or Number of
Groups, select the link to be returned to the screen and make
edits.



Chapter 5: Track Participants and Teams

8 Select the Finish button to
create the Participant List
and save it to a file.

9 Optionally, save the template
for future use.

10 Add names and other
participant information to the
new Participant List.

TurningPoint displays the Participant Information window
where you can type, paste, edit or import data. You can also
Add/Remove or Rename Fields and Groups from this window.

Participant List Wizard: Participant Information

a Participant Information - New List 7.6.2007 4.09.29 PM.tpl

i File  Edic  Import Number of Participants: 1

[ | Device ID Last hame First Hame Student ID Team 1 | Team2
¥y

[ check to rearrange colurn order (sdting Functionalty wil be limiced)

Flease select a Partiopant st you would ke to edi by dicking the Fle menu and cick Open.

Cancel Done

If you have modified a pre-defined template, TurningPoint
asks whether to save the settings as a custom template. If you
select the Yes button to name and save the template, the
custom template will be available under My Custom
Templates the next time you create a Participant List.

Participant Information

= Participant Information - New List 7.6.2007 4.09.29 PM.{pl [SE=][ES]
i File Tmport Rumber of Participarks: 4
Device ID Lask Mame First Mame Student ID Team 1 Team2
1 7 “Washington George 1776 V|
2 |8s Franklin Benjanmin 17z v|
3 90 Hamiton Alexander 1801 v
P 4 |43 Adams John Q. 7679 [F]

[ check to rearrange column order (editing Functionality will be limited)

Flease select a Particpant List you would ke to edt by clicking the Fle menu and click Open.

Cancel Done

226
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Create Participant Lists

11 Optionally, Add a Field.

a Select a row in the TurningPoint will insert the new group/field to the right of
Participant Information the row you have selected.
window.

b Select Edit from the menu Participant Information: Edit Menu
bar_ = Participant Information - New List 7.6.2007 4.09.29 PM.tpl

Import: HNumber of Participants: 4

[t Chrl+ StudentID | Team 1 | Team 2

Copy ctrhC 1776

Paste Ctrl+y 1752

Select Al A 1801

Clear Del X 7679

Add Participant

Remove Participanti(s)

add FeldfGraup 3 Add Field
Remove Fisld/Group Add Group

Rename Field/Group

Freeze Columnl(s)

[ check ko rearrange column order (editing functionalicy will be limited)

Please select = Particpant List you wauld Ike to edi by cicking the File menu and cick Open

Cancel Done.

This displays a menu listing the editing options available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

c Select Add Field/Group > This displays an Add Participant Information window.
Add Field
Participant Information: Add Participant Information

Participant Information

Add Participant Information

Add a custom Field Selected Fields

TurningPoint User Guide 227



12

d Type the name of the new
field in space provided
under Add a custom field.

e Select Add.

f Repeat steps d and e to
add additional fields.

g Select Finish.

Optionally, Add a Group.

a Select Edit from the menu
bar.

The name of the newly created field appears in the
Selected Fields box.

To remove any fields from the Selected Fields box,
place a checkmark in the box next to the field name and
select Remove.

The fields you created will be added to your participant
list.

Participant Information: Edit Menu

a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

Import Humber of Participants: 4

Cut Chrki Student I | Team 1 Team2

Copy b 1776

Paste Chrl+y 1752

Select Al Ctra 1801

Clear Del ) 7679

add Participant

Remove Participant(s)

Add Figld/Group r Add Field

Remave FiekdiGroup Add Group

Rename FieldiGroup

Freeze Calurin(s)

[ Check ko rearrange colmn order {editing Functionality will be limited)

Please select a Participant List you would like to edit by cicking the File menu and cick Open.

Cancel Done

This displays a menu listing the editing options
available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.




b Select Add Field/Group >
Add Group.

c Type the name of the new
group in space provided

under Create a new group.

d Select Add.

e Repeat steps d and e until
you have added all of your
additional groups.

f Select Finish.

This displays an Add Groups to your Participant List
window.

Participant Information: Add Groups

Participant Information

Add Groups to your Participant List

Create & new group Included Groups

Team 3 Aadd

The name of the newly created group appears in the
Included Groups box.

To remove any groups from the Included Groups box,
pace a checkmark in the box next to the group and select
Remove.

The groups that you created are added at the end of your
participant list.



Chapter 5: Track Participants and Teams

13 Optionally, Rename a
Field/Group.

a Select the field or group
that you want to rename.

b Select Edit from the menu Participant Information: Edit Menu

bar. a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

Import Humber of Participants: 4

Cut Chrki StudentID | Team 1 Team2
Copy ke 1776

Paste i+ i 1752

Select al ctri+a 1601

Clear Del 3 eI

add Participant

Remove Participant(s)

add Field/Group » Add Field
Remove FigldiGroup Add Group

Rename Fiskd{Group

Freeze Calumn(s)

[] Check ko rearrange column order {editing functionailty will be limited)

Floase select  Participant List you would ke to edt by cicking the Fils menu and cick Open-

Cancel Done

This displays a menu listing the editing options
available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

c Select Rename Participant Information: Field/Group Entry
Field/Group.

Participant Information

Pleasze enter the name of the Field/Group.

| Team 1 |

This displays a text entry window.

230 Turning Technologies



d Enter the new name of the
field/group.

e Select Ok.

14 Optionally, Remove a
Field/Group.

a Selectthe Field/Group that
you want to remove.

b Select Edit from the menu
bar.

c Select Remove
Field/Group.

Create Participant Lists

The Field/Group has been renamed.

Participant Information: Edit Menu

a Participant Information - New List 7.6.2007 4.09.29 PM.tpl

Impart
=1
Copy
Paste
Select Al

Clear

Remave

Remave

Rename

Add Participant

Add FieldiGroup 3 Add Field

Freeze Column(s)

[] Check to rearrange column order (editing funetionality will be limited)

number of Participarits: 4

Ctrl+ StudentID | Team | | Team2
C+C 1776

Chri+y i 1752

I Chrih 1801

Del ) 7679

Participant(s)

Field{Group Add Group
Field{Group

Flease select 2 Particpant List you would like to edit by dicking the Flle menu and click Open.

Cancel Done

This displays a menu listing the editing options available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

The field/group will be deleted.

TurningPoint User Guide
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Chapter 5: Track Participants and Teams

15 Optionally, rearrange the
column order in your
Participant List.

a Place a checkmark in the Participant Information: Rearrange Columns
box next to Check to 2/ Participant Information - New List 7.6.2007 4.09.29 PM.1pl
rearrange column order TRk Edt Impot Number of Partiparts: 6
located at the bottom of RN T 2 &
. 2 |85 Franklin Benjanmin 1752 [ |
the WIndOW 3 90 Hamilkan Alexander 1801 [ |
4 43 Adams John G, 7679 | |
5 09 Lincoln Abraham 1865
3 Ford Gerald TEE
heck ko rearrange column arder (editing Functionality will be limited)
Please select a Participant List you would like ta edit by clicking the File menu and click Open.
You will have limited editing abilities while this function
is active.
b Select the column you Click and hold the column would like to move.
want to move.
c Drag and drop the column
to its new location.

16 SelectFile > Save to save the The new Participant List appears on the TurningPoint toolbar
data in the Participant List in the Select a Participant List drop-down menu (next to the
before closing the Participant Participants menu).

Information window.
232 Turning Technologies



Create Participant List from Enterprise Manager

You can use Enterprise Manager from Turning Technologies with TurningPoint. Enterprise Manager is
an essential tool for large organizations that put the TurningPoint 2008 group response system to
work in a classroom setting. Using a web-based interface, users interact with Enterprise Manager to
identify classes that use TurningPoint 2008 as part of the curriculum, assign faculty and students to
those classes, and input Device IDs for the students’ response devices. Enterprise Manager captures
this information and manages the licenses for response device usage.

Class rosters stored in Enterprise Manager are ready for use with TurningPoint 2008. A faculty
member using a computer on the organization’s network can open TurningPoint 2008 and use the
Enterprise Manager Wizard to import a class roster and use it as a Participant List.

On TurningPoint Enterprise Manager, the system is designed to work with KeyPads and does not
require the special setup of WebCT and Blackboard.

To access TurningPoint Enterprise Manager, you need the following information from the technical
support staff at the school:

server name of the Enterprise Manager server

your username

your password

Before You Begin

Open TurningPoint 2008 on the computer hosting the presentation.



Step by Step Instructions To load a Participant List into TurningPoint 2008...

1 From the TurningPoint A menu opens and displays a list of TurningPoint tools. The
toolbar, select Tools. Enterprise Manager option displays near the bottom of the list.

Enterprise Manager Menu

Response Devices

%% | Turning Reports

Session Management 4
Standards

Comparative Links

Conditional Branching

Import from TestingPoint

Parser

Update Parser Template

G R

Ranking Wizard

WebCT Wizards * | & Campus Edition 4.1

=
&

Blackboard Wizard i-_ Campus Edition 6.0/ Vista 3, 4

VantagePoint
QuestionPoint
Enterprise Manager

Settings

RSP

Upgrade TurningPoint Receiver

2 Select Enterprise Manager > The Enterprise Manager Log-in window opens.
Enterprise Manager Log-in.
Enterprise Manager Log-In Window

= TurningPoint - Enterprise Manager E]

Enterprise Manager Log-In

Server URL: | |

User Mame: | |

Password: | |

. Wark OFFline [



3 Enter the Server URL, User
Name, and Password.

4  Select the Next button.

5 Select the class from the
drop-down menu.

6 Select the Import Participant
List checkbox.

7 Select the Finish button.

The Server URL is the web address where faculty members
access Enterprise Manager. Faculty members enter the user
name and password used to log into Enterprise Manager.

The Class Select window opens. The drop-down menu displays
the list of classes assigned to the faculty member. A checkbox
displays next to Import Participant List.

Class Select Window

= TurningPoint - Enterprise Manager

Enterprise Manager Class Select

Please select your current class:

iTPEM-lDl Inkroduction to TurningPoint Enterprise Manager ¥

[w] Import participant lisk

A checkmark appears in the box when selected.

Confirmation text displays in orange in the Class Select window
when the file has been successfully imported. The Class Select
window closes.

A Save As window opens for saving the Participant List on the
host computer. In the location field, the file is set to be saved in
the Participants folder under My Documents > TurningPoint. In
the File Name field, the class name displays with the date and



time of the import. You may edit the name to be more
meaningful.

Note The Participant List must be saved in the
Participants folder under My Document >
TurningPoint on the host computer for
TurningPoint to find the list.

8 In the Save As window, A confirmation message displays.
select the Save button.
Confirmation Message

TurningPoint

TurningPoint has successfully imported your class participant lisk{s).
Click on the participant list pulldown menu to load your list ar click the participants menu to for other options.

9 Select the OK button. The newly imported Participant List displays in the Participant
List drop-down menu in the TurningPoint Toolbar.

Next Steps

Before giving the presentation, select the Participant List from the Participant List drop-down menu.

Create a Participant List from a Course Management System

As a versatile educational tool, TurningPoint is also compatible with course management systems
by WebCT and Blackboard. If you teach at a school or other educational institution that uses
WebCT or Blackboard you can use TurningPoint to transfer classroom information between your
computer and a server. Varying degrees of integration are available for different versions of these
course management systems.

TurningPoint can work with WebCT and Blackboard to import a Participant List from a server. The
following steps describe how to connect to WebCT and Blackboard from TurningPoint. Before trying



to import data into TurningPoint, ensure you are set up properly on the system’s server. Contact the
technical support at the school if you need assistance with setup.

Before You Begin
On WebCT, the following steps need to occur with WebCT before using the WebCT Wizard:

The system administrator at the institution adds a column called “KeyPadID” in WebCT. The
instructions on how to add a column are found in the System Administrator’s Guide: WebCT
Campus Edition.

The instructor creates a class list and includes the KeyPad ID field.

The students log into WebCT and enter their KeyPad ID number twice, the second time to confirm,
and then enter their contact information. Students receive a message that the add was successful
and that their currently registered Device ID is xxxy, etc.

The instructor can then gather all response Device IDs from registered students.

To use the WebCT Wizard, you need to obtain the following information from the technical support
staff at the school:

server name of the WebCT server
port number of the WebCT server
your username
your password

On Blackboard, the following steps need to occur with Blackboard before using the Blackboard
Wizard:

The instructor creates a class list and identifies an existing column to store the KeyPad ID data.
(Blackboard does not allow adding a column.)

The students log into Blackboard and enter their KeyPad ID number in the column specified by the
instructor. Students must reenter their KeyPad ID when new classes are added.

Instructors and students can also download information for multiple classes into a zip file and
choose a location in which to save the file.

To use the Blackboard Wizard, you need to obtain the following information from the technical support
staff at the school:

server name of the Blackboard server
your username

your password



Step by Step Instructions

1

From the TurningPoint
toolbar, select Tools. In the
menu, select WebCT Wizard
(CE 4.1 or CE 6.0/Vista 3, 4)
or Blackboard Wizard
Manager, depending on your
system.

To import a Participant List...

Course Management Menu

Response Devices

Eoes e

t RSB

-
3-

Turning Reports

Session Management 4
Standards

Comparative Links

Conditional Branching

Import from TestingPoint

Parser

Update Parser Template

Ranking Wizard

WebCT Wizards 4
Blackboard Wizard

Campus Edition 4.1
Campus Edition 8.0/ Vista 3, 4

i B

VantagePoint
QuestionPoint
Enterprise Manager

Settings

Upgrade TurningPoint Receiver

TurningPoint displays a window to ask you which task you
would like to perform.



2 SelectImport Participant List. WebCT Wizard: Select Task

= WebCT Wizard
WebCT Interface

r5elect a Task to Perform —

@ Impork Participant Lisk

) Export Grade Data

Note The illustrations shown in this section are of the
WebCT CE 4.1 interface, but the interfaces for
WebCT CE 6.0/Vista 3, 4 and Blackboard are
similar.

3 Select the Next button. TurningPoint provides a window for your login information.
Contact the technical support at the school to obtain this
information if you do not have it.

4  Enter your login information. WebCT Wizard: Login

= WebCT Wizard X]

WebCT Log-In

Server Mame (IF3: |sv1 urninguniversity, com

Port Mumber: |560E| |
User Mamne: |bl‘ﬂi||er' |
Password: k| |




5 Select the Next button.

TurningPoint saves the Server Name (IP) and the Port
Number. You must enter your username and password for
WebCT. The system prompts you for the Institution’s name
and then displays all courses associated with your user name
and password.

The next steps differ slightly depending on the type of system
you have. In WebCt CE 4.1, you indicate the course pertaining
to the Participant List you want by following the instructions in
the window. In WebCT CE 6.0/Vista 3, 4, you select the
institution you belong to and then the course you wish to
import from. In Blackboard, you provide the name of the field
in the Participant List file that holds the KeyPad ID data.



6 Provide the information
requested in the window,
including selecting the course
containing the data you want
to import. In Blackboard,
select the name of the field
you designated to hold the
KeyPad ID.

= WebCT Wizard

WebCT Class Select

Moasze chock the classes you would lilke ko
impork from the list below;

WebCT Wizard: Class Select
X

= Blackboard Wizard

Blackboard Class Select

Please enter the Course ID of the course
wou would like bo import From:

Blackboard Wizard: Class Select

X

‘TP101

vl

Please select the field that contains the
Response Device IC:

!Company

vl

[oec N o |

correctly.

Note In Blackboard, a class list is limited to the
existing columns. When you set up a class
list, you cannot add a column for KeyPad ID
numbers. You must use a column that
already exists but is unused, such as
Company or Work Fax. Inform students of
the name of the column you designate for
KeyPad ID numbers so they enter their data

TurningPoint displays a window describing the location where
the data will be imported to the computer and the file name you
wish to import. The default location is My

7 Select the Finish button.



8 Select the Save button.

9 Select the OK button.

Documents\TurningPoint\ Participants. TurningPoint adds the
current date and time to the file name.

TurningPoint displays a confirmation message that your file
has been imported. Optionally, you may edit the location or
file name, and then select the Save button.

Note A Participant List must be saved in My
Documents\TurningPoint\Participants on the
computer that runs the presentation session.

The file name displays in the Select a Participant List drop-
down menu if it is saved in the My Documents\
TurningPoint\Participants folder.

TurningPoint Toolbar: New Participant List

Participants = | |

OIS
(Auto)
Histaric Men
Partic 1
Partic 2
Presidents
Teams




Manage Participant Lists

After you have imported a Participant List or created one with the Participant List Wizard, you can
make changes to a Participant List or delete it altogether.

This section describes how to:

Modify a Participant List
Delete a Participant List

Add Data to a Participant List from a Course Management System

Modify a Participant List

Follow these steps if you would like to make changes to an existing Participant List. Although the
presenter’s computer assigns response device numbers to each participant, you can manually assign
a participant to a specific device number by modifying the list.

Before You Begin

A Participant List should have a.tpl extension (TurningPoint participants format). You must import the
Participant List or create a list using the Participant List Wizard Assistant before editing it with
TurningPoint.

When modifying a Participant List, you may add as many new participants as needed. If you add more
participants than the number of expected devices range that were designated when you setup your
devices and you are using a Response Table, you will need to change the number of expected
devices. The Response Table will only display the number of participants equal to the number
expected devices. Find more information on expected device range in Response Device Settings on
page 192 and on Response Tables in Add a Response Table on page 141.



Chapter 5: Track Participants and Teams

Step by Step Instructions

1 From the TurningPoint
toolbar, select Participants >
Edit a Participant List.

2 Selectthe desired Participant
List, and then select the
Open button.

To modify a Participant List...

@ ?

Selecta Help

Participants Menu

Participants
- Participant List |

Display Participant Monitor
Participant List Wizard

uad Import a Participant List
|4 Edit a Participant List

#%  Delete a Participant List

TurningPoint displays a window of Participant Lists saved in
My Documents > TurningPoint > Participants.

TurningPoint displays the Participant List data in the
Participant Information window. The grey fields represent
data that cannot be edited, such as the column titles and row
numbers.

Participant Information window

a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

i Fle Edit  Import Mumber of Participants; 1

| Devics ID Last hame First Mame: Student ID Tesml Teamz

[] Check ko rearrange column order {editing functionailty will be limited)

Floase select  Participant List you would ke to edt by cicking the Fils menu and cick Open-

Cancel Done
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3 Optionally, edit the existing
data in the white fields by
selecting the entries and
typing new information.

4 Optionally, add a new
participant by right-clicking in
in the row above the row that
you want to add a participant
and selecting Add
Participant.

5 Optionally, Add a Field.

a Select a row in the
Participant Information
window.

Manage Participant Lists

Participant Information Window: Add New

a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

i Fle Edit  Import

Humber of Participants: 6

Copy
Paste

Clear

Select Al

Add Participant
Remove Participant(s)

[] Check ko rearrange column order {editing functionailty will be limited)

Device [D Last Mame First Mame Student ID Teaml Teamz Team3
» 1T Washington | George 1776 L
2 85 Frankin Benjanmin 1752 u
L] Harmikon Alexander 1601 [ ]
4 |4 Adams John Q. 7679 L
i 1865

Floase select  Participant List you would ke to edt by cicking the Fils menu and cick Open-

Cancel Done

TurningPoint will insert the new group/field to the right of
the row you have selected.

TurningPoint User Guide

245



Chapter 5: Track Participants and Teams

b Select Edit from the menu Participant Information: Edit Menu

bar. a/ Participant Information - New List 7.6.2007 4.09.29 PM.tpl

Import Humber of Participants: 4

Cut Chrki StudentID | Team 1 Team2
Copy ke 1776

Paste i+ i 1752

Select al ctri+a 1601

Clear Del ) 679

add Participant

Remove Participant(s)

Add Field{Group » Add Field

Remove FigldiGroup Add Group

Rename Fiskd{Group

Freeze Calumn(s)

[] Check ko rearrange column order {editing functionailty will be limited)

Floase select  Participant List you would ke to edt by cicking the Fils menu and cick Open-

Cancel Done

This displays a menu listing the editing options
available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

c Select Add Field/Group > This displays an Add Participant Information window.
Add Field
Participant Information: Add Participant Information

Participant Information

Add Participant Information

Add 5 cuskom field Selected Fields

Add
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d Type the name of the new
field in space provided
under Add a custom field.

e Select Add

f Repeatstepsdandeto
add additional fields.

g Select Finish.

Optionally, Add a Group

a Select Edit from the menu
bar.

The name of the newly created field appears in the
Selected Fields box.

To remove any fields from the Selected Fields box, place
a checkmark in the box next to the field name and select
Remove.

The fields you created will be added to your participant
list.

Participant Information: Edit Menu

a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

Import Humber of Participants: 4

Cut Chrki Student I | Team 1 Team2

Copy b 1776

Paste Chrl+y 1752

Select Al Ctra 1801

Clear Del ) 7679

add Participant

Remove Participant(s)

Add Figld/Group r Add Field

Remave FiekdiGroup Add Group

Rename FieldiGroup

Freeze Calurin(s)

[ Check ko rearrange colmn order {editing Functionality will be limited)

Please select a Participant List you would like to edit by cicking the File menu and cick Open.

Cancel Done

This displays a menu listing the editing options available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.




b Select Add Field/Group >
Add Group.

c Type the name of the new
group in space provided

under Create a new group.

d Select Add.

e Repeat steps d and e until
you have added all of your
additional groups.

f Select Finish.

This displays an Add Groups to your Participant List
window.

Participant Information: Add Groups

Participant Information

Add Groups to your Participant List

Creake & new group Included Groups

Tearn 3 Add

The name of the newly created group appears in the
Included Groups box.

To remove any groups from the Included Groups box,
lace a checkmark in the box next to the group and
select Remove.

The groups that you created are added at the end of
your participant list.



Manage Participant Lists

7 Optionally, Rename a
Field/Group.

a Select the field or group
that you want to rename.

b Select Edit from the menu Participant Information: Edit Menu

bar. = Participant Information - New List 7.6.2007 4.09.29 PM.tpl

Import Number of Participarits: 4

Cut i+ Student D | Team 1 | Team 2

Copy ctrhC 1776

Paste Chrl+y 1752

Select All Chrkka 1801

Clear Del ) 7e7a

add Participant
Remove Participant{s)

Add FigldiGroup » Add Field

Remave FieldiGroup Add Group

Rename FieldiGroup

Freezs Calunmnis)

[ Check to rearrange colurn order (editing Functionality will be limied)

Please select a Particpant List you would like to edit by dicking the File menu and click Open.

This displays a menu listing the editing options available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

c Select Rename Participant Information: Field/Group Entry
Field/Group.

Participant Information

Fleaze enter the name of the Field/Group.

| Team 1 |

This displays a text entry window.
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d Enter the new name of the
field/group.

e Select Ok. The Field/Group has been renamed.

8 Optionally, Remove a
Field/Group.

a Selectthe Field/Group that
you want to remove.

b Select Edit from the menu Participant Information: Edit Menu

bar. a Participant Information - New List 7.6.2007 4.09.29 PM.1pl

Impart Humber of Participants: 4

Cut ek StwdentID | Team1 Team2
Copy CrhC 1776

Paste ek i 1752
Select Al A 1801

Clear Del ) 7679

idd Participant

Rernove Participant(s)

Add FieldfGroup 3 Add Field
Remave FieldjGroup Add Group
Rename FieldjGroup

Freeze Column(s)

[ Check to rearange column order (sdting functionality will be mited)

Flease select a Participant List you would like to edt by cicking the File menu and cick Open.

Cancel Done

This displays a menu listing the editing options
available.

Tip  Alternately, you can right-click to display a
contextual menu listing the same editing
options.

c Select Remove The field/group will be deleted.
Field/Group.
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9 Optionally, rearrange the
column order in your
Participant List.

a Place a checkmark in the
box next to Check to
rearrange column order
located at the bottom of
the window.

b Select the column you
want to move.

c Drag and drop the column
to its new location.

10 Select File > Save.

Manage Participant Lists

Participant Information: Rearrange Columns

a Participant Information - New List 7.6.2007 4.09.29 PM.tpl

Number of Participants: &

Team 1 Team2 Team3

iFie Bt Import
Device ID Last Name First Mame Student 1D
17 Washington | George 1776
2 |ss Frarklin Benjanmin 1752
3 |90 Harniltan Alexander 1801
4 |43 Adams John Q. 7679
5 |9 Lincoln abraham 1865
& Ford Gerald 7678

heck to rearrange column order (editing functionalicy will be limiced)

Please select a Participant List you would ke to edit by cicking the File menu and cick Open

Cancel Done

You will have limited editing abilities while this function is

active.

Click and hold the column would like to move.

TurningPoint displays a confirmation message telling you that
your changes have been saved.
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11 Select the Done button to
close the Participant
Information window.

Delete a Participant List

This section describes how to remove a Participant List from TurningPoint.

Before You Begin

Deleting a Participant List sends the file to the computer’s Recycle Bin. Save a backup copy in
another location if you would like to be able to access the file later.

Step by Step Instructions

1 From the TurningPoint
toolbar, select Participants >
Delete a Participant List.

To delete a Participant List...

w | w ?
i ?
Participants Select a Help
~ Participant List

Participants Menu

Display Participant Monitor
Participant List Wizard
Import a Participant List
Edit a Participant List

o B E Bl E

Delete a Participant List

TurningPoint displays a window that lists all Participant Lists
that have been created or imported.



2 Select the file name of the Delete Participant List

Participant List you wish to TurningPoink - Delete Participant List ®
remove. Historic Man.kpl

Mew Lisk 7.6.2007 4.09,29 PM. tpl

Partic 2.tpl

Presidents.tpl
Tearns, kol

Close ] [ Delete

3 Click the Delete button. TurningPoint displays a window confirming that you want to
delete the selected participant list.

Add Data to a Participant List from a Course Management
System

With access to WebCT, Blackboard, or TurningPoint Enterprise Manager, you can import data from a
course management system server and add it to an existing Participant List in TurningPoint.

Before You Begin

If you have not imported data from a server on a course management system before, find more
information in Create a Participant List from a Course Management System on page 236 to know
what you need to do in WebCT, Blackboard, or TurningPoint Enterprise Manager before you begin.

This function allows you to add data to a Participant List as long as the total number of participants
remains less or equal to the number of response devices. The maximum number of response devices
was defined when first creating the list, and you may not exceed that number.



Step by Step Instructions

1

From the TurningPoint
toolbar, select Participants >
Edit a Participant List.

Select the existing
Participant List to be used
and then the Open button.

From the toolbar in the
Participant Information
window, select Tools >
Import. Then select
Blackboard, WebCT or
Enterprise Manager,
depending on your system.

Type the requested
information to connect to the
server.

Select the file containing the
data you wish to import and
then the Open button.

Select File > Save.

To add Participant List data...

TurningPoint displays a window where you can select the file
you wish to edit.

The Participant Information window opens displaying the file
you have selected.

TurningPoint connects to the server and displays the
available files.

TurningPoint connects to the server and displays the
available files.

TurningPoint imports the new data from the file on the server
into the Participant List.

TurningPoint saves edits to the Participant List.



Set Up Team Competitions

TurningPoint can enhance group interaction to create a more memorable and educational
presentation. Team competitions are a fun way to incite this interaction. Set up team competitions
through the Participant List Wizard. You can create a Participant List that enables you to assign
participants to teams who will compete for the highest score during your presentation.

For participants or teams to accumulate scores, you will have to assign point values to correct
answers. You can even assign points based on how quickly participants respond using speed scoring.

TurningPoint offers several slides to keep track of participant and team point totals and which
participants responds most quickly. Find more information in Competition Slides on page 61.

This section describes how to:

Add Teams to a Participant List

Add Teams to a Participant List

Follow these steps to create a Participant List that can enable team competitions.

Before You Begin

These steps create a new Participant List that assigns participants to teams before the presentation. If
you would like to pick teams on the fly during the presentation, you need to insert a Team Assignment
slide. Find information about this special slide in Competition Slides on page 61.

Step by Step Instructions To set up team competitions...

1 Follow step 1 through step 5 In the Participant List Wizard window, TurningPoint displays the
in Create a Participant List Groups entry box. Use this page to add groups to your
using Participant List Participant List.

Wizard on page 221.



Type a group name in the
Create a new group field, and
selectthe Add button. Repeat
for all desired team names.

Select the groups in the
column to the right that you
want to designate as teams
who will compete against
each other.

TurningPoint displays all groups in the Included Groups list.
These groups can represent any type of grouping you wish to
assign participants to, such as teams, class level, or any other
demographic information.

Check marks appear next to the groups designated to
compete as teams.

Participant List Wizard: Add Groups

" a TurningPoint - Participant List Wizard

Add Groups to your Participant List

You may optionally include Groups within your  Incuded Groups
Participant List, Participants may be assigned
to these groups for purposes of tracking
dermographics andfor team competition,

Create a new group

[ add

Remave

] (e




4 Select the Next button to TurningPoint displays the Participant List summary screen.
continue.

Participant List: Summary

" a TurningPoint - Participant List Wizard

Add Participant Information

Participant List Summary

Mame:
Mumber of Figlds: 3
Mumber of Groups: i

Click "Firish" to generate your Participant List and launch the Participant
Information Dialog, From this dialog you can add, edit, import, or export
participant information and assign participants to groups,

Back ] ’ Finish

5 Select the Finish button to
create the Participant List
and save it to a file.

Next Steps

Find more information about slides for keeping track of participants’ and teams’ points in Competition
Slides on page 61.



Where Do I Go From Here?

This chapter has demonstrated how to create and customize Participant Lists for your presentation.

If you have not set up the hardware devices for participants to respond, Chapter 4: TurningPoint
Device and Settings Management demonstrates this process. You only need to set up hardware
devices once on the computer you will use them with, unless you add or change the hardware
devices.

If you have already set up hardware devices and have a participant list for the audience you will be
presenting to, you are ready to conduct your presentation! Chapter 7: Run Presentations
demonstrates this process.



Tools

TurningPoint offers several tools that allow you to use powerful advanced features:

Create slides to rank items.
Create and assign standards for evaluating participants

Create comparative links for comparing the responses from several slides in a single chart in your
presentation

Use conditional branching to control the order of slides in your presentation based on responses
Create slides from imported files.

The Standards tool enables you to use reports to evaluate the performance of participants based on
standards. You can use the built-in standards, set up a list of standards, associate those standards
with questions, and then evaluate the performance of the audience as a whole, by groups, or by
individuals on each standard. Find more information in Standards on page 269.

The Comparative Links and Conditional Branching tools allow you to add advanced functionality to
your presentation.

The Comparative Links tool is used to compare the results from several slides in a single chart in your
presentation. For example, you might ask several similar questions in succession, and then wish to
compare the responses from each question on a single slide. By creating comparative links between
the slides, a single slide’s chart can show the results from up to three additional questions. Find more
information in Comparative Links on page 284.

The Conditional Branching tool allows you to control the order of slides based on the responses to a
question. For example, you could have the audience vote on which topics to cover in your
presentation, or you could continue with a different topic when the audience demonstrates a sufficient
understanding of the current one by answering a question correctly. Find more information in
Conditional Branching on page 289

The Ranking Wizard allows you to create slides to rank items on several criteria. Find more
information in Ranking Wizard on page 261.



The TurningPoint Parser allows you to automatically create presentations from XML or Word
documents. Find more information in Import Slides with the TurningPoint Parser on page 307.

The Import from TestingPoint tool allows you to automatically create presentations from
TestingPoint documents. Find more information in Import Slides from TestingPoint on page 311



Ranking Wizard

You can quickly and easily create slides that support decision-making, prioritization, or other kinds of
ranking using TurningPoint’'s Ranking Wizard. The Ranking Wizard automatically creates slides for
comparisons of items on one to three criteria, then summarizes the results of the comparisons in a
chart.

For example, suppose you wanted to prioritize several projects you are considering. You might
compare them on the basis of cost, impact, and urgency to rank them.

You can choose to rank each item on a numerical scale for each criterion. For example, one slide
would ask you to rank Project A on urgency from least (1) to most (10). You can use a scale beginning

with 1 and ending with any number up to 10.

Alternatively, you can choose to compare items on the criteria by pairs. For example, one slide would
ask you whether Project A or Project B is more urgent.

You can include as many items as you wish, and you can compare them on up to three criteria. The
results are displayed in a chart which ranks the items. The chart looks similar to this:

Ranking Wizard chart

Bubble size = Impact (least to most)
100

ProjectA
60 k 4

00 60 100

Urgency (least to most)

00

Cost {most to least)

In this example, Project D looks like a clear winner, since it has the lowest cost, most urgency, and a
relatively high impact.



The Ranking Wizard gathers information from you about the items, the criteria, and how you would
like to make the comparisons. Then it automatically constructs a series of slides with the questions
and answers necessary to construct a final comparison chart.

This section describes how to:

Create Slides with the Ranking Wizard

Create Slides with the Ranking Wizard

The Ranking Wizard is located in the Tools menu on the TurningPoint toolbar. It guides you through
the process of creating a ranking.

Step by Step Instructions To create slides with the Ranking Wizard...

1 Navigate to the slide you When you complete the Ranking Wizard, the ranking slides
would like the ranking slides will be added to the presentation after the currently visible
to be inserted after. slide.



2 Select Tools from the
TurningPoint toolbar.

The Tools menu opens.

Response Devices

Eo - MR VA 7

St % FE

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
YantagePoint
CuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver

Select Ranking Wizard



3 Select Ranking Wizard. The Ranking Wizard window opens.

Ranking Wizard: Add Items

¥ u TurningPoint - Ranking Wizard X

Add items you want to compare or rank

Enter Item: | J[ aad

= &
4 Type aname for anitem to be The item will be added to the list. You must add at least two
ranked in the box provided items.

and select the Add button. Repeat this step until you have added all the items you would

like to rank.

Note You can save a list of items if you will reuse
them with the Ranking Wizard. Lists are
stored as simple text (.txt) files.

Use the Save button (shaped like a disk) to

save a text file with the list of items. Use the
Load button (shaped like a folder) to load a

text file with a list of items.




5 When you have added all the The next set of options allows you to specify the criteria that is
items to rank, select the Next displayed in the Ranking Wizard.
button.
Ranking Wizard: Enter Criteria

¥ g TurningPoint - Ranking Wizard 3

Enter criteria and choose options

~
—

[J2 writerion

Enter text for the Z coordinate ‘

‘What would you like to do? Haove would vou like your sides created? Do you want te...?

@ Standard RjRYiRYZ ® Grovped by Creria [ futo-advance
) Paired Comparison O Grouped by List Trem Do charts
Optional Paired Comparison Settings
6 Enter a name for the X You must enter at least one criterion (X) for the ranking. If you
criterion and, optionally, the Y are comparing only a single criterion, leave the Y criterion blank.
criterion, in the boxes . . .
) The X and Y criteria appear on the horizontal and vertical axes
provided. .
of the chart, respectively.
7 If you wish to include a third The Z criterion, if used, is represented in the chart by the size of
criterion in the ranking, check the “bubble” for each item.

the box for the Z criterion and
enter a name for the Z
criterion in the box provided.

8 Choose a method for ranking

the items:
* Select Standard X/XY/XYZ You will specify the numerical scale to use later in the
to rank the items on a Ranking wizard if you choose a standard comparison.

numerical scale for the
criteria.



9

10

11

12

e Select Paired Comparison
to compare the items by
pairs on the criteria.

If you chose a standard
comparison, select whether
you would like the slides to be
grouped by criterion or by list
item.

Check the box if you would
like to Auto-Advance the
slides created by the Ranking
Wizard.

Check the box if you would
like to display the charts for
the slides created by the
Ranking Wizard.

If you are using a Z criterion,
check the boxes if you would
like to use the following
options:

e Show Bubble Names
shows the name of each
item on the bubble that
represents it in the ranking
chart.

If you choose paired comparisons, you may allow a
response of No Preference by checking the box for that
option.

Grouping slides by criterion will present the slides for each
item about criterion X, then slides for each item about criterion
Y, and so on.

Grouping slides by item will present the slides for each
criterion about item A, then the slides for each criterion about
item B, and so on.

Using Auto-Advance automatically advances the slide after all
participants have responded to a question.

Commonly, you are not interested in seeing the results for
individual slides in the ranking questions. You can remove the
check mark and use it in combination with Auto-Advance to
make your way quickly through the ranking questions to
display the ranking chart.

The chart also includes a key that color-codes the
bubbles with the items.



* Show Bubble Sizes shows
the numerical size of each
item’s bubble on the
ranking chart.

13 When you have specified all If you chose a standard comparison, the next set of options
the options you would like to allowing you to specify the ranking scale is displayed in the
use, select the Next button. Ranking Wizard window. (If you chose a paired comparison, a

summary is displayed and you can skip to step 17.)

Ranking Wizard: Customize Scale

¥ g TurningPoint - Ranking Wizard X
Customize the ranking scale
14 Uncheck the boxes next to Unchecking a number also unchecks all the larger numbers.

the numbers if you wish to

o For example, if you would like to use a scale of 1-4, uncheck
limit the scale to less than 1-

the box next to 5.

10.
15 If you would like to add labels You might like to add labels to the lowest and highest numbers
to the numbers, select a of the scale (such as “Worst” and “Best”).

number and type the label
text.



16  When you are finished A summary of all the options you chose is displayed in the
modifying the ranking scale, Ranking Wizard window:
select the Next button.
Ranking Wizard: Review Selections

¥ g TurningPoint - Ranking Wizard 3
Review Selections and build slides

viou chose to buid 2
Grouped by

X Criterion is

¥ Criterion is

Z Criterion is

‘ou have entered

Using a scale of

This wizard wil create 12 question slides and 1 chart slide.

17 Review the information in the If any of the information is incorrect, you can select the
summary to ensure that it is incorrect information to be taken to the set of options in the
correct. Ranking Wizard where you specified the information. Change

the information to be correct and then continue with the
remaining steps. (Alternatively, use the Back button to go
back to the incorrectly set option.)

18 Select Finish to create the TurningPoint inserts the ranking questions and the ranking
ranking slides. chart in your presentation. (This may take some time if you
have a large number of items.)

Next Steps

When you run the presentation containing the ranking slides, the results will be compiled to
generate the ranking chart, which is displayed in a slide following the ranking questions.

Because the Ranking Wizard uses the results from the created slides to construct the final chart,
you should not alter the slides created by the Ranking Wizard.



Standards

TurningPoint’s standards tools allow you to use built-in standards per state, subject and grade level or
create your own lists of standards on which participants can be evaluated. For training, teaching, or
testing, standards help you organize the material in your presentation into subject areas,
competencies, or other standards which the participants should meet. You can then view participants’
results by standards using TurningPoint reports. Find more information in Reports on page 341.

Before you can assign standards to slides in a presentation, you need to select from the Built-in
Standards or create a list of the standards you will be using.

This section describes how to:

Create a Built-in Standards List
Create a Custom Standards List

Assign Standards to Slides

Create a Built-in Standards List

TurningPoint 2008 comes loaded with built-in standards per state, subject and grade level. Create a
list of standards using any of these criteria.



Step by Step Instructions To create a Built-in Standards List...

1 Select Tools in the The Tools menu opens.

TurningPoint toolbar.

Response Devices

H e & 8k W

%P B

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
VantagePoint
QuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver

Select Standards



2 Select Standards from the The Standards window opens.
Tools menu.
Standards Window

¥ » TurningPoint - Standards 3]

Buit-in Standards List | Custom Standards Lists |

Select a stake or country... Select & topic. Select a subject Select a grade.

\ 3 | d | d | <]

Current Standrds List: Presertation M

Skandards for Current Selection

Q0

add Category | (_addstanderd | [ Remove | [ EdtFeld

3 Select the Built-in Standards This displays a window with four drop down menus:
Lists tab. state/country, topic, subject, and grade.

Standards Window
¥ a TurningPoint - Standar ds ]

Buit-in Standards List | Custom Standards Lists |

Select a stake or country... Sellect a topic. Select & subject Sellect a grade.

\ 3 | ¥ | ¥ | |

Current Standerds List: Presentation hs

Standards for Current Selection

Q0o

A Category | ((AddStanderd | [ Remove | [ EdtField

Dane




4 Select a state or country from This populates the Select a topic drop down menu with topics
the Select a state or country for the selected state.
drop down menu.

Built-in Standards: Select a State

Standards ]

urningPoi

Buitin Standards List | Custom Standards Lists

Select a state or courkry. Select a topic Select a subject. Select & grade.

[ v [ v | v | |
Gh - Georgia

ot - ohio

Current Standards List [Presentation i

Standards for Current Selection

oo

5 Select a topic from the Select This populates the Select a subject drop down menu with
a topic drop down menu. topics for the selected topic.

Built-in Standards: Select a Topic

¥ TurningPoint - Standards X

Bui-in Standards List | Custom Standards Lists

Select a state or country., Select a topic... Select a subject... Select a grade..,
OH - Ohio | | Academic Content Standards | [SCI - Science 2003 v [k~ kindergarten v

it Standards

Current Standards List: Presentation hd

findergarten ~ Standards far Current Selection
SCLK, - Earth and Space Sciences
[ 5CLK.A - Observe constant and changing patterns of objects in the day and nigh
= & 5CLK. - The Universe
[ SCLK. L - Observe that the Sun can be seen only in the daytime, but the
) 5CLK.E - Explain that living things cause changes on Earth,
(= & SCLK. - Processes That Shape Earth
[ SCLK.2 - Explore that animals and plants cause changes to ther surroun
[ 5CLK.C - Observe, describe and measure changes in the weather, both leng terr
(= & SCLK. - Processes That Shape Earth
[ SCLK.3 - Explare that sometimes change is too Fast to see and sometime
[ SCLK.4 - Observe and describe day-te-day weather changes (.0., toda
1) SCLK.5 - Observe and describe seasenal changes in weather,
[ SCLK.D - Describe what resources are and recogrize some are inited but can be
D SCLK. - No indicators present for this benchmark. v

< I >

oo

Standard: PK - Prekindergarten




6 Select a subject from the This populates the Select a grade drop down menu with grade
Select a subject drop down levels for the selected topic.
menu.

Built-in Standards: Select a Subject

Standards X

Bult-in Standards List | Custom Standards Lists

Select a state or country... Select a topic Select a subject. Select a grade.

[oH-onio v/ [Acaderic Content Standards || [5c1 - sciencs 2008 | [k -Kindergarten v
Current Standards List: Presentation v
findergarten ~ Standards for Cunrent Selection

SCLK. - Earth and Space Sciences
[ SCLK.A - Observe constart and changing patterns of objects in the day and righ
= ) 5CLE. - The Universe \d
(1) SCLK.1 - Observe that the Sun can be seen only in the daytime, but the
I 5CLK.B - Explain that living things cause changes on Earth.
= ) 5CLE. - Frocesses That Shape Earth
(1) 5C1K.2 - Explore that animals and plants cause changes to their surroun:
I 5CLK.C - Observe, describe and measure changes in the weather, both long terr
= ) 5CLE. - Frocesses That Shape Earth
(1) 5C1K.3 - Explore that sometimes change is too fast to ses and sometime
(1) 5C1K.4 - Observe and describe day-to-day weather changes (e.g., toda
(1) 5CLK.5 - Observe and describe seasonal changes in weather.

Q0o

I 5CLK.D - Describe what resources are and recogrize some are limited but can be.
) 5CLK. - Mo indicators present for this benchmark,
< | >

E3

7 Select a grade level from the All of the Standards for the selected state/country, topic,
Select a grade drop down subject, and grade are displayed in the left pane of the
menu. Standards window.

Built-in Standards: Select a Grade

Bul-in Standards List | Custom standards Lists

Select a stake or country... Select & topic. Select a subject Select a grade.

[oH- ohio | [Academic Content Standards || |51 - science zo0s | [K-Kindergarten v

- Grade One
- Grade Two
- Grade Three
- Grade Four —
- Grade Five
6 - Grade Six
findergarten -~ Standards For Current Se.7 - Grads Ssven ~
SCLK. - Earth and Space Stiences
[ SCLK.A - Observe constant and changing patterns of objects in the day and nigh
= O SCLE. - The Uriverse L3
1) SCLK.1 - Obserwe that the Sun can be seen only in the daytime, but the
[ SCLK.B - Explain that living things cause changes on Earth.
= ) SCLE. - Processes That Shape Earth
1) SCIK.2 - Explore that animals and plants cause changes to their surroun:
[} SCLK.C - Observe, describe and measure changes in the weather, both long terr
= O SCLE. - Processes That Shape Earth
1) SC1K.3 - Explore that sometimes change is too fast to see and sometime:
(1) 5C1K.4 - Observe and describe day-to-day weather changes (e.g., toda
1) SC1K.5 - Observe and describe seasonal changes in weather.

Current Standards List: Presentation

|

Q0

I 5CLK.D - Describe what resources are and recogrize some are limited but can be.
) 5CLK. - Mo indicators present for this benchmark,
< | >

E3




8 Select a standard from the You can add the standard to the presentation or slide.
list.

9 Select the right arrow button The standard is displayed in the list of standards in the right-
(>)to assign the standard to a hand pane of the Standards window.
presentation or specific slide.
Standards Window: Standards for Presentation

¥ a TurningPoint - Standards 3]

Buil-in Standards List | Custom Standards Lists

Select a stake or country... Select 4 topic. ., Select a subject. ., Select & grads...
OH - Ohin | [Academic Content Standards | [5cT - Science 2003 | [k -Kindergarten ~
Currert Standards List: Presentation A

finderaarten ~ Standards for Current Selection

SCLK. - Earth and Space Sciences [ 5CLK. 1 - Observe that the 5un can be seen only in th. .
[ SCLK.A - Observe constant and changing pattems of bjects in the day and righ

= W SCLK, - Processes That Shaps Earth
K.2 - Explore thet animals and plants cause changes ta their surroun:
SCLK.2 - Explore that Is and plant: h to the
[} SCLE.C - Observe, describe and measure changes in the weather, both long terr )
= ) SCIK. - Processes That Shape Earth
1) SCLK.3 - Explare that sometimes change is too Fast to see and sometime.
K.4 - Observe and describe day-to-day weather changes (e.g., toda
SCLK. 4 - Ob: d de ibe day-to-d ther ch tod:
1) SCLK.5 - Observe and describe seasonal changes in weather
[} SCLE.D - Describe what resources are and recognize some are limited but can be
D SCIK. - No indicators present for this benchmark. v
< >

Clear &l

[Standard: SCTK.1 - Chserve that the Sun can be seen only in the daytime, bUE the Moon can be seen sometimes ot night and somebmes during the day.

You can remove a standard using the left arrow button (<).

10 Repeat these steps You can assign multiple standards to each slide. You can also
beginning with step 11 to add use multiple Standards Lists.
standards to additional

id If you would like to start over, you can select the Clear All
slides.

button to clear all standards from all slides in the presentation.



11

When you are finished
assigning standards to your
slides, select the Done
button.

Create a Custom Standards List

TurningPoint allows you to create a list of standards to suit your specific needs.

Step by Step Instructions

1

Select Tools in the
TurningPoint toolbar.

To create a Standards List...

The Tools menu opens.

Response Devices

% Turning Reports

Session Management
Standards

Comparative Links
Conditional Eranching
Import from TestingPoint
Parser

Update Parser Template

Boos ik W

Ranking Wizard
WebCT Wizards
BElackboard Wizard
VantagePoint
QuestionPoint
Enterprise Manager

Settings

L HM® A

Upgrade TurningPoint Receiver

Select Standards



2 Select Standards from the The Standards window opens.

Tools menu.
Standards Window
¥ a TurningPoint - Standards 3
" Buit-in standards Ust | Custom Standards Lists
Select a state of country... Select a topic, ., Select a subject. . select agrade. .
v | v | v | v
Currert Standards List: Presentation b
Standards for Current Selection
©
3
add Catagory | [ Add stendard | [ memove | [ Edereld
3 Selectthe Custom Standards The Current Standards List drop-down menu displays the
Lists tab. selected Standards list. The drop-down menu allows you to

choose from the Standards Lists in your Standards folder.The
Load button allows you to import a Standards List to your
Standards folder from elsewhere. The Delete button allows
you to delete a Standards List from your Standards folder.



4 Select the New button.
Standards List.

*'w TurningPoint - Standards

Built-in Standards List | Custom Standatds Lists |

TurningPoint prompts you to enter a new name for the

Custom Standards Window
X

Currert Selection

thiare)

W [ ) [ ] oo ]

Curvent Standards List: Fresentation

(21}

Standards for Current Selection

add Category | [ add standard | [ Remave

][ Edered

Clear Al

Dane

5 Enter a name in the box
provided and select the OK
button.

TurningPoint creates the Standards List in your Standards
folder, displays it in the Current Standards List drop-down
menu, and displays the new Standards List in the left-hand pane
of the Standards window.

Custom Standards Window: New Standards List

TurningPoint

Enter the test for the new standard:

The new Standards List has a top-level category with the same

name as the list.



To add a category or a
standard, complete the
following steps.

a Select the parent category
in which to include the
category or standard you
wish you add.

b Selectthe Add Category or
Add Standard button.

c Enter a title in the box
provided and select the
OK button.

d Repeat steps a—c until you
have added all the
categories and standards
you need.

Categories arrange standards into a hierarchy.

Custom Standards: Select Parent Category

¥ a TurningPoint - Standards

Buit-in Standatds List | Custom Standards Lists

Current Selection

[Parent Category.tps v [Cwew ) [ tesd ][ veere |

Current Standards List: Presentation ~|

[© T

Standards for Current Selection
[ SCL&.1 - Describe the rock cycle and explain that the....

oo

Add Category | [ Add Standard | [ Remove | [ ediFied

Clear Al

[Category: Parent Category

Done

TurningPoint prompts you to enter a title for the
category or standard.

Custom Standards Window: Add Category

TurningPoint

Enter the text for the new categaony:

Cancel

TurningPoint adds the category or standard to the
parent category you selected.

You can delete a category or standard from the list

using the Remove button. You can change the title of a

category or standard using the Edit Field button.



7 When you are finished TurningPoint indicates that you have made changes to the
creating your Standards List, Standards List and asks if you would like to save your changes.
select the Done button.

8 Select the Yes button. The changes are saved to your Standards List file and the
Standards window closes.

Next Steps

To associate standards with slides, follow the instructions in the next section, Assign Standards to
Slides.

Assign Standards to Slides

Assigning standards to slides allows you to use TurningPoint reports to assess participants’
performance on slides relating to the standards.

Before You Begin

You should create or obtain Standards Lists to be assigned to the slides. Find more information in
Create a Built-in Standards List on page 269 or Create a Custom Standards List on page 275.



Step by Step Instructions

9 Select Tools in the
TurningPoint toolbar.

To assign standards to slides...

The Tools menu opens.

Response Devices

Eol- T R A

LM% B

|5 | Turning Reports

Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
YantagePoint
CuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver

Select Standards



10 Select Standards from the The Standards window opens displaying two tabs: Built-in
Tools menu. Standards Lists and Custom Standards Lists.

Standards Window
¥'a TurningPoint - Standards 3]

Buit-in Standards List | Custom Standards Lists

Select a state of country... Select & topic. . Select & subject... Select a grade. ..

& | d | | 5

Current Standards List: Presentation L’

Standards for Current Selection

(21}

add Categary | [ addstandard | [ Remove | [ Edereld

Dane

11 Select either Built-in The remaining steps are the same for both applying a Built-in
Standards Lists or Custom Standards or Custom Standards list.
Standards List.

12 Selectto assign a standard to Standards Window: Assign Standards
the presentation or slide  TurningPeint - Standards =
Uslng the Cur‘rent Selectlon | Bult-in Standards List | Custom Stendards Lists |

Currert Selection

d ro p'd own menu. New List 05_25_07.tps v [ wew ) tead [ ekt |
:‘New List 05. 25 07.tps ¢
e st o ] I o

D New List 05_25_07 Standards for Current Selection
D Math
) Algebra T
D verbal
) Grammar
) Punctuation

Q0

add Category | (_addstanderd | [ Remove | [ EdtFeld

[Categary: Mew List 05_25_07




13

14

15

Select a Standards List in
one of the following ways:

a Select a Standards List
from the Standards folder
using the Current
Standards List drop-down
menu.

b Select a Standards List
from elsewhere using the
Load button.

Select a standard from the
list.

Select the right arrow button
(>)to assign the standard to a

presentation or specific slide.

The categories and standards are displayed in the left-
hand pane of the Standards window.

The Standards List file is copied to your Standards
folder and the standards and categories are displayed
in the left-hand pane of the Standards window.

You can add the standard to the presentation or slide.

The standard is displayed in the list of standards in the right-
hand pane of the Standards window.

Standards Window: Standards for Presentation

" w TurningPoint - Standards @

Current Selection

Englsh tps v [Cwew ) [ wad ][ ook |

Current Standards List: Presentation ~|

Standards for Current Selection
[ Reading

2]+

Add Category | [_add standard | [ Remave I

[Standard: Readng

You can remove a standard using the left arrow button (<).



16 Repeat these steps
beginning with step 11 to add
standards to additional
slides.

17 When you are finished
assigning standards to your
slides, select the Done
button.

Next Steps

You can assign multiple standards to each slide. You can also
use multiple Standards Lists.

If you would like to start over, you can select the Clear All button
to clear all standards from all slides in the presentation.

Several reports allow you to assess participants’ performance on the standards you assigned. Find
more information in Reports on page 341.



Comparative Links

You can use comparative links to compare the responses from several slides on a single slide’s

chart.

This is a sample chart comparing the responses from three slides.

Chart with Comparative Links

Tasty

Yucky

o 50%

50%

5%

L] A%
=] 3%

s

The bars are grouped by answer. Each answer’s bars include the results for the current slide at the
left (or top, depending on the chart type), then the results for each linked slide in the order that the

links are assigned.

A slide can contain up to three comparative links, so you can compare up to four questions.
Generally, each question you compare should have the same number of answers, since the first
answer in the answer region is compared to the first answers on the linked slides, the second
answer to the second answers on the linked slides, and so on.

This section describes how to:

Set Up Comparative Links



Set Up Comparative Links

Set up comparative links using the Comparative Links window, available from the Tools menu in the
TurningPoint toolbar.

Before You Begin

Before you set up a comparative link, first create the slides you would like to be compared. A slide can
contain one to three comparative links, so you can compare up to four questions.

Generally, the slides being compared should each have the same number of answers.

For the slide on which the comparison will be displayed, use a vertical, horizontal, offset, or donut
chart. Comparisons cannot be displayed using 3D pie or distributed pie charts.

The slide on which the comparison will be displayed should come after the slides it is being compared
to, so that the results of those slides are available for display.



Step by Step Instructions To create a comparative link...

1 Select Tools in the The Tools menu opens.

TurningPoint toolbar.

Response Devices

Select Comparative Links

e B R

-k

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
YVantagePoint
CQuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver




2 Select Comparative Links The Comparative Links window opens.
from the Tools menu.

Comparative Links Window

TurningPoint - Comparative Links

Selected Slide

“% Link to Slide:

Create Link

Comparative Slide Linked Slide

The selected slide will display the results of itself and any linked slides during a SlideShow. 4 slide may only contain three links
at once,

I

3 Select the slide to include the Comparative Links Window: Select Slide
comparison in the Selected TurningPoin

Slide drop-down menu.

Selected Slide

Whers Is the capital of Ohio

Where is the capital of Pennsyhvania?
Whers Is the capital of the United States?
Where is the capital of New Mezica
Where Is the capital of Wirginia?

What is the capital of Tennessee? d
Which ona is the United States Flag?

What is the capital of Michigan? o

“% Link to Slide:

R

Comparative Slide

The selected slide will display the results of itself and any linked slides during a SlideShow. 4 slide may only contain three links
at once,

I




4 Select a slide to compare Comparative Links Window: Link to Slide

with in the Link to Slide drop- “a TurningPoint - Comparative Links 3
down menu. Selocted Side [2 Where s the capialof Ohio 5]
“ Link to Slide: v

f Ohio
3 Pennsylvania?
4 Wihere is the capital of the United States? H
5 Wihere is the capital of New Mexica
Comparative Slide & wihere is the capital of Virginia?

7 Wihat is the capital of Tennessee?
& wihich one is the Uinited States Flag?
9 Wihat is the capital of Michigan?

5 Select the Create Link button The link is displayed in the list of comparative links.

to create the comparative
link.

6 Select the Done button. The Comparative Links window closes. TurningPoint adds the
comparative link to the slide. (The comparison will not be
visible until you run the presentation session and collect data.)

Next Steps

When you run your presentation session, the charts in slides containing comparative links will
automatically show comparisons of the data for the linked slides.

You can add additional comparative links by repeating these steps. You can add up to three links to
a slide.

You can delete comparative links by selecting the link in the Comparative Links window and
selecting the Break Link(s) button.



Conditional Branching

Conditional branching allows you to control the order of slides in your presentation based on the
responses received from the audience.

For example, at the beginning of your presentation you might ask the participants to vote whether
you’ll cover topic A or topic B. Depending on the results of the vote, the presentation will skip ahead to
the slides for topic A or topic B.

Or, you might ask a question covering a specific subject area to assess whether the participants
understand the subject. If most of the participants respond correctly, you can skip ahead to the next
section of material.

This section describes how to:

Set Up Conditional Branching

Set Up Conditional Branching

You set up conditional branching by defining a condition, which, if satisfied, advances to the slide you
specify. Each condition consists of a comparison. The number or percentage of responses for a
particular answer (or all correct answers) is compared with a specific value, or with the majority of
responses for that slide.

Set up conditional branching using the Conditional Branching window, available from the Tools menu
in the TurningPoint toolbar.

Before You Begin

Before setting up conditional branching, you should create the slides for the branches of your
presentation and plan their order.



Step by Step Instructions

1

Select Tools in the
TurningPoint toolbar.

To set up conditional branching...

The Tools menu opens.

Response Devices

Select Conditional Branching

Hee & &k W

%P B

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
VantagePoint
QuestionPoint
Enterprise Manager

Settings

Upgrade TurningPoint Receiver




2 Select Conditional Branching The Conditional Branching window opens.
from the Tools menu.

Conditional Branching Window

& TurningPoint - Conditional Branching

Conditional Branching Rules

Select 5 Slide:

Add Delete Rename

Conditional Branching Rules

Rule Mame
OR Condition
Conditional Branching Rule Description
3  Select the slide where the You will specify where to branch (which slide to show next)
branch will begin in the based on the outcome of the selected slide’s polling.
Selected Slide drop-down
menu. Conditional Branching Window: Select Slide

& TurningPoint - Conditional Branching

Conditional Branching Rules

Select a Slide

2 Where is the capital of Ohio ~
3 Whers is the capital of Pennsylvania? =
4 Where is the capital of the United States?
5 Whers is the capital of New Mezica

& Where is the capital of Yirginia?

7 What is the capital of Tennessse?

& Which one is the United States Flag?

3 What s the capital of Michigan? ha

AND Condition

OR Condition

Conditional Branching Rule Description




Chapter 6: Tools

4 Select Add to add a The condition appears in the Conditional Rules box with a
condition. default name of New Rule.

Conditional Branching Window: New Rule

a TurningPoint - Conditional Branching,

Conditional Branching Rules

Select aside
|2 where is the canital oF oo v

Condktional Branching Rules

Rule Mame

niew Rule 1

AND Conditian
GR Condtion

[ asd | [ pelste | [ Rename |

Conditional Branching Rule Description
1F "Condirion’ then go to “Slide Selection”

5 Optionally, rename the A box will appear for you to enter the new name of the rule.
condition by selecting Select OK. The name has been changed.
Rename.

Conditional Branching Window: Rename Condition

= TurningPoint - Conditional Branching

Condtional Branching Rules

Select a slde
|2 where is the capital of Ohio -

Condltional Branching Rules

Rule Hame
New Rule

AMD Condition

Rename Conditional Branching Rule

Conditional Branching Rule Descrip)

If "Condition" then go to "Slide ¢

Enter new rule name

292 Turning Technologies



Optionally, create multiple Select AND Condition to link a conditional branching item to the

conditions for a slide by previous item to specify that both conditions should be met.
selecting AND Condition or Select OR Condition to link a conditional branching item to the
OR Condition as Logical previous item to specify that either condition can be met.
Operators.

Conditional Branching Window: And/Or Condition
fa TurningPoint - Conditional Branching, g|

Conditional Branching Rules |

Select a Slide
|2 Where is the capital of Ghio v]

Conditional Branching Rules

FRule Name

OR Condition

add | [ pelete ] [ Renzme

Canditional Branching Rule Description
TF "Condition]' then go ko "Side Selection”

Note You can link more than two conditional
branching items for one slide.




Define all conditions in the
Conditional Branching Rule
Description by selecting the
appropriate link.

a Condition - choose from
the number or percentage
of responders that must
choose the same
response to satisfy the
condition.

Find some examples of conditions in the examples following
these instructions on page 296.

Choose from Percentage of Response, Number of
Responders, or Majority Rules.

Conditional Branching Window: Choose Condition

Add New Rule 3

Chooze a Rule

Percentage of Responzes
Mumnber of Responders
b ajority Fules

2k l [ Cancel

This displays the Compound Rule Condition Box with
up to three Conditional Rules that must be met:
Comparison Operator, Value, and Selected Answer.

Conditional Branching Window: Compound Rule

Condition
Compound Rule Condition [g\
Please complete the Conditional Rule for the Compound Condition
"Comparizon Operator’' "Value" percent of responses are answer "Selected Anzwer"
Delete Rule Change Rule

Comparison Operator - Determines if the condition
for the branch item has been met. You can choose
from:

greater than (>)
less than (<)

equal to (=)



b Slide Selection - choose
the slide you want to be
displayed when the
condition is fulfilled.

c Select Next Slide to
choose the slide you wish
to go to if the condition is
not met.

Answer Selection

Anzwers:

Total Correct
1 Columbuig

2 Cincinnati

3 oungztown
4 Cleveland

not equal to (<>)
greater than or equal to (>=)
less than or equal to (<=)

Value - Determines the value or percentage to be
compared to in the next step. For Number of
Responders, enter a number of responses (from 0 to
the total number of participants). If you choose
percentage, enter a percentage of responses (from 1 to
100)

Selected Answer - Determines what answer must be
selected to make the condition true.The number or
percentage of responses for the selected answer will
be used in the comparison. You can choose any of the
answers on the slide., The condition uses the number
of responses for that selected answer choice.

Conditional Branching Window: Slide Selection

X]

]9

l [ Cancel

You can branch to any slide in your presentation.



8 Repeat steps 4 and 5 to add See examples of how to add multiple conditions to a slide on
additional independent page 296.
conditions to same slide.

9 Select the OK button in the
Conditional Branching
window when you are
finished adding all conditions
to the slide.

For Example

The examples below show you how to add a variety of multiple conditions, both linked and
independent, to a slide.

Example 1 illustrates multiple conditions linked together. All three conditions must be met for
TurningPoint to branch to the designated slide listed in the third condition.

Example 1
" 5 5 e 5
& TurningPoint - Conditional Branching, &‘
Conditional Branching Rules \
Select a Slide
|2 Where is the capital of Ohio ~
Conditional Branching Rules
AND Condition
OR Condition
add | [ pelte | [ Rename
Conditional Branching Ruls Description
1f "Mumber of Responders” and “Wumber of Responders” and "Percentane of " then go to
"4 \Where is the capital of the United States?"
| N i |

During the presentation, if one participant selects Cincinnati AND if one participant selects
Cleveland AND if less than half select Youngstown, then the presentation continues with slide 4.



Examples 2.1 and 2.2 illustrate two independent conditions added to the same slide.

Example 2.1

X

& TurningPoint - Conditional Branching

| [ Conditional Branching Rules

Select a Slide

|2 where is the capital of ohio

Conditional Branching Rules

Rule: Mame

Ohio Xico
Ohia to Virginia
AND Condition
OR Condltion

[ add ][ oekete ][ Rename

Conditional Branching Rule Description
TF "Percentade of " then 0o ko "Slids Selection”

Example 2.2

& TurningPoint - Conditional Branching

| [ Conditional Branching Rules

Select 5 Slide:

2 where is the capital o ohio

Conditional Branching Rules

Rule Name:
Ohia to Naw Mexico
Ohia to Virginia

AND Condition
OR Condition

[ add | [ Dpeete | [ Rename

Conditional Eranching Rule Description

IF "Maiority Rules” then go to "6 Where is the capital of Wirginia?"

During the presentation, if all participants answer correctly, the presentation continues with slide 5.
Alternatively, if the majority of participants select Cleveland, the presentation continues with slide 6.



Examples 3.1 through 3.3 illustrate both linked and independent conditions added to a single slide.
Example 3.1

& TurningPoint - Conditional Branching

Conditional Branching Rules
v

Selact & S
[2 Where s the capital of ohia

Conditionl Branching Rules

Rule Nam¢

Ohio ko Mew Mexica
Ghia ka Yirginia AND Condition
OR Condition

| [ pelete ] [ Rename

[ s

Conditional Eranching Rule Description
If "Mumber of Responders” and "Number of Responders” and "Percentage of " then go to

"4 Where is the capital of the United Skabes?”

Example 3.2

a TurningPoint - Conditional Branching

Conditional Branching Rules

Select a Slide
|2 Where is the capital of Ohio

Conditional Branching Rules

Rule Name

Ohia b United States
©hia to Virginia T
OR Condltion

] [_pelete ] [ Rename

[ s

Conditional Branching Rule Description
If "Percentas of " then 0o to "5 where is the capital of New Mexico”




Example 3.3

" & TurningPoint - Conditional Branching E‘

Conditional Branching Rules \
Select a Slide
|2 Where is the capital of Ohio ~
Conditional Branching Rules
Rule Name
Ohia to United States
I
AND Conditien
OR Condion,
add | [ pelte | [ Rename
Condtionsl Branching Rule Description
If "Msiority Rules’ then go ko "6 Whers is the capital of Virginia?"
| B = |

During the presentation, if all participants answer correctly, the presentation continues with slide 5.
Alternatively, if the majority of participants select Cleveland, the presentation continues with slide 6.
Alternatively, if one participant selects Cincinnati AND if one participant selects Cleveland AND if less
than half select Youngstown, then the presentation continues with slide 4.

Next Steps

When you run your presentation session, the slides set up for conditional branching advance to the
slide you specified if the condition is met.

You can remove a condition by selecting it in the list in the Conditional Branching window and
selecting the Remove button.



Parser Documents

The TurningPoint Parser can import two kinds of documents:

an XML document

a Microsoft Word document (.doc)
To be imported by the TurningPoint Parser, these documents must be formatted in the proper way.
The following sections describe the proper formats for documents imported by the Parser.

This section describes how to:

Format XML Documents

Format Word Documents



Format XML Documents

The following is a basic shell of the XML document type accepted by the TurningPoint Parser:

<slides count="" id="">
<slide id="" type="" multiresponse="">
<question alias="" filename=""
imageposition="" />
<topic id="" />
<answers>
<answer alias="" value="" filename="" />
</answers>
</slide>
</slides>

Each element is described below, along with an example and an explanation of the attributes.

Note Remember that the following characters are
reserved in XML: <> & '

Use the XML entities for these characters
(¢1t; &gt; &amp; &apos; &quot;
respectively).

slides The slides element is the top-level element in the XML
document and contains all the information TurningPoint
requires to create the interactive presentation. The slides
element contains a number of s1ide elements.

<slides count="1"” id="86FF9DB9”>

Attribute Description

count The total number of slide elements in
the presentation.

id An optional attribute that contains a
unique identifier for the group of
slides.

slide Each s1ide element contains the question and answer

information for a single slide.



<slide id="E15F45B” type="D”"” multiresponse="1">

Attribute

Description

id

type

multiresponse

An optional attribute that contains a
unique identifier for the slide.

Defines what type of slide to create
using a single-letter code. The
following types are accepted:

Q = standard question slide

P = picture slide

D = demographic slide

S = speed scoring slide

F = fill in the blank slide (vPad and
Web vPad only)

E = essay slide (vPad and Web
vPad only)

M = moment to moment slide

An optional attribute that contains the
number of responses allowed per
keypad for the slide. Accepted values
are 1-10.

question The question element contains the question information (as
attributes) and the question text (as content).

<question alias="Gender?” filename=""
imageposition="">
What is your gender?

</question>
Attribute Description
alias An optional attribute that contains an

alias for the question.



Attribute Description

filename An optional attribute that contains a
filename for a picture that can be
included with the question.

imageposition An optional attribute that sets the
question picture position. The
following are acceptable values:

L = Left
R = Right
F = Full

The topic element contains the question topic.
<topic id=""></topic>

Attribute Description

id An optional attribute that contains a
unique identifier for the topic.

The answers element contains a number of answer elements.

<answers>

Each answer element contains answer information (as
attributes) and the answer text (as content) for a single answer.

<answer alias="" value="" filename="">
Female
</answer>
Attribute Description
alias An optional attribute that contains an

alias for the question.



Attribute

Description

value

filename

An optional attribute that contains a
value for the answer. Valid answer
values are “Correct”, “Incorrect”, or a
point value negative 10,000-10,000.

An optional attribute that contains a
filename for a picture that can be
used in place of the answer text on
the slide. This attribute is used only if
the slide type attribute is set to “P”.



Format Word Documents

To create a Word document to be imported by the TurningPoint Parser, you must create an outline
using the heading styles built into Word. You can apply the heading styles using the drop-down menu
in the Formatting toolbar, or in the Styles and Formatting pane available through the Format menu.

Each question must use the “Heading 1” style. The question is followed by several answers on
separate lines using the “Heading 2” style.

In addition to the question and answer text, you can use optional TurningPoint tags to control other
settings. Each TurningPoint tag must use the “Heading 3” style. Tags occur at the start of the outline
(for tags that apply to the entire presentation) or on the lines immediately following a question or
answer (for tags that apply only to a specific question or answer). A tag is formatted in the following
way:

<tag>value

All tags are optional. If omitted, the slide will default to a standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of The number of slides in the
outline. presentation.

<d>  Start of Contains the Session ID (if at the
outline or start of the outline) or topic ID (if
followinga  following a question).
question.

<a> Followinga Contains an alias for a question or
question or  answer.
an answer.



Tag Location Description and Allowed Values
<t> Followinga Defines what type of slide to create
question. using a single-letter code. The
following types are accepted:
Q = standard question slide
P = picture slide
D = demographic slide
S = speed scoring slide
F = fill in the blank slide (vPad
and Web vPad only)
E = essay slide (vPad and Web
vPad only)
M = moment to moment slide
<f> Followinga The filename of a picture file. If the
question or  tag follows a question, the picture
an answer.  will be added next to the question
text on the slide. If the slide type is
“P” and the tag follows an answer,
the picture will replace the answer
text on the slide.
<n> Followinga Contains the question picture
question. position. The following are
acceptable values:
L = Left
R = Right
F = Full
<m> Followinga Contains the number of responses
question. allowed per keypad for the slide.
Accepted values are 1-10.
<p> Followinga Contains the question topic.
question.
<v> Following Contains a value for the answer.
an answer.  Valid answer values are “Correct”,

“Incorrect”, or a point value
negative 10,000-10,000.



Import Slides

TurningPoint can automatically create TurningPoint slides from Microsoft Word files, XML files or
TestingPoint.

Using this feature of TurningPoint provides a quick way to create a number of slides, and it is also
beneficial if you already have question and answer data in another form that you would like to
transform into TurningPoint slides.

A simple slide presentation can be created by importing a an XML document or Microsoft Word
document using the TurningPoint Parser. Alternatively, you can import question and answer data from
TestingPoint.

This section describes how to:

Import Slides with the TurningPoint Parser

Import Slides from TestingPoint

Import Slides with the TurningPoint Parser

The TurningPoint Parser is located in the Tools menu and allows you to automatically create slides
from Microsoft Word or XML files.



Step by Step Instructions To import slides with the TurningPoint Parser...

1 Select Tools from the The Tools menu opens.
TurningPoint toolbar.
Select Update Parser Template

Response Devices

%2 Turning Reports

Session Management 4
Standards

Comparative Links

Conditional Branching

Import from TestingPoint

Parser

Update Parser Template

e s 5 R E

Ranking Wizard

WebCT Wizards L4
Blackboard Wizard

VantagePoint

QuestionPoint

Enterprise Manager

tRA® B

Settings

41 Upgrade TurningPoint Receiver
2 (Optional) Select Update The slides you import will be created with default
Parser Template. characteristics that may not match your settings. You can use

the Update Parser Slides command to update the imported
slides to match your settings.



3 Select Tools from the
TurningPoint toolbar.

The Tools menu opens.

Response Devices

Select TurningPoint Parser

eo - ML VA 7

St % FE

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
YantagePoint
CuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver




4  Select TurningPoint Parser.

5 Navigate to the file you would
like to import (.doc or .xml)
and select it.

6 Select the Open button to
continue.

7 Select the Yes button to add
the slides to the current
presentation, or select the No
button to create a new
presentation.

Next Steps

An open file window appears asking you to select the file to
import.

Open File Window

Open a TurningPoint Import Document

Look in: ‘_} Sessions v| ¢ ? s FE

\ |)Backup

23 IZ)Real-Time
Iy Fecent
Drocuments

@

Desktap

My Documents

9

hy Computer

‘_;‘] File hame: “ w | { Open 1
b

My MNetwork | Files of type: ‘ [%.xml" doc;” dacx;” xls] ~ | [ Cancel ]

A dialog appears asking whether you would like to add the
slides to the end of the current presentation or create a new
presentation.

TurningPoint builds the slides from the file. If there are many
slides, this may take some time.

The slides imported by the TurningPoint Parser are normal TurningPoint slides, so you can take
advantage of any the TurningPoint customizations you would like to make on them.



Import Slides from TestingPoint

TurningPoint can insert files from TestingPoint and create slides based on them. TurningPoint retains
the features used in the TestingPoint files.

Step by Step Instructions To import slides from TestingPoint...

1 Select Tools from the The Tools menu opens.
TurningPoint toolbar.
Select TestingPoint

Response Devices

% Turning Reports

Session Management b
Standards

Comparative Links

Conditional Eranching

Import from TestingPoint

Parser

Update Parser Template

Boos ik e

Ranking Wizard

WebCT Wizards k
BElackboard Wizard

VantagePoint

QuestionPoint

Enterprise Manager

Settings

L HM® A

Upgrade TurningPoint Receiver




2 Select Import from An ‘Import a TestingPoint Document’ window opens allowing
TestingPoint. you to select the file to import.

Import a TestingPoint Document Window

Import a TestingPoint Document

Look in:

TestingPoint bxlt

My Recent
Drocumets

@

Desktop

~

ty Documents

9

y Computer

File name: ‘ TestingPoint b | { Open 1

My Network | Files of type: ‘ TeslingPoint Test [*.txl] w | [ Cancel ]

3 Navigate to the file you would
like to import and select it.

4  Select the Open button to A dialog box opens allowing you to choose to add the slides
continue. to the end of the current presentation or create a new
presentation.

Import Dialog Box

TurningPoint

\:.’r/ tould you like ta add your slides ta the end of the active presentation? If Ko is selected a new presentation will be created.

Yes
5 Select the Yes button to add TurningPoint builds the slides from the file. If the file contains
the slides to the current many slides, this may take some time.

presentation, or select the No
button to create a new
presentation.



Where Do I Go From Here?

This chapter has demonstrated how to use tools with TurningPoint. After you present a session, you
are ready to run a presentation.

Chapter 7: Run Presentations describes the process of running a presentation.
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Run
Presentations

After you have created the slides and objects discussed in Chapter 3: Creating and Saving Slides,
you are ready to run an interactive presentation. The process of running a presentation requires a few
preliminary steps and offers some options and tools that this chapter demonstrates for you.

Each time you run a presentation, TurningPoint creates a unique session. A session is made up of
data pertaining to the response devices, the participants in the audience, and the responses of the
participants. This data typically saves to the computer that is running the presentation.

To run a presentation:

Establish the settings for gathering and storing responses on the computer that runs the
presentation. The settings are made up of the results data, which may need to be reset, the
response devices, and the Participant List. Optionally, the settings could include preferences for
the Response Grid, especially if infrared keypads are used.

Run a session. A presentation session feels similar to running a typical PowerPoint slide show, but
as you present, the Showbar is initially available at the top of the screen during interactive slides.
The Showbar can be moved to any location on the screen by selecting the appropriate icon. The
Showbar allows you to open and close polling, view polling status, and view the response data in
a variety of ways.

Save a session. You can save the results of your interactive presentation and generate reports
through TurningPoint to evaluate the audience’s responses. You will want to save the responses
provided by your audience for each presentation session.

You can perform test runs or present the completed presentation to your audience. Behind the
scenes, TurningPoint gathers, tallies, and stores the responses from your audience. You can choose
to share the results of the session with the audience or keep them confidential.



Recall the five steps to presentation success. As depicted in the following diagram, running a
presentation session is the fourth step when using TurningPoint.

| 3

Install TurningPoint

!

Five Steps to Success

e A
Enter question text... e ®
- s see
S A
= = =
Step Two: Step Three:
Install Devices Create
Step One: and Manage Participant List
Create Slides Settings
ﬂ —
Whre i the :ar;ulal M glm a /,
—— (Optionally)
— Manage Tools
FlSS
Step Four: (Optionally) Run Reports
Run Presentation

!
N =

{Optionally) Export Data
Step Five:
Save Session

This chapter describes the following activities to help your presentation run smoothly:

Run an interactive presentation using the Slide Show functionality. Find instructions for running
a presentation in Run a Presentation on page 317.

Control the presentation using the Showbar. Find instructions for using the Showbar in Run the
Slide Show on page 324 and View Polling Status on page 328.

Monitor the audience participation. Find instructions for monitoring in View Polling Status on
page 328 and Use the Participant Monitor on page 330.



Run a Presentation

You run an interactive presentation session using PowerPoint’s Slide Show functionality.

You control the presentation session by opening and closing polling. Polling is the mechanism by
which TurningPoint accepts and tallies the responses provided by the audience using response
devices.

This section describes how to:

Establish the Presentation Settings

Run the Slide Show

View Polling Status

Use the Participant Monitor

Add Slides During a Presentation Session

Data Slicing (View Results by Question)

Establish the Presentation Settings

The presentation settings consist of the results data and Participant List to be used, which are
important items to check before running the presentation.

Prior to starting a presentation session, you must perform the following steps:

Clear any previous session results.
Identify the Participant List to be used.

This section explains how to perform these steps. It also demonstrates how to create the settings for
the Response Grid, an option especially helpful to sessions with infrared keypads that gives
participants confirmation that their responses were received.

Before You Begin

Chapter 4 discusses the response devices you set up before you begin. Find information on getting
the response devices ready in Chapter 4: TurningPoint Device and Settings Management.



If you are using Response Card devices the vPad or the Web vPad response device software, you
can use the Polling Test feature to test TurningPoint’s ability to successfully receive the response.
Find information on Polling Test in Chapter 4: TurningPoint Device and Settings Management.

If you want to track responses, you must have also created a Participant List using the Participant
List Wizard. Without a Participant List, the session collects anonymous responses. Find information
on participant lists in Chapter 5: Track Participants and Teams.

Step by Step Instructions

1 From the PowerPoint menu,
select File > Open.

2 Select the TurningPoint
presentation to be used, and
select the Open button.

3 From the TurningPoint
toolbar, select Reset >
Session.

To create the settings for the presentation session...

A window opens and displays the available files.

The file’s contents are visible in the PowerPoint window. You
can use the TurningPoint toolbar to clear any previous results
data and identify the use of response devices and a
Participant List.

Reset Sessions

. ™ __.‘
2 & l
Reset Continue 5

K Prior Session 5e

f]  Session
]| Current Slide
Ty | AllSlides

Prior to starting the presentation session, you must clear all
prior audience responses that are stored in memory.

If you select Reset > All Slides, new data is appended to the
end of the session without resetting the entire session. If you
select Reset > Current Slide, you remove values for the
current slide without removing the data from the session.

TurningPoint displays a window instructing you to wait until all
responses have been cleared before continuing with your
slide show.



4 Optionally, from the
TurningPoint toolbar, select
the Response Device menu
and select an option for
testing the presentation.

5 From the TurningPoint

toolbar, select the Participant

List Button and choose the
Participant List to be used

Response Device Selection

Response Devices o

Response Devices
Keyboard Keys 0-9
Simulated Data

Response Devices is the default setting. TurningPoint allows
you to select how responses will be provided during the
presentation. Your choices are:

Response Devices—a response device will be used
during the presentation. The response devices must have
been set up as outlined in Chapter 4: TurningPoint
Device and Settings Management.

Keyboard Keys 0-9—you will provide input to the
presentation using the keyboard, keypad, or number
keys.

Simulated Data—TurningPoint provides random
responses to the presentation. TurningPoint determines
the number of responses to provide based on the number
of expected devices designated in settings. i.e. If you
enter expected devices as 100, TurningPoint will provide
up to 100 responses to each question in your
presentation. Find more information on expected devices
in Manage Response Device Settings on page 171.

Note Always use the Response Devices default
setting for an actual presentation. Select
Keyboard Keys 0-9 or Simulated Data when
testing a presentation.

A task pane appears to the right listing the available Participant
Lists. The default Participant List is shown as Anonymous.
TurningPoint shows all Participant Lists available in the




Participants folder. Participant lists located on the desktop or
in other folders are not displayed.

Participant List Selection

TurningPoint 2008 - Participant Lists ¥ X

Zurrent Participant List:
[fanonymous) |

Awailable Lists:

[&ne
[ALt
Historic Men
Partic 1
Partic 2
Presidents
Tearms

Import & List ] [ Use Selected List

The default setting is Anonymous or Auto. If Auto is selected,
response Device IDs and participants’ choices are collected
without a participant list. If Anonymous is selected, only
participants’ choices are collected.

Note You can change the default participant list
setting to Auto or Anonymous using the
Default Participant setting, a presentation-
level setting. Find more information on
modifying settings in TurningPoint Device
and Settings Management on page 153.




Run a Presentation

6 Select Use Selected List TurningPoint will use this list when you run your interactive
button. presentation.

Participant List Selection: Use Selected List

Use Selected List

TurningPoint User Guide 321



7 From the TurningPoint
toolbar, select Tools >
Settings (Hint: it looks like a
pair of eyeglasses). In the
window, select the
Presentation from the
Settings Hierarchy.

The TurningPoint Settings window opens.

Settings Window

© o TurningPoint - Settings =1

Settings | Paling Test

Response Device “~|| Answer Settings ~
Presentation

=1 Where & the capital of Ohic| || Answer Bullet Farmat Decimal Periad
1 Columbus
2 Cincinati | Chart Settings
3 Youngstown Autn Scale Charts True
4 Cleveland Chart Colers Caler Scheme

= 2 Where is the capital of Perr || (o 2 Py
1 Pittsblrgh Chart Value Farmat 0%
2 Harrishurg Standard Chart Type vertical
3 Scranton
4 Philacielphia Competition Settings

=3 Where s the capital of the L |
1 Washingtan State Default Humber of Teams s
2 Washington, P4 Include Non-Responders Falsa
3 Washingtan D.C. Maximum Resporders s
4 Washington, NC Participants In Leaderboard 5

= 4 Whers is the capital of New || Teams In Leaderboard s
1 Albuguergue
2 SantaFe | Misc
j ED;\SA;ZEDS | d-In shways lnaded False

< S Correct Point Valug 100 al

(® Common Settings (O All Settings.

Use these settings to establish the settings for the entire
presentation. You can establish the settings for a specific
slide or answer by selecting the Slide or Answer, respectively,
from Settings Hierarchy.(Find more information about
modifying settings in TurningPoint Device and Settings
Management on page 153.)

If infrared keypads are used, it is recommended that you use
a Response Grid, which gives participants confirmation that
their responses are received. The Response Grid is
unnecessary with radio frequency, vPad and Web Pad
devices because confirmation displays right on the device.
The following settings affect the presentation and style of the



Response Grid that can be shown during an interactive slide
show.

Response Grid

‘ ” H " H - H - H a H s H e H Y H ° ‘
‘ 3 H - H - H - H - H ¢ H ° ‘

Note A Response Grid is specifically
recommended to use with infrared keypads
to give participants confirmation that their
responses are received. Other options for
tracking responses, such as a Response
Counter or Response Table, are located in
the Insert Objects menu. Find information on
these objects in Add Objects on page 128.

These settings affect what is displayed in each box of the
Response Grid.

Display Device IDs—select True to include the devicelD
field in the Response Grid.

Display Participant Names—select True to display the
participant’s name in the Response Grid.

Display Device Numbers—select True to display the
response ID number.

These settings affect how the Response Grid is displayed.

Grid Opacity—enter a percentage to identify how opaque
the Response Grid should be when opened.

Grid Position—choose a selection from the menu to
identify where the Response Grid should be positioned on
the screen. The selections include Top, Bottom, Left,
Right, Center, TopLeft, TopRight, BottomLeft, and
BottomRight.



Grid Rotation Interval—enter the number of seconds
per interval the Response Grid takes to rotate through
responses, for when there are too many participants to
fit in one grid.

Grid Size—identifies how wide and tall the Response
Grid should be when displayed on the Response Grid.
The height and width are measured in pixels. The
default setting is 800 x 600 (or full screen).

Use Scheme Colors—Determines if Scheme Colors, as
established in Chart Settings, or Custom Colors will be
displayed on the Response Grid.

Next Steps

After establishing the settings, you are now ready to run the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your interactive presentation. TurningPoint
accepts responses provided by your audience, presents the results of the responses, and stores the
responses in memory. You either save the responses to a file or clear the memory.

Before You Begin

To run the slide show, you must first perform the steps listed under Establish Presentation Settings
to create the settings for your presentation session.

Step by Step Instructions To run the interactive presentation...

8 From the PowerPoint ribbon, This displays a menu of slide show options.
select the Slide Show tab.



9 In the Start Slide Show
section, select From the

Beginning.

The first slide of the presentation is shown. TurningPoint
displays the Showbar in the top right corner of the screen. The
Showbar is a toolbar that provides activation buttons for polling,
monitoring, and viewing responses during the slide show.

Showbar
EE s (LB [l e T - v FESpONSEs! uset Feadback: polling:
% 8 Wil @ D B OO 0 opEn

Right-click on the Showbar and move your cursor across the
Showbar to display each command’s name. To activate the
command, you can select the Showbar icon or use the
respective Fn key on your keyboard. Use the commands on the
Showbar as follows:

|

%

B

F9-Show/Hide
Showbar

F2-Toggle
Results

F3-Data Slicing

F6-Show the
Original Chart

F4-Repoll
Question

Closes the Showbar for the
duration of the current
presentation session.

Changes the values displayed on
each chart. The values can be
represented as either numbers or
percents.

Shows the responses on the chart
for the portion of the audience who
chose a certain response on
another question.

Use this command after using the
Toggle Results or Data Slicing
commands to return the chart to its
appearance when it was first
created.

Clears the responses and accepts
new responses from the audience
for the currently displayed
question. Both the original
responses and the new responses
are stored in the session file.



F7-Show the
Response Grid

F8-Show Non-
Response Grid

F10-Go to Next
Slide

F12-Display
Participant
Monitor

F5-Insert Slide

Display
interactive
results

Press for
moveable
Showbar

Opens a Response Grid on the
screen allowing you to see which
participants have responded to the
question.

The size, location, visual display
and contents of the grid are
controlled using the controls in the
Presentation Settings. Find more
information about settings in
Establish the Presentation
Settings on page 317.

Opens a Response Grid on the
screen. As each participant
responds, their response box is
removed from the grid.

Advances the slide show to the
next slide.

Opens the Participant Monitor.
Find more information in the Using
the Participant Monitor section.

Opens a drop-down menu allowing
you to select the slide type to be
inserted into the presentation.

Expands the Showbar to display
the responses, user responses,
and polling status.

Allows the Showbar to moved
anywhere on the Screen.



10 Click the mouse to control the The control of each slide will vary slightly depending on the
progress of the slide show. objects you choose to insert when you create the slides. Find
information on slide objects and their behavior in Add Objects
on page 128.

Optionally, you can press the Spacebar, Enter, or Right-Click
and select next on the shortcut menu to control progress.

a Open polling. Polling will TurningPoint receives responses when polling is open.
automatically open when
you display a slide. Polling Open
tESpOnSEs: user Feedback: polling:
0 1] open
b Click a second time to No responses are accepted when polling is closed.
close polling and display
the results. Polling Closed
responses: user Feedback: polling:

0 0 closed

c Click again to advance to
the next slide.

Note To advance slides, you may use any method
PowerPoint allows, such as clicking the mouse
or pressing the space bar, arrow keys, or Enter

key.
11 Click at the end of the slides If you exit the program, TurningPoint prompts you to name and
to exit from the Slide Show save the session results to a file. The default location is My
(or optionally, press the Esc Documents > TurningPoint > Sessions. TurningPoint adds the
key). date and time to the file name.

For every session, TurningPoint automatically creates a backup
copy and stores it at My Documents > TurningPoint > Sessions
> Backup.

You can set TurningPoint to automatically delete old backup
sessions using the Backup Maintenance setting, a presentation-
level setting. In the Backup Maintenance field, enter the number
of days you want to keep files. TurningPoint will eliminate
backup sessions created before that time. Find more



information on modifying settings in TurningPoint Device
and Settings Management on page 153

Tip  Store your session file in the Sessions folder
suggested by TurningPoint to allow the session
file to be used again by TurningPoint to restart
sessions or generate reports. Find information
about reports in Reports on page 341.

View Polling Status

TurningPoint provides three mechanisms to see how many participants have responded to the
question when polling is open. You can expand the Showbar to see how many responses are
received. You can display a Response Grid. Or, you can open the Participant Monitor to see the full
details of the audience response.

This section describes using the expanded Showbar and the Response Grid to view participant
results. Find more information about the Participant Monitor in Use the Participant Monitor on
page 330.

Step by Step Instructions To view the polling results...
1 On the Showbar, select The Showbar expands to display three additional regions that
Display Interactive Results. show the polling status. After everyone submits a response,

the number in the Responses column equals the total number
of participants.

Showbar Expansion

| responses: user Feedback: polling:
|Q| - 1 1 Closed

i-Display Expands the Showbar to display the
interactive responses, user questions, and polling
results regions. The Showbar also becomes fully

visible on the slide.



Responses Identifies the number of responses received
from the audience. This area is not visible
when the slide show starts.

User With vPad devices, shows the typed
Feedback questions. With ResponseCards, shows the
presses of the question mark key.

Polling Identifies whether polling is open or closed.
The background of this region is green
when polling is open and red when closed.
This area is not visible when the slide show
starts.

This step may meet all your needs for viewing polling status.
You also have the option to use the Response Grid explained in
step 2, especially if you use infrared keypads.

Note A Response Counter or Response Table are
two other options for viewing polling status that
can be added when you create the slides,
before you run the presentation.

The Response Counter shows how many
participants have responded, while the
Response Table, which can be fixed or rotating,
shows who has responded. A fixed table
displays all the participants, ideal for groups
with 40 or fewer participants. The rotating table
is best for very large groups and displays
participants in sets of 40.

Find information about inserting objects in
slides in Add Objects on page 128.

Optionally, display a The Response Grid is a grid that is overlaid on a slide during the
Response Grid during the presentation and indicates which individuals enter responses.

session. From the Showbar, Similarly, the Non-Response Grid indicates which participants

select the Show Response have yet to respond. Specifically helpful to participants using

Grid button. infrared devices, these grids give the participants confirmation



3 After polling closes, click the
mouse to advance to the next
slide.

that their responses were received. Radio frequency, vPad
and Web vPad devices display confirmation right on the
device.

Response Grid
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The Response Grid can be shown or hidden at will by
selecting the Show Response Grid button. An interactive slide
displays a Response Grid when the question is first presented
and automatically removes the grid from the slide that shows
the tabulated results.

Viewing the polling status becomes disabled in the Showbar
until you activate another poll. If you want to always display
the Showbar expansion, set the Expand Showbar setting to
True. Expand Showbar is a presentation-level setting. Find
more information about modifying settings in TurningPoint
Device and Settings Management on page 153.

Use the Participant Monitor

The Participant Monitor shows which participants have responded to a question and displays details
about the responses, such as the percentage of correct responses, how long participants took to
respond, and which answers they picked. Use of the Participant Monitor is optional, but it is helpful
if you would like to keep track of how people are responding during your presentation.



You can access the Participant Monitor from either the Showbar, while the slide show is running, or
from the TurningPoint toolbar under the Participants drop-down menu, after you end the slide show.

Step by Step Instructions

1 While running the slide show,
from the Showbar select the
Display Participant Monitor
button.

Note If you want to limit the Participant Monitor to
your eyes only, then you can set up a second
monitor for displaying it. Find information about
setting up a second monitor in Windows Help
Chapter 4: TurningPoint Device and Settings
Management.

To monitor participants...

Alternatively, you can display the Participant monitor after
running a slide show by selecting Participants > Display
Participant Monitor from the TurningPoint toolbar.

Showbar Expansion: Display Participant Monitor

BxB@o oo d oo

TurningPoint opens the Participant Monitor window.

Participant Monitor Window

" a TurningPoint - Participant Monitor. E\
View
a
Question Overall % Corr... | TotPoint... #
1) Where is the capital of Chio 50% 100
2) here is the capital of Pennsylvania? 50% 100 B
3) Where is the capital of the United States? 100% 100
4) Where is the capital of New Mexico 100% 100
0% 100 v

5) Where is the capital of New Mexico

Last Hame Device ID Overall % | TotPaint... = Response Time | Response
ESEEIBFEBERGY... 3

First Name
George

Washinton

[Eenjanmin Frarkiin ADOZEF

[NEY

Question Response

1) Where is the capital of Chia

2) Where is the capital of Pennsylvania?
3) Where is the capital of the United States?
4) where is the capital of Mew Mexico

<

Accurnulsted Qroup percent; 100%
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The window displays Question, Participant and Individual
details about each participant’s response and the percentage
of correct answers.

Participant Monitor Window: Question Region

Question Overall % Corr... | TotPoint... -
1) Where is the capital of Chia 50% 100
2) here is the capital of Pennsylvania? 50% 100
3) Where is the capital of the Urited States? 100% 100
4) there is the capital of New Mexica 100% 100
5) Where is the capital of New Mexica 0% 100

Lists the specific responses chosen by the participant
selected in the Participant region

Participant Monitor Window: Participant Region

First Name Last Hame Device ID Overall % | TotPaint.. = Response Time | Response
\éashington EHEEIBFEBEBG4. .
Frarkiin ADO3BF
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Gives details about the response results for each participant for
the question selected in the Question region.

Participant Monitor Window: Individual Region

= TurningPoint - Participant Monitor

a8
Question | overall % Corr... | TotPoint ... | &
1) Where s the capital of Chio 50% 100
2) Where is the capital of Pennsylvania? 50% 100
3) Wwhere is the capital of the United States? 100% 100
4) Where is the capital of New Mexico 100% 100
5) Where is the capkal of Hew Mexico 0% 100

First Name | Last Hame | Device ID
George ‘ashington E5EESBFEBEBE4 ..
[Eenjanmin Frarkin ADD3EF 5

a
Question Respons= ~
1) Where is the capisl of Oio
2) Where is the capital of Pennsylvania?
3) Where is the capital of the Lnied States?
) Where Is the capital o Hew Miexico v
< >
Accurnulsted Qroup percent; 100%

Lists each question and totals the correct responses and point
values per question. Select a question to view details pertaining
to it in the Individual region.

You can hide one or more of When viewing the Participant Monitor while running the slide
the three regions by selecting show, advancing to the next slide will hide the Participant

the close button (X) in the Monitor window. To view the window again, press the F12 key.
upper right corner. To view a (Alternatively, you can also press the Alt + Tab keys, or simply
region you have hidden, end the slide show.)

select it from the View menu
in the Participant Monitor

window.

You can expand or reduce When viewing the Participant Monitor while running the slide
the size of the three regions show, advancing to the next slide will hide the Participant
by selecting the borders and Monitor window. To view the window again, select the View

dragging them up or down. Participant Monitor icon.



Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding a template or custom slide while running the
presentation. Inserting a new slide is an option available at your fingertips through the Showbar.

Step by Step Instructions To add a new slide...

1 Insert a new slide in one of
the following ways:

* Template Slide - select the A drop-down menu opens from the Showbar allowing
arrow next to the Insert you to select the slide type to be inserted into the
Slide button on the presentation.

Showbar and select the
type of slide and skip to Showbar Expansion: Insert a Template Slide
step 3. =1L |Q| = | respuﬂnses: User Fenedback:

Yes/ho

TruejFalse

Yes/Mofabskain

Likert 3

EENEric L

FesponseCard RF Channel Slide

wPad [ web vPad Log-In

Fill in the Blank,

Essay

Team Leader Board

Team Leader Board{fccumulate Poinks)
Participant Leader EBoard

Participant Leader Board{Accumulake Painks)

¢ Custom Slide - select the Showbar Expansion: Insert a Custom Slide

Insert Slide button on the E % ﬂ g @ = {% B = ,@ﬁ
Showbar and go to step 2.




If you chose to create a
custom slide, type the
question in the top region of
the window. Type the answer
choices in the lower region,
separating each answer with
a line break.

The Custom Question window opens to display the fields
for typing the question and answer choices to be used on
the interactive slide.

Insert Slide: Custom Question

TurningPoint - Custom Question

nter gquestion text. ..

Enter answer text...

[ Cancel ][ Insert

Insert Slide: Custom Question

TurningPoint - Custom Question

nter gquestion text. .,

Enter answer text..,

[ Cancel ][ Insert




3 Select the Insert Add button. A new interactive slide appears, after the slide you had been
viewing, displaying the new question.

Note If you would like to reuse the presentation with
the newly added slide, save the file. From the
PowerPoint menu, select File > Save As. If you
forget, TurningPoint asks you before closing.

Data Slicing (View Results by Question)

After receiving response data, TurningPoint can cross-reference the responses of one question to
another set of responses. This function, called data slicing, is particularly useful for analyzing
demographic information. For example, you can find out whether a certain age group in the
audience prefers a certain type of music. By asking participants to identify their age group in one
question, and later asking them to pick their favorite type of music, you use data slicing to find out
how many young adults in the crowd prefer jazz, how many seniors prefer classical music, and so
on.

Before You Begin

To measure demographic information, insert a question slide early in the presentation that asks the
audience to identify themselves in a demographic category, such as an age group or gender.

Note To use demographic information in reports,
identify a slide with a demographic question in
the TurningPoint settings at the slide level. Set
the Demographic setting to True. Find more
information in TurningPoint Device and
Settings Management on page 153 and
Reports on page 341.




Step by Step Instructions

4 Run the presentation. (From
the PowerPoint ribbon, select
the Slide Show tab. In the
Start Slide Show section,
select From the Beginning.)

5 Use the arrow keys to go to
the primary question slide
whose data you want to slice.

6 From the Showbar, select the
Data Slicing button.

To use data slicing...

For the example, to find out whether a certain age group in the
audience prefers a certain type of music, you would go to the
question slide that asks participants to select a favorite type of
music.

The Data Slicing window opens and displays a list of all
questions from the interactive slides followed by their answers.

Showbar Expansion: Data Slicing

B vllosotd o=




7 Select the answer whose
data you wish to reference in
the primary question slide.

8 Select the Select button.

9 To return the chart to its
original data, press the F6
key.

The default selection is the first answer in the first question
slide. For the example, to find out how many young adults

prefer each type of music, you would select the 18-35 age
range.

Data Slicing

TurningPoint - Data Slicing

= a Data Slicing {11 questions)
[ where is the capital of Chio
[ Where is the capital of Pennsylvania?
[ where is the capital of the United States?
[ Where is the capital of Mew Mexico
[ where is the capital of the United States?
[ Where is the capital of Yirginia?
[ where is the capital of Virginia?
[ What is the capital of Tennessee?
[ which one is the United States Flag?
[ What is the capital of Michigan?
[ what is the capital of Delaware?

(%) Question Data () Participant Groups

TurningPoint retabulates the data to show the new
distribution. Instead of viewing the results for the entire
audience, you see the distribution for only the participants in
the audience who submitted the selected answer.

After you have displayed a data slice, you can select a
number on the keyboard corresponding to an answer to see
the slice associated with that answer. You can also cycle
through groups that have responded by pressing the G key.
When finished viewing the data slices, press the F6 key to
return to the original chart.



Where Do I Go From Here?

This chapter has demonstrated how to run and manage presentations.

You are now ready to begin reviewing reports and understanding presentation data. You can find
information in Chapter 8: Reports.



Chapter 7: Run Presentations

340 Turning Technologies



Reports

Turning Reports allows you to view, export, and print a wide variety of reports based on the responses
you received during your TurningPoint and TurningPoint Anywhere sessions. The reports are Word or
Excel files with information about the questions and answers, participants, and responses gathered in
your presentation. The Report Wizard Turning Reports displays a hierarchical menu of reports
organized by category, such as Results by Question Reports and Demographic Reports. If you
double-click on one of these categories, the Report Wizard Turning Reports screen displays
subheadings of specific report titles, including Graphical Results by Question and Demographic
Comparison, and also shows samples of each selected report.



View a Report

You can create reports using Turning Reports available in the Tools menu in the TurningPoint
toolbar.

This section describes how to:

View a Report

View a Report

Use Turning Reports to generate reports.

Before You Begin

Create a session file by running a presentation session and saving the file. Find more information in
Chapter 7: Run Presentations.



Step by Step Instructions

1 Select Tools in the
TurningPoint toolbar.

2 Select Turning Reports from
the Tools menu.

To view a report...

The Tools menu opens.

Response Devices

e e 5§ R e

*tHM®FE

Turning Reports
Session Management
Standards

Comparative Links
Conditional Branching
Import from TestingPoint
Parser

Update Parser Template
Ranking Wizard
WebCT Wizards
Blackboard Wizard
VantagePoint
QuestionPoint
Enterprise Manager
Settings

Upgrade TurningPoint Receiver

Select Turning Reports

The Turning Reports window opens, displaying two tabs:
Sessions and Reports.



3 Select the Sessions tab.

4 Choose a session file.

The Turning Reports window displays a list of the session files
in your Sessions folder.

Turning Reports: Select Session

" a Turning Reports - Current Session EHE‘E‘

Sessions | Reports

Please select your session

= & Press F5 to refresh the sessions list
Mame Date ad
- Current Sessior I
87pM1.tpz 7}12i2007 11:15:24 Ak
B7pM10.tpz 71242007 11:15:24 Ak
BpM11.tpz 711202007 11:15:24 Ak
BpM12.tpz 711202007 11:15:24 Ak
8]pMz.tpz 7H2i2007 11:15:24 At
8]pMatpz 7H2i2007 11:15:24 At
2 pMd.tpz 7112j2007 11:15:24 AF
8 pMs.tpz 7}12j2007 11:15:24 AF
8 pM6.tpz 7}12j2007 11:15:24 AF
S1PM7.tpz 712/2007 11:15:24 AF
©PM.tpz 712/2007 11:15:24 AP
87 pMo.tpz 712§2007 11:15:24 Ak
8 priorityDemogMoment tpz 712§2007 11:15:24 Ak
8 Reports.tpz 711202007 11:15:24 At
8 ReportsDemog. kpz 1202007 11:15:24 Ak
< >

(®) My Session Files
() My Backup Session Files

r

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session
button (shaped like a folder) above the list of files. This allows
you to use a TurningPoint or TurningPoint Anywhere session
file you have copied from elsewhere.

You may choose a session file in one of the following ways:

Select the Current Session (in red text) to use the
session currently open in PowerPoint

This option is available only if you have a TurningPoint
presentation open and response data has been
collected.

Select a session file from the list of files in your
Sessions folder.



5 Select the Reports tab once
you have selected a session
file.

To display the session files from your Sessions folder in
the list of files, select My Session Files. Press F5 to
refresh the sessions list

Select a session file from your backup session files.

To display the backup session files in the list of files,
select My Backup Session Files. Press F5 to refresh the

sessions list.

Import a session file from another location.

Use the Import Session button to open a file dialog to

locate and select the session file.

The Turning Reports window displays a list of the categories of

reports you can generate from your session file.

¥ u Turning Reports - Current Session

Sessions | Reports |

Turning Reports: Generate Reports

Please select the report(s) to generate

Reports by Category

[ Results by Question Reports
[lg5 Demographic Reports

[l Participant Results Repores
[(l5> Results by Participant Reports
[CJg& Participant Lists

[lg&- standsrds Reports

[ Comparative Scoring Reports
[l5 ream Scoring Reports
[l Percentie Reports

[l ther Reparts

Categories in italics have options

[ change numeric responses to alphabetic responses (1 = &, Z

Description and Repart Sample
Report Description
The deseription of the currently selected report vill be displayed here.

=B, etc)

SR

Each category of report is listed by name. You can double-click
the category or click on the plus sign beside the category to view
a list of reports in each category. The icon beside the report

name indicates whether it generates an Excel file or a Word file.

Some reports are available in both forms.




When you select a report, you can see a sample preview of
the report on the right-hand side of the Turning Reports
window.

6 Select the type of report(s) Find more information in Reports on page 341.
you would like to generate by
selecting the check box next
to the report name.

You can select multiple reports by selecting multiple check
boxes. You can also select an entire category of reports by
selecting the check box for the category.

You can select to change numeric responses to alphabetic
responses by checking the Change numeric responses to
alphabetic responses check box.

Click Change Numeric Responses...

" a Turning Reports - Current Session

Sessions | Reparts |

Please select the report(s) to generate

Reports by Category

[ Results by Question Reports
I Demographic Reports

[Ies Perticipant Results Reports
I Results by Participant Reports
g Participant Lists

[ standards Reports

e Comparative Scoring Reports
[ Feam Scoring Reports
& Fercenite Reports

[ Other Reports

Description and Report Sample
Report Description
The: description of the currently selected report wil be displayed here.

Categories in italics have options

Changs numeic responses to alphabetic respanses (1 = A, 2 = B, etc)

r Generate Repart 1




Depending on the type of report you select, the Include Page
Breaks check box may be displayed below the report preview.

Include Page Breaks

" a Turning Reports - Current Session EHE‘E'

Sessions | Reparts |

Please select the report(s) to generate

Reports by Category

[ Results by Question Reports
[Vl Demoagraphic Reports
[ Particpant Results Reporés

[l Results by Participant Reports
[CIg& Participant Lists

(g Standards Reports

[l Comparative Scoring Reports
[ Team Scoring Reparts
[l Percentie Reports

[l ther Reparts

Description and Report Sample
Report Description

Categories in italics have options

[] change numeric responses to alphabetic responses {1 = &, Z = B, etc)
Include Page Breaks (in all that apply)

7 Specify whether to include If you check the box, TurningPoint will create page breaks at
page breaks in the report by convenient places in the report for ease of printing.
checking the Include Page
Breaks check box (if
available).

8 Select the Generate Report TurningPoint creates the report and opens it in Microsoft Excel
button. or Word.

This may take some time, especially if there are a large number
of questions or participants in the session.

You can generate as many reports as you like. When one report
is finished being created, select another type of report from the
list and select the Generate Report button again.



9 When you are finished
creating reports, the Exit
button to close the Turning
Reports window.

Next Steps

You can use Excel or Word to edit, save, or print the reports.



Types of Reports

This section describes:

Results by Question Reports (2 Reports)

Demographic Reports (2 Reports)

Participant Results Reports (4 Reports)

Results by Participant Reports (4 Reports)

Participant List Reports (2 Reports)

Standards Reports (3 Reports)

Comparative Scoring Reports (2 Reports)

Team Scoring Reports (2 Reports)

Percentile Reports (2 Reports)

Other Reports (8 Reports)
Attendance Report
Moment to Moment Report
Outline Report
Participant Questions and Comments Report
Ranking Summary Report
Response Data Export Report
Results by Group Report
Statistics Report



Results by Question Reports

The Results by Question and Graphical Results by Question Reports show a summary of
responses for each question. Each of these reports creates an Excel file.

Results by Question Report This report includes the following information for each
question:

the answers
an indication of the correct answer(s)
the number of responses for each answer

the percentage of responses for each answer

Results by Question Report

Turning Results by Question

Session Name: Reports.tpz
Created: 7/23/2007 2:33 PM

1) Where i thecapital of Ohio

Responses
(percent) _ {court)
Columbus 50% 1
Cincinnati 056 of
Youngstown 505 1
Clavaland o5 of
| Totak 100%| 3)
2) Where & thecapital of Pennsyhania?
Responses
(percent) _ {court)
Fitrshurgh 05| 9|
Harrisburg 100% 2
Saranton 0| of
Fhiladelphia 5| of
[Totak 1005 2)
3) Where s the capital of the United States?
Responses
{percent]  (count)
WashingtonState 05| ol
Washington, PA | of
Wias hington D.C. 100% 1
Washington, NC | of
Tatak 1005| 1

4.) Where s thecapital of New Mexico

Responses
(percent]  (count]
05|

Albuguerque

SN

Santa Fe 50%
Loz Alamos 056 | of
Carlsbad 508¢| 1
[Totak 10058] 3)
5.) Where is the capital of the United States?
Respanses.
{percent]  {count]
[ of
508¢| 1
w g 50% 1
Washington, NC 55| of
| Totak 100%| 3)
Pagelof3
Graphical Results by This report includes the following information for each

Question Report question:

the answers



Types of Reports

° an indication of the correct answer(s)
° the number of responses for each answer
¢ the percentage of responses for each answer

° Pie chart with a percentage of the responses per answer

Graphical Results by Question Report
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Demographic Reports

The Demographic Comparison and Graphical Comparison Reports show a summary of responses
for each question broken down by demographics. Each of these reports creates an Excel file.

Demographic Comparison The Demographic Comparison includes the following
Chart information for each question:

the answers
indication of the correct answers

the number of responses for each answer from each
group

the total number of responses from each group

demographically categorized response data on a per
question basis

number of people who answered each question
correctly

Demographic Comparison Chart

Turning Demographic Comparison

Session Name: ReportsDemoOnly. tpe
Crested: 7/23/2007 2:40 PV

1.) Whatiis your age group?

1825 2630 3140 41-50 5160 6170 71
s 10] 0
2630 0 [ 14
3140 [
4150
5160
6170
7180
80+

-

HEIEE] ]S

olalole

o|mfolofofofo]o|f
EEEEIEEIEElE

o|o|o|alb|ofala
o|olE|o|o|o|o|o

ol|alo|alala
o|alo|t

ololo|ala

2.) How hours of television do you watch s day?

2
-

EEEEEEEEE

1825
2630
3140
4150
5160
6170
7180
80+

1 F] z

ale|rlm(tle el ololo|olo|klo|e

IS 14 198 18 (P PN P O - |
1o a1 [ro s s [ 0] | e
U ) 199 18 P 4 9 P P
NEICIM N N
olo|s|n|w|e | w]wn
U TV 19 1R P 1 PP
wlo|o|wlw|m|w ol

Page lofl




Graphical Comparison Chart The Graphical Comparison includes the following information
for each question:

the answers
an indication of the correct answer(s)

the percentage of responses for each answer from each
group

a vertical bar chart of the responses for each answer from
each group

When generating the Graphical Comparison Report, you have
the option of creating page breaks between each question.

Graphical Comparison Chart

Tuming Graphical comparison
‘Sesson Name: ReportsDemoOnl yitpz
Created: 7/23/2007 2:40 P
1) whatis your age group?

25 %30 3120 a1so 5160 6170 7180 B0+
1825 100.00% o.00% 000% o.00% 0.00% [ 0.00% 0.00%
2630 0.00% 100.00% 000% 000% 000% oodk 0.00% 0.00%
3140 0.00% 0.00% 100.00% D.00% 0.00% 0006 .00 D.00%
ar-s0 0.00% o.00% 000% 100.00% 0.00% [ 0.00% 0.00%
5160 0.00% 0.00% 000% 0.00% 100.00% 0.00% 0.00% 0.00%
6170 0.00% 0.00% 000% 000% 000% 100.00% 0.00% 0.00%
71-80 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 100.00% 0.00%
Bo+ 0.00% o.or% 000% 000% 000% 000k 0.00% 100.00%

e, A— A — L H 0 |

e 63 3AC WP  SLED . BLID TLED B0

1825
2630
3140
a1-50
5160
6170
7180

suyuv {

20004

n s

nams

& L 2 3 1 5 : i

Fagelaf 1




Participant Results Reports

The Participant Results, Graded Participant Results (correct/incorrect), Graded Participant Results
(point values), Graded Participant Results (ratio) Reports show a summary of responses for each
question. When generating the you have the option of displaying the entire question or excluding
the question text. Each of these reports creates an Excel file.

Participant Results Report The report includes the following information for each
participant:

device number
fields defined in the participant list

the numerical value of the participant’s response to
each question

Participant Results Report

6
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Graded Participant Results The report includes the following information for each
(correct/incorrect) Report participant:



Graded Participant Results
(point values) Report

device number
fields defined in the participant list

the numerical value of the participant’s response to each
question

an indication of whether the response is correct or
incorrect

total percent correct

Graded Participant Results (correct/incorrect) Report

aiaamag
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The report includes the following information for each
participant:

device number
first and last name (if specified in the Participant List)

the numerical value of the participant’s response to each
question



an indication of whether the response is correct or
incorrect

the total number of points

Graded Participant Results (point values) Report
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Graded Participant Results The report includes the following information for each

(ratio) Report participant:
device number
first and last name (if specified in the Participant List)

the numerical value of the participant’s response to
each question

an indication of whether the response is correct or
incorrect



the ratio or correct to incorrect answers for each question

Graded Participant Results (ratio) Report

Session Name: Reports Demog2.tpz

Created: 7/23/20072:41PM

Device ID

6BEE3BFEBEBE40BC
A003BF

90

43

El

23

Last Name

Adams
Lincoln
Ford

First Name

Geore.
Beni

Jot
Abraham
Gerald

Turning Graded Participant Results

Student ID

1776
1752
1801
7679
1865
7878

Team 1
True

True

True

pPagelofl

Team 2

True

True
True

1) Where is the
capital of Ohio

ai
3i
1c
3i
ai
ai

2) Where is the.

capital of
Pennsvivania?
3i

1i
1i
2¢c
1i
1i

3) Whereis the
capital of the
United States?
3c

21
3c
3c
ai
2i

Total

2/8
o/s
2/8
5/8
o/s
o/8



Results by Participant Reports

The Results by Participant Report shows a summary of responses for each question for each
individual participant. This report creates an Excel file.

When generating these reports, you have the option of creating page breaks between each
participant’s section.

Results by Participant Report The report includes the following information for each
participant for each question:

the question
the numerical value of the participant’s response

an indication of whether the response is correct or
incorrect

the correct answer

Results by Participant Report

Turning Results by Participant

Session Hame: Reports.tpz

Creatad: 7/23/2007 2:43PM

[ = [Responses]

1] Whereisthecapitalof Ohio 3i
Calumbus:

2) Whereisthe capital of Pennsylvania? 2c
Harrisburg

3) Whereisthe capital of the United States? 3c
‘Washington DC.

) Whereisthe capital of New Mexico 4i
SantaFe

5) Whereisthe capital of the United States? 3c
Washington DC.

&) Whereisthe capital of Virginia? 4c
Richmond

7) Whereisthe capital of Virginia? 3i
Richmond

B} What is the capital of Tennasses? 2i
Nashille

9] Which one is the United States Flag? 1

10) What isthe capitsl of Michigan? 4i
Lansing

11) What is the capital of Delaware? 2i
Dover

A

[ jBnmi; lin. Respanses

1] Whereisthecapitalof Chio 1c
Columbus.

2) Whereisthe capital of Pemsylvania? 2c
Harrisburg

3) Whereisthe capital of the United States?
Washington D.C.

4) Where isthe capital of New Mexico 2c
SantaFe

5) Whereisthe capital of the United States? 2i
Washington D.C.

&) Whereisthe capital of Virginia? 4c
Fichmond

7) Where isthe capital of Virginia? 1
Fichmond

B} What s the capital of Tennasses? 2i
Nashwille

5} Which one is the United Staes Flag? 1

10) What isthe capitsl of Michigan? 2c
Lansing

11) What isthe capits|of Delawars? 4i
Dover

0%




Results by Participant
(Answer Detail) Report

Results by Participant
(Response Detail) Report

The Answer Detail Report includes a complete list of answers

for each question. This list enables you to match the numerical
value of the participant’s response (number 1 or 2, etc.) to the
actual answer (e.g. yes or no) and highlights the correct answer
in green. This report also shows whether responses are correct
or incorrect by marking them with a ‘c’ or an ‘.’

Results by Participant (Answer Detail) Report
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The Response Detail Report includes the question along with
the participant’s response. This report displays correct answers
in green and incorrect answers in red and calculates the



percentage of correct answers and the total points
accumulated by each participant.

Results by Participant (Response Detail) Report

Turning Results by Participant (Response Detail]

Session Name: Reports.tpz
Created: 7/23/2007 2:43 PM

1) Where is the capital of Ohio
[Coumbus]
2) Where is the capital of Pennsylvania?
3) Where is the capital of the United States?
14) Where is the capital of New Mexico

[Santa Fe]
5) Where is the capital of the United States? Washington D.C
&) Where is the capital of Virginia? Richmond
7) Where is the capital of Virginia?
[Rickmand]
18} What isthe capitl of Tennesses?
eshule]
5} Which one isthe United States Flag?
10) What is the capital of Michigan?
[Lansing]
11) What is the capital of Delaware?
[Dover]
Correct %
Total Points

1) Where is the capital of Ohio

2) Where is the capital of Pennsylvania?

3) Where is the capital of the United Statas?

14) Where is the capital of New Mexico

5) Where is the capital of the United Statas?
[Washington D.C]

&) Where is the capital of Virgini=?

7) Where is the capital of Virginia?
[Rickmand]

18} What isthe capital of Tennassss?
Neshuilie]

15} Which one isthe United States Flag?

10} What is the capital of Michigan?

11) What is the capital of Delaware?
[Dover]

Correct %

Total Points




Results by Participant (Score The Score Detail Report calculates the percentage of correct
Detail) Report answers and total points accumulated by each participant.

Results by Participant (Score Detail) Report

Turning Results by Participant [Score Detail)

Session Name: Reports.tpz
Created: 7/23/2007 2:43PM

[ George

Corrects

Total Points

[

Correct®

Total Points

| Alsander Hamifton
Correct®

Total Points

| John Q. Adams

[ Abraham Lincoln

[ Gerald Ford

wg| | |aE] | [s5 | (8% | la8) | (85]]




Participant List Reports

The Participant List Reports show the participant data from the Participant List in either a Word file
or an Excel file.

Participant List (Word) The report shows device number and any of the fields defined
Report in the Participant List (name, contact information,
demographic groups or teams, etc.).

Participant List (Word) Report

Turning Participant List

Session Name: ReportsDemog3.tpz

Created: 7/23/2007 2:45 PM

Device ID: GBEE3BFEBEBGA0BC
Device ID: 68EE3BFEBEBG40BC
Last Name: Washingtan
First Name : George
Student ID: 1776

Team 1:True

Device 1D: ADO3BF
Device |D: ADD3BF
Last Name: Franklin
First Name: Benjanmin
Student ID: 1752

Team 2: True

Device ID: 30
Device ID: 90
Last Name: Hamilton
First Name: Alexander
Student ID: 1801

Team 1: True




Participant List (Excel) The report shows device number and any of the fields defined
Report in the Participant List (name, contact information, demographic
groups or teams, etc.).

Participant List (Excel) Report

Turning Participant List

Session Name: ReportsDemog3.mz
Crested: 7/23/2007 2:45 PV

Device ID lastName  FirstMame  Student!D Tesm1 Team2
EBEEIBFEBEBE40BC Washington George 1776 True

AOOBF Franklin Benjanmin 1752 True
] Hamilton  Alexander 1301 True

a Adams JehnQ 7673 True
£l Lincoln Abraham 1865 True
23 Ford Gerald 7878 True

Pagelof2




Standards Reports

The Overall Standards, Individual Standards, and Group Standards Reports show response
information based on standards identified for each question. These reports create Excel files.

Overall Standards Report The Overall Standards Report is very similar to the Results by
Question Report but includes additional information relating to
standards. It includes the following information for each
standard:

the percentage of overall comprehension for all
questions that are associated with the standard

the questions associated with the standard
the answers for each question

an indication of the correct answer(s)

the number of responses for each answer

the percentage of responses for each answer

Overall Standards Report

Turning Overall Standards

Session Hame: ReportsStandards07_15_07.tpz
Created: 7/23/2007 2:47 PM

[Fiate Capitaks = 51.85%

1) Where i the capital of Ohio
Respanses
(percent) _{count)

Cincinnati 16675
Youngstawn 16675
Clevelznd

oo e e

05|
| Totas 100%|

2 Where is the capital of Pennsyhania?

Responses
(percent] _{court]
Pitsburgh 16.67%| 1

Scranton 16.675| 1
Philadelphiz 16.675|
Totak 1005| €|

3) Where i the capital of the United States?

esponses
[percent]  {count]

Washington State 0] [

Washington, PA 3333%| 2

Washington, NC 16675 1
Totak 1005 8]

4) Where & the capital of New Mexico
Responses
(percent]  (count)
05|

Albuquerque

Los Alsmos E=EEH
Carlsbad 16675
[Totals 1005

£ e,

5) Where is the capital of Virginia?

Responses
(percent) {court)
Alzandria 16679
Lynchburg 16675
Martinsille 05|

ol 6w e

| Totas 100%|

Pagelof2




Individual Standards Report The Individual Standards Report includes the following
information for each individual participant for each standard:

the participant’s percentage of comprehensive for all
questions that are associated with the standard

the questions associated with the standard
the answers for each question
an indication of the correct answer(s)

an indication of the participant’s response and whether it
was correct

Individual Standards Report

Turning Individual Standards

Session Hame: ReportsStands rds07_15 07.tp
Crested: 7/23/2007 2:45 PM

[State Capitaks = 66.67% |
1) Where i the capital of Ohio

Cincinnati
Yaungstown
Cleveland

2 Where i the capital of Pennsylania?
Fittsburgh

Scranton
Fhiladelphia

3) Where is the capital of the United States?
Washington State
Washington, PA

Washington, NC

4) Where i the capital of Hew Mexico
Albuguerque

¥ Los Alamas
Carksbad

5) Where i the capital of Virginia?
Alexandria

Lynchburg

Martinsiile

6) Whatis the capital of Tennessee?
¥ Gatlinburg

Memphis

Knowile

7) Which oneis the United States Flag?
* 1

2

3

2

8) Whatis the capital of Michigan?
Ann Arbor

Grand Rapids
EastLansing

Pagelof7

When generating the Individual Standards Report, you have the
option of creating page breaks between each participant’'s
section.



Group Standards Report

The Group Standards Report displays the percentage of
correct responses from each group for each standard.

Group Standards Report

Turning Group Standards

Session Name: ReportsStandards07_15_07.tp
Created: 7/23/2007 2:45 PM

[State Gapimks

Team 1= 63%
Team 2= 75%

Pagelofl




Comparative Scoring Reports

The Individual Scoring and Scoring Distribution Reports show a summary of scoring information
based on participant responses in comparison to other participants. Each of these reports creates an

Excel file.

Individual Scoring Report

Scoring Distribution Report

The Individual Scoring Report includes the following information
for each participant:

numeric response labeled correct or incorrect
percent scores

whether the participant’s score puts him/her above or
below the class average

Individual Scoring Report

Tuming Individual Scoring

Session Hame: ReportsStands rds07_15 07.tp
Crested: 7/23/2007 2:49 PM

(George Washingmn

Number of Auerage Percent Correct Your Percent Above/Below
Questions Al Particigants Score Class Average
£l 58.33% 75% 16.67%
Question Your Correct % Audiance
Number Answer Answerfs) Comect

1 1c 1 66675

2 2c 2 505

3 3c 3 505

4 3i 2 505

5 4c 4 66675

3 1i 3 E6E75

7 1 - -

2 3c 2 505

3 1c 1 E6E75
Benjamin Franklin

Number of Auerage Percent Correct Your Percent Above/Below
Cuestions Al Participants Score Chass Average
£l 53.33% 755% 1667
Cuestion Your Correct % Audience
Number Answier Answerfs) Comect

1 1c 1 BEE75

2 3¢ 2 505

2 3c 3 505

4 2¢ 2 50%

5 1i 4 6667

6 3¢ 3 66675

7 1 - -

8 3i 2 50%

3 1

1c 6667

The Scoring Distribution Report includes the following
information:



the total number of participants

the score ratios for assessment (number of correct
answers to question)

the number of participants achieving each score ratio
the answer value (correct, incorrect, no value)
acceptable answer choices

number of responses each answer received

Session Hame: ReportsStandards07_15_07.tpz
Created: 7/23/2007 2:50 PM

Turning Scoring Distribution Report

Scoring Distribution

Score mtiosfor assessment [correct answers to Humber of participants achieving score
‘questions) mtio
Boutof 8 0
Toutol 8 0
Goutcf 8 2
Soutof 8 1
doutof 8 2
Joutdf 8 1
Zoutdf 8 o
loutol 8 0
Ooutdf 8 0

Total Participants: 3

Question Performance Data

Question A‘:‘."’:' Answer Choice. Mumber of Responses

Comect
ncorrect
ncorrect
ncorrect
ncorrect
Comect
ncorrect
ncorrect
ncorrect
ncorrect
Comect
Incorrect
Incorrac
Comect

Incorrac
Incorrect
Incarrect
Incarrect
Incarrect
Comect
Incarrect
Incarrect
Comect
Incarrect

) [P S JPN Y P PN VP YA RO OP P (R P P )RR S o Y 1

o o] m] | of e m]w] | wl ofw| wlm|o




Team Scoring Reports

The Team Scoring (Percentage) and the Team Scoring (Points) Reports show overall team results,
the correct answer for each questions, the number of responses per answer for each question, results
for each question and the correct answer highlighted in green. While generating these report, you
have the option to exclude response detail. Each of these reports creates an Excel file.

Team Scoring (Percentage) The Team Scoring Percentage Report includes the following
Report additional information:

the answers

the overall percentage of questions each team answered
correctly

the percentage of team members that answered each
question correctly

Team Scoring (Percentage) Report

Turning Team Storing Report

Session Name: ReportsDemog2.tp
Created: 7/23/2007 251PM

Overall Team Scores
Team 1= 62.5%
Team 2= 10%

1) Where is the capital of Ohia

Columbus Cincinmati Cleveland Total
Team 1 o 1 05|
Team 2 | 1 E] 20|
2.) Where is the capital of Pennsylvania?
Pitrshurgh Harrishurg Seranton Phildelphia Total
Team 1 2 9] 2 1005
Team 2 4 1 o 05|

3) Where is the cpital of the United Statas?
Washington State _ Washington, PA__ Washington D.C. _ Washingtan, NC Tatal

Team1
Team 2

4) Where is the capital of New Mexica

Team1 | o i o| o‘ 100%]
Team 2 1 1 o 3 20|
5.) Where is the capital of Virginia?
Alexandria Lynchburg Martinsville Richmand Total
Team1 1 [ 0]
Team 2 1 3 1 0 05|

) What s the capital of Tennesses?
Gatlinburg Memphis Nashville Knanville Total

Team1 q 3 100%]
Team 2 1 0 05|
7.) Which one is the United States Flag?
1 2 2 4 Total
Team 1 | a‘
Team 2 o

|2 2|

8) What s the capital of Michigan?

Ann Arbor Lansin Grand Rapids East Lansing Tatal
Team 1 0] of 0] 100%¢]
Team 2 ol 1] 03]

IS

Pagelofd




Team Scoring (Points) Report

The Team Scoring Points Report includes the following
additional information:

the answers
the total points accumulated by each team

the points each team received for every question

Team Scoring (Points) Report

Turning Team Scoring Report

Session Mame: ReportsDemog2.tp
Created: 7/23/2007 251PM

Overall Team Scores
Team 1= 500
Team 2= 80

1) Where is the capital of Ohia
Columbus Cincinnati Cleveland Toeal

Team1
Team 2

!
w
Bo

2) Where is the capital of Pennsylvania?

Fitrsburgh Ha rrisburg Seranton Phildelphia Toeal
Team1 1 9] 2 00|
Team 2 g 1 o o

3.) Where is the capital of the United States?
Washington State

Washingta
Team 1
Team 2

4) Where is the capital of New Mexica

Albuquerque SantaFe Los Alames Carkbad Total
Team 1 of 1 of of 100)
Team 2 1 1 ol E] 20|
5) Where is the capital of Virginia?
Alexandria Lynchburg Martinsville Richmond Total

Team 1

-
oo

Team 2

&) What s the capital of Tennessee?

Team 1 g 1 100]
Team 2 1 0 [

7.) Which one is the United States Aag?

Team1
Team 2

o o

8) What s the capital of Michigan?

n Arbor Lar Grand Rapids East Lansing Tatal
Team1 0]
Team 2

!
7.
o
&

9.) What s the capital of Delaware?

Daver
Team1 1 0 0]
Team 2 bl 1] 3

Page 1ofd




Percentile Reports

The Percentile (correct/incorrect percentage) and Percentile (points) Reports show how participants’
responses compared to other participants’ responses, Device ID, first and last name, and the
percentile ranking for each participant against other participants. You can change the percentiles
shown by recording the new percentiles separated by a semicolon in the appropriate box. Each of
these reports creates an Excel file.

Percentile (correct/incorrect The Percentile (correct/incorrect percentage) Report includes
percentage) Reports the following additional information:

the total percentage of questions each participant
answered correctly

Percentile (correct/incorrect percentage) Reports

Turning Percentiles Report

Session Names ReportsDemog.tpz
(Created: 7/23/2007 2:55 PM

Device D Total % Correct
12.5%
37.5%
37.5%
5%

o

12.5%
37.5%
37.5%

5%

25th Percentile

125%

o w e

37.5%
37.5%
255

@ w e

Percentile (points) Report The Percentile Points Report includes the following additional
information:



the total accumulated by each participant

Percentile (points) Report

Tuming Percentiles Report

Session Mame: ReportsDemog3.tpz
Created: 7/23/2007 255PM

Device D Total Points
3 300
1 100
3 300
5 243
& 143
1 100
3 300
5 243
& 143

100

g

243
143

oo w e




Other Reports

TurningPoint offers eight unclassified reports: Attendance, Moment to Moment, Outline, Participants
Questions and Comments, Response Data Export, Ranking Summary, Results by Group, and
Statistics Reports.

Attendance Report The Attendance Report provides basic participant information,
including name and Device ID, and shows has attended the
presentation.

Attendance Report

Tuming Artendance Report

Session Name: ReportsDemog3.pz
Created: 7/23/2007 2:57 M

Device ID Last Name: First Name Attended
GEEE3BFEBEBGA Washington  George v

ADOZBF Franklin Benjanmin
0 Hamilon Alexander
a3 Adams JehnaQ.

9 Lincaln Abraham
3 Ford Gerzid

SN

Pagelofl




Moment to Moment Report Moment to Moment Report shows a chart of the moment to
moment rating results. This report creates an Excel file.

Moment to Moment Report

o T <

Wd 652 £00Z/€2/L :p238210

2dyjuswoypyspodey Bwe uopssag

zot
$puGsSS ST
P
SUNS2Y JUAWOI 03 LW Funy,

Outline Report The Outline Report gives an outline of slide questions and
answers in a Word file. The outline include an indication of the



correct answer(s). This report is found under the Other Reports
category.

Outline Report

Turning Outline

Session Name: ReportsDemog3.tpz

Created: 7/23/2007 2:57 PM

1) Where isthe capitsl of Ohio?
Correct-Columbus
Incorrect - Cincinnati
Incarrect - Youngstown

Incorrect - Cleveland

2)Where isthe capital of Pennsylvania?
Incarract - Pittsburgh
Corract-Harrisburg
Incorrect - Scranton

Incorrect - Philadelphia

3] Where isthe capital ofthe United States?
Incarrect - Washington State
Incorrect -Washington, PA
Correct - Washington D.C.

Incarrect - Washington, NC

4)Where is the capital of New Mexico

Incorrect - Albuquerque




Participant Questions and The Participant Questions and Comments Report shows any
Comments Report comments or questions sent by vPad participants during the
presentation. This report creates an Excel file.

Participant Questions and Comments Report

' =

%

£ 5 ¢ § £ § &8 % £

E} #
& 2 H
i g H
M 4 B

Ranking Summary Report The Ranking Summary Report shows a summary of Ranking

Slides. The report creates an Excel file.
The Ranking Report includes the following information:
a list of the ranking criteria

a list of the ranked items and the rank assigned for each
criterion



the chart showing the ranking

Ranking Summary Report

Turning Ranking Summary

Session Name: ReportsRanking.tpz
Created: 7/23/2007 3:01 PM

Cost
Urgency
Impact
10
X Y z
1 4.5 35
4.6666667 5.1666667 7.3333333
68333333 53333333 53333333
Project D 4.8333333 65 &5
Bubble Size = Impact
10
z
= 53333331313
Mn 5
£
o +
o 5 10

Cost

Pagelofl




Response Data Export Report The Response Data Export Report gives the raw response
data in an Excelfile. It creates a table of values in Excel giving
the numerical response values for each device number.

Response Data Export Report

Tuming Response Dt Export

Session Name: ReportsDemog3.tp
Created: 7/23/2007 257PM

(Device ID: 3FE3BFEBEBGA0BG)
(Device ID: ADOSBF)

(Device 1D: 90}

(Device ID: 43)

(Device 1D: 9}

(Device ID: 23)

Bee W
P
HRewe s
Wl ww s e
Weswe e
[P
W N
LR
s e W

Pagelofl

Results by Group Report The Results by Group Report shows a summary of correct
responses for each question by demographic groups. This
report creates an Excel file.

The report includes the following information for each
question:

the answers

an indication of the correct answer(s)



the percentage of correct responses from each
demographic group

Results by Group Report

Turning Results by Group

Session Name: ReportsResultstyGroupd7_17_07_05.tp

Created: 7/23/2007 3:08 PM
1) What s your Age Group?
1)1825
2)2530
3) 3140
4] 4150

Team 1= 65%
Team 2= 453

2.) Where i thecapital of Ohio
2) Gincinati
2 Youngstown
4] Oeveland

Team 1= 453
Team 2= 55%

3) Where is thecapital of Pennsyhvania?
1) Fittsburgh

2 Serantzn
) Philadelphiz

Team 1=25%
Team 2=75%

4) Where is the capital of the United States?

1) Washington State
2.) Washington, PA

4 Washingtan, NC
Team 1= 100%
Team 2= 100%

Pagelof3




Statistics Report The Statistics Report shows the overall correct percentage
per participant versus mean, median and mode. This report
creates and Excel file.

Statistics Report

HEEEBE === =
8§E g1 gl
A F2 2
fel gis S
ge 183 3
gF B3 B3
Bln 2= B
g " * g8
S
if
23
omp H
553 E
QxR ®
e« ®
1]
=]
35
28
3
z
3
H
k] g
& 2
£ S p
el sl
i H
|3 i g
3
8
£
g
8
5
=
g
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HEREEN
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Where Do I Go From Here?

This chapter has introduced the various report types, and has demonstrated how to view these
reports.

You are now ready to begin managing sessions. You can find information in Chapter 9: Sessions.



Chapter 8: Reports
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Sessions

TurningPoint creates session files whenever your run a TurningPoint presentation. When you save a
session, a default TurningPoint setting automatically includes the PowerPoint presentation with your
TurningPoint file. You have the option to exclude the PowerPoint presentation from the TurningPoint
session file. This function allows you to save only the TurningPoint results data without the
presentation slides. If you do NOT wish to include the PowerPoint presentation in your TurningPoint
session file, navigate to the Settings menu and, under the Misc heading, change ‘Include
Presentation’ from True to False.

The session results are stored temporarily during a session. You can save the session results to a file
to access them later. This chapter provides instructions to access and manage your TurningPoint
sessions through Turning Reports. In addition to Turning Point sessions, Turning Reports allows you
to access and manage TurningPoint Anywhere sessions.



Recall the five steps to presentation success:

-—
g

Install TurningPoint

Enter question text.

X

7,

Step One:
Create Slides

P
Where is the capital of Ohio

1. Coumbus
2 Cincienas
3 Weusgstewn
4 Chveland

nom

Py

Step Four:
Run Presentation

il

Step Five:
Save Session

Install Devices
and Manage

Settings

Five Steps to Success

Step Three:
Create
Participant List

(Optionally)
Manage Tools

(Optionally) Run Reports

— .7

{Optionally) Export Data

This chapter discusses how to save and manage sessions.



Manage and Edit Sessions

With TurningPoint, you can stop and save a session, and pick up where you left off at a later time. You
can also use a TurningPoint setting to create back-up files of your session. Knowing how to save,
resume, and delete a session gives you greater flexibility during your presentation.

This section describes how to:

Save Results from a Session
Changing the Default Save Location
Continue a Previously Saved Session
Edit Session Data

Delete Results from a Session

Save Results from a Session

TurningPoint can quickly save a session so it is available for retrieving the results or resuming the
session later.

Before You Begin

Identify a reliable location on the computer or on a data storage device where you would like to save
the presentation.

Step by Step Instructions To save a session...
1 From the Slide Show view, TurningPoint concludes the presentation.
right-click the screen. Select
End Show. Save Session

Save
Session




2 From the TurningPoint
toolbar, select the Save
Session button. (Hint: the
icon is a disk.)

3 Select the Save button.

TurningPoint displays the Save Session window that shows
the file name, file type, and where the file will be saved. The
default location is My Documents > TurningPoint > Sessions.
TurningPoint adds the date and time to the file name.

Customize the Save in and the File Name fields to edit the
location and file name, if you wish to change the default
settings. To permanently change the default location, go to
Changing Default Location on page 260.

TurningPoint saves the file in the designated location.

Note TurningPoint can save an automatic backup file
of your session. To enable Real-time Backup,
navigate to the Settings menu, select the
Settings tab, select Presentation from the
Settings Hierarchy, and select all settings.
Then, under Backup Settings, select Real-time
Backup Path and designate a location where
the backup file should be stored. After you
designate the location, it will be listed in the
Settings menu beside Real-time Backup Path.
Find more about change the default Real-time
Backup Path, go to Chapter 4: TurningPoint
Device and Settings Management

Changing the Default Save Location

Change the default save location for your TurningPoint folder. This includes your session files,

participant lists, and standards.

Before You Begin

Identify a reliable location on the computer where you would like to save your TurningPoint

documents.



Step by Step Instructions

1

In the TurningPoint Toolbar
select Tools > Settings (Hint:
It's the one that looks like a
pair of eyeglasses).

Select the Settings Tab form
the Settings window.

Select Presentation from the
Settings Hierarchy

To change the default save location...

This displays the Settings window.

a TurningPoint - Settings

Settings | Poling Test

Settings Window
EEX

Response Device
Presentation
=1 Where is the capital of Ohic
1 Columbus
2 Cincirnati
3 Youngstown
4 Cleveland
12 Wihere is the capital of Penr
1 Pittsburgh
2 Harrishurg
3 Scranton
4 Philadelphia
=3 Where is the capital of the L
1 Washington State
2 \Washington, PA
3 Washington D.C.
4 tWashington, NC
14 Wihere is the capital of New
1 Albuguerque
2 santaFe
3 Los Alamos
4 Carlshad

< I >

K3

Answer Settings
Answer Bullet Format
Chart Settings

Auto Scale Charts
Chart Colors

Chart Labels

Chart Vale Format
Standard Chart Type

Competition Settings

Default Number of Teams
Include Non-Responders
Maximum Respanders
Participants In Leaderboard
Tearns In Leaderboard

Misc

Ade-In abways loaded
Correct Point Value

Decimal Period

True

Color Scherme
Alizses

0%

‘ertical

[E3

Restore default presentation settings

(® Common Settings

© Al Settings

Dane

File Location is the first setting listed under the Application

Settings Heading



Chapter 9: Sessions

4 Select the All Settings at the Find the Misc Heading
bottom of the Settings

window. Settings Window: Misc Settings

Default Save Location Cr\Documents and Setting,

5 Under the Misc heading,
Default Save Location, click
on the file path.

A Default TurningPoint Save Path window appears.

Default Save Location Window

TurningPoint

Default TurningPoint Save Path

|C:'|,D0cuments and SettingsiuseriMy Documents | m

[ Resek to default path J

[ Apply J[ Cancel J

6 Change the Save location. You can manually enter the location or click on the box to the

right of the file path (box with ellipses) to display a Browse for
Folder window. From the browser window, you can specify
and existing folder location or create a new folder location.

Note You can restore your save location to the
default settings by selecting Reset to default

path from the Default TurningPoint Save
Path window.

388 Turning Technologies



7 Select Done. Your TurningPoint folder location has been changed.

Continue a Previously Saved Session

Resume your presentation using a saved session file. TurningPoint appends new session information
to the opened session file, allowing you to save the polling results for the presentation in one file.

Before You Begin

If the session file is saved on an external storage device, insert the device into the computer.

Locate the session you wish to open. On the computer that is running the presentation, the default
location for saved sessions is My Documents\TurningPoint\ Sessions.

Note If you did not manually save your last session,
TurningPoint automatically creates a backup
copy and stores it at My Documents\
TurningPoint\Sessions\Backup.

Step by Step Instructions To continue a previously saved session...

1 From the TurningPoint Continue Prior Session
toolbar, select the Continue
Prior Session button. (Hint:

the icon is an open folder.) Continue

Prior 5ession

TurningPoint displays the Continue Prior Session window that
shows the file name, file type, and where the file is located. The
default location is My Documents\TurningPoint\Sessions.



2 Navigate to the file you wish TurningPoint opens the previously saved file.
to open and select the Open
button.

Next Steps

From the PowerPoint menu, select Slide Show > View TurningPoint select. Use the arrow keys to
find the slide you want to be your starting point. Continue presenting the session.

Edit Session Data

You can edit TurningPoint or TurningPoint Anywhere session data after the session is saved. You
can choose to exclude a question, make a question demographic, or change answer values.

Step by Step Instructions To edit session data...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management: Edit Session

ﬁ Response Devices
A
Tools:
% Turning Reports |

Session Management 3 1.5& Export Session Data
7% Standards &4  Participant Merge [Excel)
&9 Comparative Links 8 Merge Session Files
Z& Conditional Branching &% Extract Participant List
i# Import from TestingPaint F Extract PowerPoint Presentations
@ Parser [j%) Extract Session XML File
@ Update Parser Template = | Send Session
Ranking Wizard JI AcibEession

Web(CT Wizards 4
Blackboard Wizard
_& VantagePoint
@ CuestionPoint
! Enterprise Manager
&2 | Settings
A1 Upgrade TurningPoint Receiver




2 Select Session Management The Edit Session window opens, displaying a list of session files
> Edit Session. in your sessions folder.

Edit Session Window

" o TurningPoint - Edit Session

Please select your session(s)
(&) My Session Files

ﬁ'{; @ Press F5 ko refresh the sessions list () My Backup Session Files

Mame Date e
&PM1.tpz 7/12/2007 11:15:24 AM

&1pM10.tpz 7012)2007 11:15:24 AM

89pM11.kpz 7/1202007 11:15:24 AM

89pm12.tpz 711202007 11:15:24 AM

&) pM2.tpz 7{12{2007 11:15:24 &AM

&3tz 7{12{2007 11:15:24 &M

&P tpz 7}12{2007 11:15:24 &M

& PMS.tpz 7/12/2007 11:15:24 AM

&1pM6.tpz 7012}2007 11:15:24 AM

89 pv7.tpz 711202007 11:15:24 AM

&) pMs.tpz 7{12{2007 11:15:24 &AM

&) pMa.tpz 7{12{2007 11:15:24 &M

& PriorityDemogMament. boz TIL2I2007 11:15:24 AM A

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

3 Choose a session file in one
of the following ways:

¢ Select a session file from
the list of files in your
Sessions folder.

e Select a session file from To display the backup session files in the list of files,
your backup session files. select My Backup Session Files.
* Import a session file from Use the Import Session button to open a file dialog to

another location. locate and select the session file.



4 Select the Next button to
continue.

5 Uncheck the box next to any
question in the list that you
would like to exclude from the
session.

The Edit Session window displays options for editing the
session file.

Edit Session Window: Edit Session

"u TurningPoint - Edit Session

Edit Session

Queskions -
pital of Ohig

2) Where is the capital of Pernsylvania?

3) Where is the capital of the United States?
4) whers is the capital of Mew Mexico

5) where is the capital of the United States?
&) Where is the capital of Mirginia?

[l 7y vibieres i e canital of Wirdinie?

Ansiers
Columbus
Cincinnati
Youngstown
Cleveland

r 1

The window shows a list of all questions in the session. Below
the list of question is a list of answers, which shows the
answers for the question selected in the list above.

Excluding a question will omit all data about that question
from the session file.



6

If you would like to change
the question type or value,
right-click on the question
and select the desired option
from the contextual menu
that appears.

If you would like to change an
answer value, right-click on
the answer in the answer list
and select an option from the
contextual menu that
appears.

You can change the default Correct and Incorrect point values,
or designate a question as demographic.

Edit Session Window: Change Question Value

" a TurningPoint - Edit Session "__”E‘rz|

Edit Session

Questions &

re

2) whers i Zhange question bype to a "Standard Question”

) where i Change default "Correct” point value

4 vthere i Change default "Incarrect” paint value =
s)where | Exclude question

&) Where is teTapIArOrYIFgITEY

~

[#] 71 ihere is the canital of Wirninia?

Answers
Columbus
Cincinnati
Youngstown
Cleveland

Save Session

T |

=

Demographic questions can be used in reports. Find more
information in Reports on page 341.

You can mark the answer Correct or Incorrect, assign a point
value, or clear the answer value (set to No Value).

Edit Session Window: Change Answer Value

" a TurningPoint - Edit Session

Edit Session

>

Questions

1) where is the capital of Chio

2) Wihere is the capital of Pennsylvania?

%) Where is the capital of the United States?
4) Wihere is the capital of Mew Mexico

5) Where is the capital of the United States?
&) Where is the capital of Yirginia?

[4] 71 where is the canital of Virninia?

<

ANSHErs

Columbus —

Cincinnati Change answer walue ko "Correct”

Yaungskown Change answer walue to “Incorrect”

Cleveland Change answer value to a paint value
L dear answer value

Co ] |

=




8 When you are finished A dialog opens for you to specify a location and filename for
making changes to the the session file.
session data, select the Save
Session button below the list
of answers.

9 Specify a name and location

for the exported file.

Note You should use the file extension.tpz for
session files.

10 Select the Save button. The file is saved and the dialog closes.

11 Select the Finish button to
exit the Edit Session window.

Delete Results from a Session

You can use the same presentation to create a new set of responses. The Reset menu on the
TurningPoint toolbar gives you the option of deleting the results in order to redo a session or
present a new session. You also have the option to redo only one question slide in a session. You
cannot undo the Reset function, so be certain that you wish to delete the results.

Before You Begin

If you want to view the results at a later time, save the presentation before proceeding with the
following steps.



Step by Step Instructions

1

Open the presentation. To
delete the results of one
question only, the slide with
this question should be in
view.

2  From the TurningPoint

toolbar, select the Reset
menu.

3 When you are ready to delete
the results, select either
Session, All Slides or Current
Slide.

To delete the results from a session or a single slide...

The Reset menu opens offering the options to reset either the
entire session, all the slides or simply the current slide.

Reset Session

Continue ]
hd Prior Session Se

Session

All slides

o
.| Current Slide
ey

Note Be certain that you wish to delete the results!
You cannot undo the Reset function for either
the Session, All Slides or Current Slide options.

Selecting Session resets the entire session. Selecting All Slides
resets all of the slides. Selecting Current Slide resets the
currently viewed slide only.

TurningPoint clears the results and sets the values to zero.




Where Do I Go From Here?

This chapter has demonstrated how to save, edit and manage sessions.

You are now ready to begin exporting information. You can find information in Chapter 10: Export.



Export

When you complete a session, you save the data in a TurningPoint session file (extension .tpz). Find
more information on how to save a session in Save Results from a Session on page 385.

The session file contains all the information about your presentation, including the questions and
answers, the response data, and the Participant List. This information is used to generate reports
(find more information in Reports on page 341).

Session files and can be merged with other session files and Participant Lists with other Participants
Lists to show aggregated results from your presentations. TurningPoint also allows you to share and
extract the information in your TurningPoint and TurningPoint Anywhere session files by exporting the
data into several formats.

This section describes how to:

Export Session Data

Export Results Data to a WebCT Server (Campus Edition 6.0 or Vista 3, 4)
Export Results Data to a WebCT Server (Campus Edition 4.1)

Merge Participant List

Merge Session Files

Extract Participant List

Extract PowerPoint Presentation

Extract Session Data as XML

Email Session



Export Session Data
You can export the data from a TurningPoint or TurningPoint Anywhere session file into a text file.
You can use the text file to import the data into a variety of other applications.

You can choose to export the data from the session file in one of two ways:

Export some or all of the session data to a text file where you determine the contents and format.

Export the session data using a predefined scheme for certain gradebook applications.

Step by Step Instructions To export session data into a text file...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Export Session Data

ﬁ Response Devices
r
Toculs;
% Turning Reports |
Session Management r _g, Export Session Data
=% Standards &8  Participant Merge (Excel)
=5 Comparative Links ":ﬂ Merge Session Files
54 Conditional Branching [g%  Extract Participant List
.ﬁ Import from TestingPaoint _ﬁ Extract PowerPoint Presentations
@ Parser [%j Extract Session XML File
@ Update Parser Template J—r Send Session
B# Ranking Wizard f | Edit Session
Web(CT Wizards 4
A Blackboard Wizard
_ﬁ VantagePoint
@ CuestionPoint
E Enterprise Manager
&4 | Settings
Al Upgrade TurningPoint Receiver
2 Select Session Management The Export Session window opens, displaying a list of session

> Export Session Data. files in your Session Folder.



3 Select Export Session Data
from the list of options.

4 Choose a session file in one
of the following ways:

Select a session file from
the list of files in your
Sessions folder.

Select a session file from

your backup session files.

Import a TurningPoint or
TurningPoint Anywhere
session file from another
location.

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

Export Session Data Window

" TurningPoint - Export Session Data El ] ‘@

Please select your session(s)

(&) My Session Files

& & PressFStorsfrach the sessions list () My Backup Session Files

Hame Date ~

& Current Session 7/12}2007

BPM1.tpz 7/12/2007 11:15:24 AM

B1PML0.tpz 7/12/2007 11:15:24 AM

S1PMil.tpz 7/12/2007 11:15:24 AM

Pmiz.tpz 7/12/2007 11:15:24 AM

] PMz.tpz 7/12/2007 11:15:24 AM

] PM3.tpz 7/12/2007 11:15:24 AM

8 PMatpz 7/12/2007 11:15:24 AM

8PS tpz 7/12/2007 11:15:24 AM

8 PMs.tpz 7/12/2007 11:15:24 AM

8pM7 tpz 7/12/2007 11:15:24 AM

] PMa.tpz 7/12/2007 11:15:24 AM

®prg.tpz 7/12/2007 11:15:24 &M A
r 1

To display the session files from your Sessions folder in
the list of files, select My Session Files. The Current
Session will be displayed if you have a TurningPoint
presentation open and response data has been collected.

To display the backup session files in the list of files,
select My Backup Session Files.

Use the Import Session button to open a file dialog to
locate and select the session file.



5 Select the Next button once The Export Session window displays lists of the data and
you have selected a session formats you can use to export the session file.
file.

Export Session Data: Select Export Scheme or Data
Groups

*w TurningPoint - Export Session Data

Select export scheme or data group(s) to include

Data Group
Questions and Answers
Participant Information
Responses

Stores

DUse export schemes Current Scheme: none

Narne Date

6 Choose one of these two
ways to export the data:
e Check some or all of the The following data is available for export:
boxes in the Data Group The text of questions and answers.

list to manually specify the
contents and format of the
exported text file.

Participant information, such as names and groups,
defined in the Participant List.

Participant’s responses to the questions.
Participant’s scores.

* Check the Use Export Export schemes for several gradebook applications are
Schemes box to select a available, including Angel, Easy Grade Pro, Gradebook
pre-defined exportscheme for Windows, Gradekeeper for Windows, MicroGrade,
for a gradebook Moodle for use with Moodle Participant list and
application from the Export Teacher’s Marksheet.

Schemes list. Export schemes are saved as .tpx files in the Export

Schemes folder, which is located in your TurningPoint
folder. You can use an export scheme you have copied
from elsewhere by selecting the Load an Export
Scheme button (shaped like a folder).



Using an export scheme automatically specifies the
settings available to you in the next steps to match the
format required by the application you are exporting to.
You may still choose to modify some settings, to specify
a grading scale, for example.

7 Select the Next button to The Export Sessions window displays a tabbed view for you to
continue. specify the data to be used.

Export Session Data: Include or Exclude Data—
Questions & Answers tab

" a TurningPoint - Export Session Data

Include or exclude specific data from export...

Questions & Answers | Participant Info | Responses | Scares

Questions

1. Where is the capital of Chio

2. Where is the capital of Pennsylvania?

3. Where is the capital of the United States?
4, Where is the capital of Mew Mexico

5. Whers is the capital of the United States?
6. Where is the capital of Yirginia?

7. Where is the capital of Yirginia?

8. What is the capital of Tennesses? v
Answers Walues
(%) show all answers () Show correct answers only () Do not show any answers

There are four tabs, one for each of the main groups of data you
specified whether to include in the exported file. In each area
you chose to include, you should review and modify the settings
on the corresponding tab. The next few steps explain the
settings on each tab.

8 If you chose to include the By default, all questions are checked and will be included.
question and answer data,
specify which particular
questions to include by
checking the boxes on the
Questions & Answers tab.



9 Select the Participant Info

10

tab.

If you chose to include the
participant information,
choose which fields from the
Participant List to include by
checking the boxes on the
Participant Info tab.

The Export Data window displays the Participant Info tab.

Export Session Data: Include or Exclude Data—
Participant Info tab

"w TurningPoint - Export Session Data

Include or exclude specific data from export...

Questions & Answers | Partidpant Info | Responses | Scores

Participant List Fields (FS or Right click to review or refresh participant information)
Device 1D

Last Mame

Firsk Mame

Student 1D B
Team 1

Team 2

3

|

To view the information from the Participant List, press the F5
key or right-click in the window and select Refresh Participant
List Data. This allows you to see the Participant List to help
you decide which fields you would like to include in the
exported data.

You can include the following participant information:

Device #

Last and first names

Device ID

Student ID



11

12

Select the Responses tab.

If you chose to include the
responses, choose whether
to group responses by
question or by participant by
selecting Show Responses
Horizontally or Show
Responses Vertically on the
Responses tab.

The Export Data window displays the Responses tab.

Export Session Data: Include or Exclude Data—
Responses tab

" a TurningPoint - Export Session Data

Include or exclude specific data from export...
Questions & Answers | Participant Info | Responses |Scores
() Show results Horizontally
() show results Vertically
Questions 68E.. AD... 90 43 9 23
+ Question 1 z 1
+ Question 2 1 z
= Question 3 z -
* Question 4 - 2
=+ Question 5 z2
= Question & 4
+ Quastian 7 1
+ Question & z
= Question 9 1
* Question 10 2
< Question 11 4
1

Show Responses Horizontally will group the response data by
question in the exported file. Show Responses Vertically will
group the response data by participant in the exported file.



13

14

Select the Scores tab.

If you chose to include the
scores, specify the following
settings:

¢ Selectwhetherto calculate
scores based on
Correct/Incorrect values or
based on point values.

» Select to show scores as
percentages, as letter
grades, as point values, or
any combination by
checking the boxes.

e Specify the grading scale
by selecting ranges for the
letter grades from the
drop-down menus.

The Export Data window displays the Scores tab.

"w TurningPoint - Export Session Data

Include or exclude specific data from export...

Questions & Answers | Participant Info | Responses | Scores

Export Session Data: Include or Exclude Data—
Scores tab

=)

(&) Calculate using correct fincorrect values

() Calculate using point values Tatal points possibls

o]

Show SCOPE a5 percent
[ 5how score as letter

[ 5haw score as point value

Select questions ko be treated as bonus questions
{bonus information is not included in schemes)

Question

where is the capital of Ohio

where is the capital of Pennsylvania®

Adijust the grading scale
Scale is from 0 to 100

where is the capital of the United States?
wihers is the capital of New Mexica
where is the capital of the United States?
where is the capital of Yirginia?

where is the capital of virginia?

w'hat is the capital of Tennessee?

10, What is the capital of Michigan?

11, What is the capital of Delaware?

R

o o o |

z
L E E S

T o0 ®®»
=
2

Cancel

If you base scores on Correct/Incorrect values, the
percentage score is calculated by dividing the
participant’s number of correct answers by the number
of total answers. If you base scores on point values, the
percentage score is calculated by dividing the
participant’s number of correct answers by the point
value you specify in the box provided.

You may include any or all of these ways of
representing the scores in the exported file.

The default ranges show a typical grading scale. You
can alter the grading scale by selecting a new range. To
change values upward (grade on a stricter scale), start
from A and work your way down the list to specify the



* Designate questions as
bonus questions (not to be
included in the score
totals) by checking the
boxes.

15 When you have finished
modifying the settings on the
applicable tabs, select the
Next button.

16 Specify the order of the fields
in the exported file by moving
the fields up and down the list
by selecting the Move Up and
Move Down buttons.

ranges. To change values downward (grade on an easier
scale), start from D and work your way up the list.

Questions you designate as bonus questions are not

included in the total number of questions for calculating
scores, but are included in a participant’s number correct.

The Export Data window displays a set of settings for specifying
the format of the exported file.

Export Session Data: Select Format

" TurningPaint - Export Session Data

Select order and delimiter format...

~| gy @pelmked format

= Data is delimited
° [ 2] by a specific
@ Answers e character
° Device ID

. O Fixed Width
Last Name © pr— Data s delimited by
° First Name: Q15 a fixed number of

° Student ID o - spaces

@ Team 1

@ Team 2

o Columbus Determines what
delimiter is used for

® Cincinnati Join Fields

° Youngshown

@ Scares (percent)

@ Cleweland

L .L @ Example export:
"60EE3BFEBEBG40BC", "Washington”,"Gearge”, "1 778", "True", "™, "™, "™, "True",","0 |
< | &
r 1

There is an example entry at the bottom of the window showing
a sample based on the settings specified. Observe this example
as you change the format settings in the next few steps to
ensure it matches your expectations.

Additionally, you can join two fields together or include blank
fields in the exported file. Use the Insert A Blank Field and Insert
a Join Field buttons below the list of fields to insert a join field or
a blank field. You can move join fields and blank fields up and
down the list just like the other fields.

A join field joins the previous field and the following field into a
single field. You might wish to do this with the First Name and
Last Name fields, for example.



17 Specify whether to create a

18

19

delimited or fixed-width file.

Specify whether to use
double quotes, single quotes,
or no quotes to enclose the
text in fields.

When you have finished
modifying the settings for the
format of the file, select the
Next button.

A blank field simply puts a blank separator between fields.
Depending on how you will use the exported file, you may
need to separate some data with blank fields.

A delimited file includes a “delimiter” between each of the
fields. You can select a comma, semicolon, tab, space, or
other delimiter.

A fixed-width file uses fields of a specified width (number of
characters). You can choose a width for the fields.

The format you choose depends on how you will use the
exported file.

Note You should use either double or single
quotes for the text qualifier if you are
exporting a fixed-width file or using spaces
as delimiters in a delimited file. Without
quotes, the field boundaries in the exported
file will be impossible to interpret correctly.

The Export Data window displays the data in the format to be
exported.

Export Session Data: Verification

"w TurningPoint - Export Session Data

Final verification of export...

"6BEE3BFEBEBG4NBC","Washington”, "George”,"1776", "True"
"A003EF","Franklin”,"Benianmi
d

"Where is the capital of Pennsylvania?",
"Where is the capital of the United States?","wiashington Stal

shingtar
"Where is the capital of New Mexico”,"Albuquerque”, "Santa F

Los Alamos"

"where is the capital of Yirginia?","Alexandria”
“Where is the capital of Virginia?","alexandria”,
"What is the capital of Tennesses?","G
"Which one is the United States Flag?”, R

"yhat is the capital of Michigan?","Ann Ar "Grand Rapids", "East Lansing","
"What is the capital of Delaware?","Dover”,"wilmington”, "Rehobath Beach”,"Georgetowr

< >




20 To save your export data,
select the Save button
(shaped like a document with
a disk).

21 Specify a name and location
for the exported file.

22 Select the Save button.

23 Select the Finish button to
exit the Export Data window.

Below the data are two buttons. The first, shaped like a
document and a disk, saves the export file. The second, shaped
like a disk, saves the format as an export scheme you can reuse
for other session files.

A dialog opens for you to specify a location and filename for the
exported file.

The file is saved and the dialog closes.

Optionally, you can also select the Save Export Scheme button
(shaped like a disk) to create an export scheme you can reuse
to save the data from other session files in the same format.
Specify a location and filename for the export scheme in the
same way.

If you forgot to save before selecting Finish, a message window
opens containing ‘Are you sure you want to exit without saving
an export?’ Select Yes to exit without saving the session file;
select No to save before exiting.



Export Results Data to a WebCT Server (Campus Edition 6.0 or
Vista 3, 4)

If you are using WebCT CE 6.0/Vista 3, 4, follow the steps below to export results data. Instructors
can perform the same functions; they can export results data from participants to an available
WebCT server and send grade reports to their students via WebCT email.

However, with WebCT CE 6.0/Vista 3, 4, instructors may select specific TurningPoint or
TurningPoint Anywhere sessions to upload and then enter the name of the assignment and the
maximum point value for responses.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves
the results data to this file.



Step by Step Instructions To export data to a WebCT 6.0/Vista 3, 4 Server...

1 From the TurningPoint TurningPoint displays a window asking which task you would
toolbar, select Tools > like to perform with the WebCT Wizard.
WebCT Wizard > Campus
Edition 6.0/Vista 3, 4. WebCT Wizard > Campus Edition 6.0/Vista 3,4

Response Devices

%  Turning Reports

Session Management 4
standards

Comparative Links

Conditional Branching

Import from TestingPoint

Parser

Update Parser Template

H & & B 5K

Ranking Wizard

WebCT Wizards * | & Campus Edition 4.1

Blackboard Wizard | & Campus Edition 6.0/ Vista 3, 4

VantagePoint
QuestionPoint

Enterprise Manager

Settings

-k A

Upgrade TurningPoint Receiver

2 Select the button next to WebCT Wizard: Select Task

Export Student Data to the

WebCT Gradebook/Email WebCT Wizard
Student Reports.

‘what would you like ta da?

) Impart Participant Lists

(%) Export Student Data ta the ‘WebCT Gradebook /Email Student Reports

=3 e )



3 Select the Next button. TurningPoint displays the WebCT Log-In window.

4  Enter your login information. WebCT Wizard: Login
= TurningPoint - WebCT Wizard X

WebCT Log-In

Server Mame (IP): |vista4partner‘wehct.cnm

User Marne: |sdkdua|

|
Fort Number: |3602 |
|
|

Password: |"‘**"‘****

[if ot wsing *webCT sign-in, please leave password blank)

vy

=3 == 2N

TurningPoint saves the Server Name (IP) and the Port
Number. You must enter your username and password. The
system prompts you for the Institution’s name and then
displays all courses associated with your user name and
password.

5 Select the Next button. TurningPoint displays a window asking you to select the
institution you belong to.

6 Select your institution. WebCT Wizard: Select Institution

| TurningPoint - WebCT Wizard L

WebCT Institution Selection

Flease select the institution you belong to:
Turning Institution

| Carcel |



7 Select the Next button.

8 Select the course you wish to
export data to.

9 Select the Next button.

10 Select the Session you wish
to upload.

TurningPoint displays a window asking you to select the course
to export data to.

WebCT Wizard: Select Course
a TurningPaint - WebCT Wizard |

WebCT Course Selection

Please select the course vou wish to export bo:

[ Coes ) oo J)_ten |

TurningPoint displays a window asking you to select the session
you wish to upload.

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

WebCT Wizard: Select Session
= TurningPoint - WebCT Wizard X

WebCT Session Selection

() My Session Files () My Backup Session Files

Date |
1 =
Zrarget_102_first tpz 101542005 5:21:20 P
Attendance 092205.tpz 10/15/2005 5:21:20 PM
Autodesk_Thursday. tpz 12/3/2005 2:56:14 PM
Auvtodesk_\Wednesday.tpz 1143042005 7:29:25 P
CIE Tuesday results.tpz 10415/2005 5:21:23 PM
Copy of Copy of fond Mew Session 8 25 2005 8 48 AM tpz 1041542005 5:21:25 PR
Copy of Copy of News Session 11.1.2005 207 PM.tpz 11412005 2:40:01 PM
Copy of Copy of target_102_first_rash.tpz 101542005 5:21:33 P
Copy of faod Mew Session 8.24.2005 11.05 AM.tpz 1041542005 5:21:33 PM
Coow of food Mew Session 825 2005 5 43 Ak to; 10M5/2005 52154 P ™

= ek e |



11 Select the Next button.

12 Enter the name of the

WebCT Wizard: Export Preview/Options
assignment and a maximum

point value for responses. WebCT Export Preview/Options

TurningPoint displays an Export Preview/Options window
asking you to enter the name of the assignment for the
session and a maximum point value.

w'ebCT D

studentl
student?
student3

Mame

webct_demo_ 103581, Student 103521001, Demao

One, Student
Two, Student
Three, Student

Score
100
100
100
100

Add grades shown above to 'WebCT gradebook

Column Header Msimum Value

[ Email individualized reports to students thraugh ‘webCT

You can also select the checkbox to email individualized
reports to students through WebCT.

13 Select the Finish button. TurningPoint displays a confirmation message that the export

was successfully completed.

14 Select the OK button.

WebCT Wizard: Export Complete

TurningPoint

L.
- | J Export successully completed,

You can now login to WebCT and view the results data in your

Gradebook.

[eeo ) Feir )




Export Results Data to a WebCT Server (Campus Edition 4.1)

TurningPoint allows class instructors to quickly export results data from participants to an available
WebCT server. With this function, instructors who test students through TurningPoint can easily save
participants’ test scores for grading purposes.

TurningPoint also lets instructors send grade reports to their students via WebCT email. Instructors
enter their WebCT IDs and select the checkbox to email reports to students. Instructors can then view
the sent mail and the new results that have been posted to the gradebook.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves the
results data to this file. You must know the Column Name in this gradebook where the results data
should be saved. The Column Name may have any title, but you must know the exact title and provide
it to the WebCT Wizard.



Step by Step Instructions To export results data to a WebCT 4.1 Server...

1 From the TurningPoint TurningPoint displays a window asking which task you would
toolbar, select Tools > like to perform with the WebCT Wizard.
WebCT Wizard > Campus
Edition 4.1. WebCT Wizard > Campus Edition 4.1

Response Devices

%  Turning Reports

Session Management 4
standards

Comparative Links

Conditional Branching

Import from TestingPoint

Parser

Update Parser Template

H & & B 5K

Ranking Wizard

WebCT Wizards L Campus Edition 4.1

t A% E

Blackboard Wizard Campus Edition 6.0/ Vista 3, 4

e e

VantagePoint
QuestionPoint

Enterprise Manager

Settings

Upgrade TurningPoint Receiver

-
=1

2 Select the button next to WebCT Wizard: Select Task
Export Grade Data. ¥ o WehCT Wizard

WebCT Interface

Select a Task ko Perform

O Import Patticipant List
(%) Export Grade Data

(O Upload Student List

3 Select the Next button. TurningPoint displays the WebCT Log-In window.



4 Enter your login information.

5 Select the Next button.

6 Select the class to which you
want to export data. The
class should match the
Participant List you used.

7 Enter the Column Name.

WebCT Wizard: Login

"a WebCT Wizard

WebCT Log-In
[Jusing S5L Encryption
Server Mame (IP): | |
Part: Nurber: | |
User Mame: | |
Password: | |

TurningPoint saves the Server Name (IP) and the Port Number.
You must enter your username and password. The system
prompts you for the Institution’s name and then displays all
courses associated with your user name and password.

TurningPoint displays a window asking you to select the class
for which you have new data.

WebCT Wizard: Select Class

X

= WebCT Wizard

WebCT Class Select

Please check the classes you would like to
import from the lisk below;

[ P10t
[ matHIO1

Maxirnum Yalue For Colurnn: l:l

oo JL i ]

The Column Name is the title of the column in the class
gradebook to be used to store the scores for this particular
activity or test.



8 Enter the Maximum Value for
Column.

9 Select the Finish button.

The Maximum Value for Column is the total possible score a
participant could achieve for this particular activity or test or
simply the maximum number of characters accepted.

TurningPoint displays a confirmation message and then
closes the WebCT Wizard window. The results data should
now appear in the column you designated in the file on the
WebCT server.



Merge Participant List

Participant Merge allows you to combine multiple participant lists with multiple sessions of
TurningPoint presentations to generate a report based on a common field (Student ID, Device ID,
etc.). The report shows the the total scores of the sessions in an Excel file.

Step by Step Instructions To merge Participant List...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Participant Merge

Response Devices i - _' ; ‘?
| it e

Participants Select a Help

i v Participant List
% | Turning Reports l
Session Management [ l_a‘ Export Session Data
C?.‘J Standards &8  Participant Merge (Excel)
& Comparative Links T8 Merge Session Files
S Conditional Branching &k Extract Participant List
@ Import from TestingPaint B Extract PowerPoint Presentations
@ Parser ) Extract Session XML File
/@ Update Parser Template | sSend Session
Ranking Wizard '—ﬁ’ EOH eesion
WebCT Wizards 4
Blackboard Wizard
& VantagePoint
e QuestionPoint
E Enterprise Manager
&2 Settings
41 Upgrade TurningPoint Receiver




2 Select Session Management
> Participant Merge (Excel).

3 Add a Column.

This displays the Participant Merge window.

Participant Merge Window

" a Participant Merge g‘
Aevailable Fields For Merge
e —
€7 Phi1 ) Reports
€1 P1i10 &) Report:Demog
[0 ) Report:Demog?
€7 Phi12 &) Report:Demog?
o & ppiz &) ReportsDemogEDIT
[ ] &) Report:Demalnly
9 8] P4 8] Reportstloment
= BIPMs &) RepartsRanking
) & FME 8 ReportsResultsbyoup
8]PM7 8] Reports3caringStandard
] P 8] ReportsStandards
8P
@] PriorityDemoghoment
£dd & new columin to the Tuming Participant Merge Report
I | ([ Column |
l 1

Initially, the left pane is empty. This is where your new column
and sessions to be merged will be displayed. Above the left
pane is the Available Fields for Merge drop-down box. Below
the left pane is the Add Column text box and button.

The right pane displays all of the sessions available to be
merged. Above the right pane are the Percentage Correct and
Points radio buttons.

TurningPoint displays the percentage correct or points in the
added column when the sessions are merged.

Participant Merge Window: Add Column

Ta Participant Merge E\
iwailatle Fields For Merge
s o @R
LA ©] Reparts
®1PM10 ® ReportsDemog
B8P ® ReportsDemog?
®YPM1z ®] ReportsDemog3
o 8Pz ®] ReportsDemogEDIT
®1PM3 ] ReportsDemolnly
© eipws ©] RisportsMoment
= (®IPMS © ReportsRanking
G Slewe €] ReportsResultsbyGroup
e]PM7 @] ReportsScoringStandard
(R @) ReportsStandards
8]PM3
8] PriorityD emaahoment
#dd a new eolumn ta the Tuming Panicipant Meige Report
[Clasd | [[dd Calun |
l ) 1




4 Select the sessions you want
to merge from the list of
sessions.

Highlight the sessions and use the left (<) button to add the
sessions to your column. Use the right (>) to remove sessions

from your columns.

Participant Merge Window: Select Sessions

" Participant Merge El

twailable Fields For Merge
4 (3 Percentage Corect ) Paints
(& Class 8 PM1
IPM10
IPM11
©IPM12 g
o 1Mz d
®1FM3 8 ReportsDemolinly
© |eips ] Reportshoment
= [®IPMs 8 ReportsFianking
g |2 ] ReportsFiesultsbyGroup
®FM7 ] ReportsSeoingStandaid
e ] ReportsStandards
®1FM3
2] PrioiityDemoghoment
#dd & new column to the Turming Participant Merge Repart
[ | [2dd Colurnr ]

I [

|

Repeat steps 3 and 4 until you have created all of the columns
you want added to the Participant Merge Report.



5 Alternately, remove all of the
columns by selecting the
button that looks like a trash
can.

6 Select the Field you want to
merge the Participants Lists
under from the Available
Fields for Merge.

7 Select whether the report
should display Percentage
Correct or Points.

The sessions will be merged based on the selected value.
Only fields that are common between the participant lists will
be available from the drop-down menu.

Participant Merge Window: Select Merge Field

" u Participant Merge El

Available Fields For Merge

(% Percentage Conect ) Paints

8PM1 ) Repots
Last Name 81PM1D ) RepaitsDemog
sacenlD BIFM1] 8] FeporisDemog?
Tean2 SN2 1 FeporsDemog?
LS ] FicpaitsDemogEDIT
O o 8] FicpotsDemalinly
© eipws ] Fieportsoment
& |®IRMs 8] FicpatsRanking
g (TP 81 FiepoiteResulsbyGiroup
eipN7 1 FiepoitsSicoringStanderd
[ 1 FiepoiteStandards
o1FMs
] PriarityD emoghoment

Add anew column ta the Tuming Patticipant Merge Fepart

| [[4dd ol |

: )=




Select Merge. TurningPoint generates a report in an excel file.

Tuming Participant Merge Results

Created: 71122007 12:50:54 P

Merge Value Lastlame | FirstHame Class Total
BBEEJDFE BEBG40BC Geoige a0% 40%
ADD3EF Franklin Benjamin 55 .56% 55.56%
an Hamifton Blexander 25% 25%
a3 Adams| John @ 85% E5%
a Lincoln Ahraham 75% 75%
23 Ford Gerald 0% 50%
12 Lee Robert E 125% 12.5%
198 Ross Betsy 100% 100%
ADDSHF Stowe Harriet 37 5% 37 5%
86CCIBFEBEDT2TAA Martha| Washington 0% 0%
s Abigail Adaim s 3T 5% 5%
BOMFY Grant Ulysses 25% 25%




Merge Session Files

You can merge multiple TurningPoint or TurningPoint Anywhere session files together to create a
single session file, from which you can generate reports and extract data.

This is especially useful if you have session files from multiple presentations given to the same
participants. You can aggregate the data from all the presentations into a single file with all the
responses from each participant.

Conversely, if you gave the same presentation to several groups of participants, you could
aggregate the responses from all participants into a single session file.

Before You Begin

All the session files you wish to merge must be in a single location (usually your Sessions folder). If
the session files are in different locations, move them all to your Sessions folder before you begin.

Step by Step Instructions To merge session files...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Merge Session Files

x Response Devices
"
Toolr;
52 Turning Reports |
Session Management ') _,j* Export Session Data
=% Standards &4  Participant Merge [Excel)
=5 Comparative Links T3 Merge Session Files
54 Conditional Branching @l | Extract Participant List
i# Import from TestingPaint ﬂ Extract PowerPoint Presentations
@ Parser %y Extract Session XML File
@ Update Parser Template J—r send Session
Ranking Wizard [ Edit Session
WebCT Wizards 3
A Blackboard Wizard
_& VantagePoint
e CuestionPoint
! Enterprise Manager
&2 | Settings
A1 Upgrade TurningPoint Receiver




2 Select Session Management
> Merge Session File.

3 Selectone of the session files
to be merged in the list.

The Merge Session Files window opens, displaying a list of
session files in your Sessions folder.

" TurningPoint - Merge Session Files

Please select your session(s)
() My Session Files

B & PressF5to refresh the sessions list )My Backup Session Filss

Nams Dats ~
M1 tpz 7/12/2007 11:15:24 AM

S1pMin.tpz 7/12(2007 11:15:24 AM

B1pMi1.tpz 7/12(2007 11:15:24 AM

@)pM1z.tpz 7112{2007 11:15:24 &M

@pMz tpz 7112{2007 11:15:24 &M

&pM3.tpz 7112{2007 11:15:24 AM N
&pM4 tpz 7H12j2007 11:15:24 AM

)pMs tpz 7/12f2007 11:15:24 AM

&) pme tpz 7/12/2007 11:15:24 AW

&)pM7 tpz 7112{2007 11:15:24 &M

@pMa tpz 7112{2007 11:15:24 &M

@pMa.tpz 7112{2007 11:15:24 AM

'1Pr\nrit DemnqMoment . tpz 7/12i2007 11:15:24 AM v
[0 1nclude PowerPoint Presentations {This could increase the size of the merged session dramatically)

Open T Reports 1

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

Merge Session Files Window: Select Files

" TurningPoint - Merge Session Files

Please select your session(s)
(&) My Session Files

B & PressF5to refresh the sessions list )My Backup Session Filss

Marne Date ~
€] FriorityDemogMoment tpz 7[12}2007 11:15:24 AM

& Reports.tpz F/12f2007 11 AaM

€ ReportsDemagEDIT bpz 7[12{2007 11:37:44 A0

€ ReportsDemadnly tpz 7[12}2007 11:15:24 A0

& Reportstoment, tpz 712j2007 11:15:24 AM

&) Reportshanking. tpz TF/12§2007 11:15:24 AM

& RepartsResultsbyGroup. tpz 7[12{2007 11:15:24 AM
®]RepartsSeoringStandard.tpz 7[12{2007 11:15:24 AM

€ ReportsStandards.tpz 7[12{2007 11:15:24 A0 J

v
[0 1nclude PowerPoint Presentations {This could increase the size of the merged session dramatically)
Open Turringon Reports 1|




4 Select additional files to be Repeat this step until all the files you would like to merge are
merged in the list by holding selected.
down the Control key and
clicking on the files.

5 Optionally, check the box to If you include the presentations in the merged session file, the
include the PowerPoint slides from the presentations of each of the merged files are
presentations in the merged put together into a single presentation saved in the merged
session file. session file. This may greatly increase the size of the merged

session file.

6 Select the Merge button A dialog opens for you to specify a location and filename for
below the list of files. the merged session file.

Merge Turning Session Dialog Box

Merge Turning Session

Save in: V| 3 ? $ [~

: ChBackup =0 = re
23 ChReakTime =T EL
My Recent [ChSave PM12 Re
Docurmerts |2 Sereenshats @PriorityDemogMoment @ Re
Mew Session 7-16-2007 4-25 PM Reports Re
@ Mew Session 7-16-2007 4-52 PM ReportsDemog Re
Desktop P ReportsDemogz Re
Pz ReportsDemogs Re
PIM3 ReportsDemogEDTT Re

&= Prag ReportsDemoOnIy

My Dacuments fn FMS ReportsMomz.ant
PG ReportsRanking
_ =l PM7 ReportsRasuItsbyGroup
-:fj.\g @ Prag @ReportsRBsuItsbyGroupD?_l7_07
. = P9 ReportsResultsbyGroupl?_17_07_02
tdy Computer
< | b4
‘;‘] File narne: |Merge 7-17-2007 9.47 v | I Save l
—

My Metwork Save as bype: | Tuming Session (*.tpz] v | [ Cancel ]

7 Specify a name and location

for the exported file.

Note You should use the file extension .tpz for
session files.




8 Select the Save button. The file is saved and the dialog closes.

You can access TurningPoint Reports by selecting Open
TurningPoint Reports located next to the Finish button.

9 Select the Finish button to
exit the Merge Session Files
window.

Next Steps

You can now generate reports or extract other data from the merged session file, just as if it were an
original session file.



Extract Participant List

You can extract the Participant List from a TurningPoint or TurningPoint Anywhere session file. This
is especially useful if you have a session file but have lost the Participant List file or if you set up the
list on a different computer.

Step by Step Instructions To extract a Participant List...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Extract Participant List

Response Devices

% Turning Reports

Session Management 3 l_a' Export Session Data
=% Standards &4  Participant Merge [Excel)
5& Comparative Links tﬂ Merge Session Files
5 Conditional Branching &L Extract Participant List
@ Import from TestingPaint i Extract PowerPoint Presentations
@ Parser [j4j Extract Session XML File
@ Update Parser Template = | Send Session
Ranking Wizard 'j EIM SR

Web(T Wizards 4
Blackboard Wizard
ﬂ VantagePoint
@ CuestionPoint
E Enterprise Manager
&2 | Settings
A1 Upgrade TurningPoint Receiver




2 Select Session Management The Extract Participant List window opens to display the session
> Extract Participant List. files in your Sessions folder.

Extract Participant List Window

" TurningPoint - Extract Participant List

Please select your session(s)
() My Session Files

B & PressF5to refresh the sessions list )My Backup Session Filss

Marng, Date fad
SPM1 tpz 7}12/2007 11:15:24 A4M

8pMin.tpz 7/12(2007 11:15:24 AW

B1pMi1.tpz 7/12(2007 11:15:24 AM

@)pM1z.tpz 7112{2007 11:15:24 &M

@pMz tpz 7112{2007 11:15:24 &M

&pM3.tpz 7112{2007 11:15:24 AM

&pM4 tpz 7H12j2007 11:15:24 AM

)pMs tpz 7/12f2007 11:15:24 AM

&) pme tpz 7/12/2007 11:15:24 AW

&)pM7 tpz 7112{2007 11:15:24 &M

@pMa tpz 7112{2007 11:15:24 &M

@pMa.tpz 7112{2007 11:15:24 AM

aaIF’Mnrit DemnqMoment . tpz 7/12i2007 11:15:24 AM v

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

3 Choose a session file in one
of the following ways:

* Select a session file from
the list of files in your
Sessions folder.

* Select a session file from To display the backup session files in the list of files,
your backup session files. select My Backup Session Files.
* Import a session file from Use the Import Session button to open a file dialog to

another location. locate and select the session file.



4  Select the Extract Participant A dialog opens for you to specify a location and filename for
List button below the list of the Participant List file.
files.

Extract Participant List Dialog Box

Import a Participant List

Savein |@Pallicipants V| ) ¥ £ -
L0

4 (L) Templates
My Recent Hlstorlc Men.tpl
Documents Mew List 7,11,2007 2,51 PM.tpl
Partic 1.tpl
@ Partic 2.kl
Desktop Presidents. tpl
=] Teams tpl

N

fy Documents

hdy Computer
fhe File narne: teportsDemog3 Participant List] V| I Save 1
My Netwark | Seve o e  Participant List [*1pl] | [ coreel |
5 Specify a name and location
for the exported file.
Note You should use the file extension .tpl for
Participant List files.
6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to
exit the Extract Participant
List window.

Next Steps

You can now edit the Participant List or use it in a presentation. Find more information in Chapter 5:
Track Participants and Teams.




Extract PowerPoint Presentation

You can extract the PowerPoint presentation from a session file. This is especially useful if you have
a session file but have lost the corresponding PowerPoint presentation or if you created the
presentation on a different computer.

Step by Step Instructions To extract a PowerPoint presentation...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.

Select Session Management > Extract PowerPoint
Presentations

Response Devices
%% | Turning Reports

Session Management 4 |_{3b Export Session Data
ng Standards &8  Participant Merge (Excel)
&p  Comparative Links ':tﬂ Merge Session Files
Z4 | Conditional Branching &k Extract Participant List
ﬁ Import from TestingPoint ,_ﬁ Extract PowerPoint Presentations
i@ | Parser [} Extract Session XML File
/@ Update Parser Template j—r send Session
B Ranking Wizard 4 Edit Session

WebCT Wizards 3
Blackboard Wizard
ﬂ VantagePoint
6 QuestionPoint
E Enterprise Manager
&d | Settings
4% Upgrade TurningPoint Receiver




2 Select Session Management The Extract PowerPoint Presentations window opens,
> Extract PowerPoint displaying a list of the session files in your Sessions folder.

Presentations.
Extract PowerPoint Presentations Window

" TurningPoint - Extract PowerPoint Presentations

Please select your session(s)
@ My Session Files

= @ Press FS bo refrash the sessians list My Backup Session Files

Narme: Date ~
8)PHLtpz 7/12/2007 11:15:24 AW

&)PHI0.tpz F/12/2007 11:15:24 A

B)PH1 L.tz FH2IZ007 11:15:24 AW

®1pH12.0pz F/12}2007 11:15:24 AW

®1phz.tpe F/12}2007 11:15:24 A

®)pHz.tpz F/12J2007 11:15:24 AW

©)pha.tpz 7/12/2007 11:15:24 AW

&)PH5.tpz 712/2007 11:15:24 A

8)PH6.tpz FI12/2007 11:15:24 AW

8)pH7.tpz F/12}2007 11:15:24 AW

®)phiz.tpz F/12}2007 11:15:24 AW

®)pHg.tpz F/12}2007 11:15:24 AW

@) PriorityDemogtoment. tpz 7/12}2007 11:15:24 &M v
[ Extract FowerPoint Fresentation |

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

You can also import a session using the Import Session
button above the list of files (shaped like a folder). This allows
you to use a session file you have copied from elsewhere.

3 Choose a session file in one
of the following ways:

¢ Select a session file from
the list of files in your
Sessions folder.

e Select a session file from To display the backup session files in the list of files,
your backup session files. select My Backup Session Files.
e Import a session file from Use the Import Session button to open a file dialog to

another location. locate and select the session file.



4 Select the Extract
PowerPoint Presentation
button below the list of files.

5 Specify a name and location
for the exported file.

6 Select the Save button.

7 Select the Finish button to
exit the Extract PowerPoint
Presentations window.

A dialog opens for you to specify a location and filename for the
PowerPoint presentation.

Extract PowerPoint Presentations Window: Export Dialog
Box

Export TurningPoint PowerPoint presentation

Savein | D tdy Documents v ‘ ¢] 7 ® [
Y ICT)Documents
i EB ICZ)My Maps
My Recent @MY Music
Documents @My Pictures
lEMy Videos
@ ElPowaernt Presentations
Desklop I TestingPoink
I TurningPoint
——
Ay Documents
My Computer
o File: narne: Eitale Capitals V| [ Save I
My Network | Save as type: | PowerPaint Presentation [*. ppt) “ | [ Cancel ]

Note You should use the file extension .ppt for
PowerPoint presentations.

The file is saved and the dialog closes.



Extract Session Data as XML

You can extract your TurningPoint or TurningPoint Anywhere session data into an XML file. The
XML file is a text markup format that you can use to exchange and manipulate the data.

Step by Step Instructions To extract the session data XML file...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Extract Session XML File

Response Devices

%% Turning Reports

Session Management * | [4, | Export Session Data
=% Standards &8  Participant Merge (Excel)
ﬁ Comparative Links 'lta Merge Session Files
54 Conditional Branching il | Extract Participant List
Iﬁ Import from TestingPoint i Extract PowerPoint Presentations
@ Parser [%) Extract Session XML File
@ Update Parser Template j—r send Session
B Ranking Wizard '-\"I SN

‘Web (T Wizards 4
Blackboard Wizard
ﬁ VantagePoint
e CuestionPoint
E Enterprise Manager
42 | Settings
A1 Upgrade TurningPoint Receiver




2 Select Session Management The Extract Session XML File window opens, displaying a list of
> Extract Session XML File. session files in your Sessions folder.

Extract Session XML File Window

'_. TurningPoint - Extract Session XML File

Please select your session(s)
(&) My Sessian Fles

& & Press FS to refresh the sessions list (O My Backup Session Files

Marme Date L]
89pM1 tpz 7112/2007 11:15:24 AM

89pM10.tpz 712/2007 11:15:24 A4M

B1PM11.tpz 712/2007 11:15:24 AM

8pM1Z.tpz 71122007 11:15:24 AM

1Mz tpz 7/12f2007 11:15:24 AM

8]pm3 tpz 7/12/2007 11:15:24 AW

9pM4.tpz 71212007 11:15:24 A4M

&9pMs tpz 71212007 11:15:24 A4M

89pM6 tpz 712/2007 11:15:24 AM

©9pM7 tpz 71122007 11:15:24 AM

)pMa tpz 7/12f2007 11:15:24 AM

)P tpz 7/12/2007 11:15:24 AW

&) PriorityDemogMoment tpz 7/12i2007 11:15:24 AM 4

You can also import a session using the Import Session button
(shaped like a folder) above the list of files. This allows you to
use a TurningPoint or TurningPoint Anywhere session file you
have copied from elsewhere.

You can toggle which files are displayed in the list by selecting
My Session Files or My Backup Session Files. Find more
information about where your session files are stored in Save
Results from a Session on page 385.

3 Choose a session file in one
of the following ways:

* Select a session file from
the list of files in your
Sessions folder.

» Select a session file from To display the backup session files in the list of files,
your backup session files. select My Backup Session Files.
* Import a session file from Use the Import Session button to open a file dialog to

another location. locate and select the session file.



4  Select the Extract Session A dialog opens for you to specify a location and filename for
XML File button below the list the XML file.
of files.

Extract Session XML File Dialog Box

Export Turning Session Data to XML

Save in: ‘DMy Documents V| € | ? > E-

. | Documents

{ 23 1My Maps
My Recent My Music
Diocuments @My Fictures

IEMV Yideos
@ ElPDwerPoint Presentations

Desktop E]TastingPoint
E]Turningpnint
by Documents
fdy EI_Iol"'n\iter
F_ Filz name: ‘ Fie hd | [ Save 1
My Metwork. | Save as type: ‘XML Dacument [*.=ml) v| [ Cancel ]
5 Specify a name and location
for the exported file.
6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to
exit the Extract Session XML
File.



Email Session

You can use Session Management to quickly and easily send one or more TurningPoint or
TurningPoint Anywhere session files by email.

Before You Begin

To use this feature, you must have access to the internet on the computer that has TurningPoint
installed.

Step by Step Instructions To email a session file using Outlook...

1 Select Tools in the The Tools menu opens.
TurningPoint toolbar.
Select Session Management > Send Session

Response Devices

%% | Turning Reports

Session Management k I_a. Export Session Data
CgJ Standards &8  Participant Merge (Excel)
&b Comparative Links T4 Merge Session Files
54| Conditional Branching &k Extract Participant List
#  Import from TestingPoint ,_ﬁ Extract PowerPoint Presentations
i | Parser {4} Extract Session XML File
/@ Update Parser Template —d  Send Session
B Ranking Wizard Cff | Edit Session

WebCT Wizards 4
[ EBlackboard Wizard
ﬂ VantagePoint
e QuestionPoint
E Enterprise Manager
&4 Settings
4% Upgrade TurningPoint Receiver




2 Select Session Management
> Send Sessions.

3 Enter the email address you
want to send the session
file(s) to in the To box.

4  Enter your email address in
the From box.

5 Enter a subject for the email
in the Subject line.

6 Optionally, add a message to
the email in the space
provided.

7 Select File > Attach

Session(s).

The Send Sessions window opens, displaying a blank email

form.

" a TurningPoint - Send Session(s)

Fle  Tools

Send Sessions Window
&

Tox “

From: ‘

Subject: ‘

Body:

Please use valid email addresses and attachments

-1

You may enter more than one email address. Separate
multiple email addresses by semicolons.

If you choose not to add a message, the body of the email will

be left blank.

This opens a window displaying a list of sessions files from

your Sessions folder.



8 Choose a session file.

9 When you have selected all
the files you would like to
send, select the Open button
to continue.

From this window, you can also navigate to any other location
where TurningPoint or TurningPoint Anywhere session files are

located.

Open

kc)

My Recent
Documents

=

Deskiop

-

My Documents
My Computer

My Netwark

Send Sessions: Select a Session

P

Lok i |L§ Sessions V| <] ¥ [ -
[C)Backup PME Re
[RealTme PMa = re
Geagraphy 101 PMID EI Re
Hew Session 7-16-2007 4-25 PM PML1 EL8
Hew Session 7-16-2007 4-52 P PMLZ EL8
Mew Session 7-17-2007 5-04 PM PriorityDemogMoment [ re
Mews Session 7-24-2007 2-33 PM Reports Re
ChioStandards ReportsDemag Re
PM1 ReportsDemog2 EI Re
PMZ ReportsDemoa3 ELE
PM3 ReportsDemogEDIT Us
Prg ReportsDemodnly
PMS ReportsiMoment
PME RepartsRanking
PM7 ReportsResultsbyGroup
L3 J k2
File name: “ n ‘ [ Open ]
Files of type: ‘ TurmingPaint Session(* tpz) M ‘ [ Cancel ]

You may select multiple files by holding down the Control key
and clicking on the file.

The session(s) has been attached to the email and is displayed
in the lower portion of the Send Sessions window.

" a TurningPoint - Send Session(s)

File  Tools

Send Sessions: Session Attached

X

To: |A\:|mimstralul@Tesl.edu

From: |Prasentar@Test edu

Subject: | Session Results from Geography 101

Body | Please find the attached session of Geography 101 ]

Geography 101;

Flease use valid email addresses and attachments

1




10 Optionally, change the SMTP
Server.

a Select Tools > Change This displays and SMTP Server window.
SMTP Server.

Send Sessions: SMTP Server Window
SMTP Server r$_<|

Pleaze enter your SMTP sever

b Enter the SMTP server. You may need to check with your IT Department for this
information.
c Select OK. Your SMTP server has been changed.
11 Select the Send button. A dialog is displayed indicating that the email was

successfully sent.



Where Do I Go From Here?

This user manual has introduced you to the process of creating interactive presentations with
TurningPoint. You have learned how to successfully build, deliver, and save the results of an
interactive presentation in five easy steps.

You have customized the slides and include animation, feedback mechanisms, and excitement in
your presentation. You have also created reports to view the results of your presentation session.

If you have further questions about the TurningPoint system, please feel free to contact Customer
Support at Turning Technologies. See “Customer Support” on page 15..



Chapter 10: Export

440 Turning Technologies



Glossary

Answer

An answer is one of a list of choices on a turningpoint slide.
The answers are enumerated and participants’ responses
correspond to the number of the answer.

Answer Now Indicator

An answer now indicator is an object on a turningpoint slide
that gives the audience a visual indication that polling is open
and they should respond to the question.

Answer Region

The answer region is the area on a turningpoint slide that
contains the list of answers.

Answer Value

For purposes of scoring and competition, you can assign
answer values to answers on a turningpoint slide. The possible

values are “correct”, “incorrect”, a point value negative 10,000—
10,000, or “no value.”

Chart

A chart is a visual representation of the results of polling on a
turningpoint slide.

Comparative Link

A comparative link is used to link a slide to the results from 1-3
additional slides to show all the results on a single chart.

Conditional Branching

Conditional branching determines the order of slides based on
participant responses.

Correct Answer Indicator

A Correct Answer indicator is an object on a TurningPoint slide
that gives a visual indication of the correct answer(s) after
polling has closed.



Countdown Indicator

A Countdown indicator is an object on a TurningPoint slide
that gives the audience a visual indication that polling is
about to close and that they should respond soon.

Countdown Sound

A Countdown Sound is .sound file used with a Countdown
Indicator that gives the audience an audible indication that
polling is about to close and that they should respond soon.
The acceptable file extensions include: .aiff, .au, .mid, .midi.,
.mp3, .wav, and .wma.

Criteria

In a ranking, the criteria are the qualities on which the items
to be ranked are compared. There are 1-3 criteria for the
ranking, corresponding to the X, Y, and Z axes of the ranking
chart.

Data Slicing

Data slicing is data analysis that entails cross-referencing the
results from question to the results of a another question.

Device ID

The Device ID is a number that uniquely identifies a
response device For hardware devices, it may be printed on
the tag on the back of the device.

Dongle

A dongle is a piece of hardware that attaches to a port on
your computer that confirms that the TurningPoint software is
appropriately licensed.

Essay Slide

An Essay slide asks an open-ended question. The
participants respond with text. Only vPad participants are
able to respond to an Essay slide.

Fill in the Blank Slide

A Fill in the Blank slide asks a question or makes a statement
with a missing word. Types of responses are determined by
the type of device a participant is using. For instance, vPad



users can respond with a word or phrase, but ResponseCard
users can respond only with numeric values.

Infrared (IR)

Infrared light is invisible to the human eye and can be used to
transmit information. Some of the response devices that work
with TurningPoint use infrared technology. IR devices require a
direct line of sight to the receiver. The IR response devices
allow only one-way communications.

Interactive Results

Interactive results are the data from the audience’s responses
that are displayed in real-time while polling is open.

Moment to Moment Slide

A Moment to Moment slide is a special TurningPoint slide for
getting feedback from the participants on a continual basis. The
participants respond on a scale from -2 to +2 at regular
intervals and the responses are displayed in a a chart.

Participant List

A Participant List is the file used in a session to track
responses by individuals in the audience. Users can customize
the type of data fields to include in the list but every list will
include fields for the number and ID of the response devices.

Parser

A parser examines a file and breaks it into logical units to use
and recombine. The TurningPoint Parser can take several
kinds of files and create TurningPoint presentations from them.

Participants

The people in the audience of a presentation who use the
response devices to respond to questions.

Participant List Wizard

The Participant List Wizard is a tool that guides you through the
creation of a Participant List to be used with your presentation
session.



Participant Monitor

The Participant Monitor displays the status and information
pertaining to the participants’ responses to all of the
questions, including the total percentage of correct
responses, how long each participants took to respond, and
which answers they picked.

Picture Slide

A picture slide is a TurningPoint slide in which the answer
text is replaced with pictures.

Polling

Polling is the mechanism by which Turning Point accepts and
tallies the responses provided by the audience using
Response Devices.

Presentation Session

See Session.

Radio Frequency (RF)

Radio frequency devices use radio waves to transmit
information. Some of the response devices that work with
TurningPoint use radio frequency technology. RF devices do
not require a direct line of sight. The RF response devices
use two-way communications, so the response device can
confirm that a response was received by the receiver.

Ranking

A ranking is an exercise in which items are compared on 1-3
criteria and ranked. You can set up a ranking in TurningPoint
using the Ranking Wizard.

Receiver

A receiver is a device that attaches to your computer to
receive IR or RF signals from response devices.

Reset

To return the response tallies from the audience to zero.



Report

Reports present and analyze the data from a session in a
variety of useful ways. You can create reports from a session
using the Report Wizard.

Response

A response is the signal received from a participant during
polling. The response usually corresponds with one of a list of
answers on the slide.

ResponseCard

A ResponseCard is a type of hardware response device that
use infrared (IR) or radio frequency (RF) signals to
communicate a participant’s response.

Response Counter

A Response Counter is an object on a TurningPoint slide that
gives a visual indication of how many of the participants have
responded to the question.

Response Grid

A Response Grid is available from the Showbar and is used to
show which participants have responded to a question.

Response Table

A Response Table is an object on a TurningPoint slide that
shows which participants have responded to a question.

Showbar

The Showbar is a toolbar that provides activation buttons for
polling, monitoring, and viewing responses during the slide
show.

Session

A session is a run-through of an interactive presentation where
an audience has submitted responses to some or all of the
questions.



Session File

A session file is created to store the results and other data
when you run a session. Session files are usually stored in
My Documents\TurningPoint\Sessions and have extension
Apz.

Slide Show

A slide show is a presentation created in PowerPoint, which
may or may not include TurningPoint slides.

Speed Scoring

Speed scoring scales the number of points a participant
receives for responding to a question correctly by how
quickly the participant responded.

Standard

A standard is any framework for evaluation of participants.
You can assign standards to slides in a TurningPoint
presentation to compare participants’ performance to a
standard.

Statistic Indicator

A Statistic indicator is an object on a TurningPoint slide that
shows the mean (average), median, standard deviation, or
variance of responses after polling has closed.

Text Messaging

Text Messaging is a feature for sending messages to
participants using vPad during a presentation.

TurningPoint slide

TurningPoint slides are slides in a PowerPoint presentation
with the ability to dynamically display information based on
the responses of an audience.

TurningPoint toolbar

A series of menus and buttons displayed below to the
PowerPoint toolbars that contains the tools for using the
TurningPoint software.



vPad

A vPad is a software version of a response device that is set up
for use in Settings. It can be installed on a networked desktop
or laptop computer or Smart Device.

Web vPad

A Web vPad is an internet version of a response device that is
set up for use in Settings. |

WebCT

WebCT is a software product that is popularly used by
educational institutions to facilitate e- systems.

WebCT Wizard

The WebCT Wizard is a tool that guides you through the
process of connecting to an institution’s WebCT server.

XML

XML is a markup language for text files, similar to HTML, that is
used by TurningPoint for storing session data and as an import
format for the TurningPoint parser.
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Frequently
Asked Questions

This appendix offers you a quick reference to common questions that customers have about using the
TurningPoint software. If you do not find an answer to your question here, visit the Turning
Technologies Web site at http://www.turningtechnologies.com or call a Turning Representative toll-
free at 1-866-746-3015.

Why can’t | install TurningPoint?

You must be the local administrator to install TurningPoint for
the first time. Login to the computer with the administrative
username and password.

If you have a dongle, it should not be plugged in during
installation or activation. Remove it while installing and
activating TurningPoint. Find information about installing
TurningPoint in Chapter 1: About TurningPoint.

Where is my product serial number (activation
code)?

The product serial number, also called the activation code, is
located on a label inside the ResponseCard Kit.



What does the dongle look like?

The dongle has an end that plugs into a USB port as
depicted in the image below.

USB Dongle

use
Dongle

Which response devices are compatible with
TurningPoint?

Turning Technologies partners with Responsive Innovations
to provide audience response devices that are specifically
designed to support the functionality of TurningPoint. The
ResponseCard IR, ResponseCard XL, ResponseCard RF,
and ResponseCard XR from Responsive Innovations are
products that are optimally suited for use with TurningPoint.
Users also have the option of using TurningPoint’s vPad and
Web vPad, two applications for using a virtual keypad.

How do | set up the response devices?

All of the response device settings can be found in the
Settings windows. From the TurningPoint toolbar, select the
Tools > Settings, which looks like a pair of eyeglasses. Find
information about Installing Response Devices in Chapter 4:
TurningPoint Device and Settings Management.

Where should | put the receiver?

Because the IR device uses infrared technology and line-of-
sight communication, place it in a central location in the front
of the room where it is high enough for everyone to see. The
effective range of an IR device receiver is about 75 feet (25
meters). You will need to install one receiver for every 80
participants. The effective range of an RF device receiver is
about 200 feet (60 meters). A single receiver is sufficient for
up to 1000 keypads, and a direct line of sight between the
receiver and the keypad is not necessary. When the receiver
is connected, the participant has to simply press the number
or letter on the keypad to send a response. Find information



about setting up the receiver in Chapter 4: TurningPoint
Device and Settings Management.

Why is a keypad not working?

The correct keypads may not be matched with the receiver.
Check your response device settings. Find information about
the response device settings in Chapter 4: TurningPoint
Device and Settings Management.

The keypad’s batteries may be too low or dead. Press a button
on the keypad. The light on the keypad blinks or does not light
up if the batteries need to be replaced.

The keypad may not be correctly programmed. Refer to the
Programming ResponseCards insert in the TurningPoint kit.

How do I track responses from participants?

Create a Participant List in TurningPoint and then use the
Participant Monitor to view the responses from each
participant. You can either create a Participant List using the
Participant List Wizard or by importing an existing file. Find
information about participant lists in Chapter 5: Track
Participants and Teams. Find information about the
Participant Monitor in Chapter 7: Run Presentations.

When running the presentation, why don’t the
graphs appear unless | advance to the next slide
and then go back?

The animations in the charts vary between Office 2003 and
Office 2007. It is likely that Microsoft Office has been upgraded
since TurningPoint was installed. Uninstall TurningPoint, and
then reinstall it.

How do I clear data from a session or a slide?

From the TurningPoint toolbar, select the Reset menu, and
then select Session or Current Slide from menu. Find
information about working with sessions in Chapter 9:
Sessions.

How do | save a session?

From the TurningPoint toolbar, select the Save Session button,
which looks like a disk. A window opens allowing you to select
a file name and location. Save the file in the Sessions folder,



located at My Documents > TurningPoint > Sessions. Find
information about saving a session in Chapter 9: Sessions.

How do | make a report with the data from my
session?

TurningPoint enables you to create several types of reports.
Find information about your options and instructions for
creating reports in Chapter 8: Reports.
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